
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
IDEC CORPORATION                                                   B-2314(0)  

INR-SI47-2104d-E 

 

Inverter Support Software 

VFD Doesa-Loader 

Instruction Manual 

 
 



 

 

 

 

 

 

 

 

 

 

 

 

 
Copyright © 2022 IDEC CORPORATION. 

All rights reserved. 

The copyright for this instruction manual lies with IDEC CORPORATION. 

The unauthorized reprinting or reproduction of this manual, in part or in full, is strictly prohibited. 

 

Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United 

States. Other company names and products mentioned in this manual are generally registered trademarks 

or trademarks of the relevant companies. 

 

Please be aware that the specifications and so in this manual may be subject to change without notice for 

improvement. 

Every effort has been made to ensure the accuracy of the content of this manual, however, please contact 

your local IDEC CORPORATION sales office at the end of this manual if there is anything that is unclear, or 

if any errors and so on are found. 

 



i 

Preface 

This instruction manual describes how to use the inverter support software VFD Doesa-Loader. This 

instruction manual does not cover the handling of inverters. For information on the handling of inverters, 

refer to instruction manuals or user's manuals. 

 

 
 If you use a folder name or file name that contains environment-dependent characters 

created in a Windows that differs from the language specifications of your Windows, you 

may not be able to read or write the file. Use folder and file names that do not contain 

environment-dependent characters. 

 If the settings shown below are set in the Windows of use, the characters may protrude. 

・When the size of text or the like is set to a size larger than specified in the [Display] 

setting of the control panel. 

・In the Windows10, when the size of text or the like is set to a size larger than the 

specified size in [Settings]→[System]→[Display] settings. 

 Some of the views may be in languages or fonts that depend on your Windows 

preferences. 

 If you do not install language packs Microsoft.NET Framework Ver. 4.5 or higher, some of 

the displayed languages may become English. 

 The resolution of the monitor is recommended to be 1920 × 1080 or more. Below that, the 

operability may deteriorate. 

 Example screens shown in this manual might differ from actual displaying screen by the 

software version or specifications change. 

 

 

■ Safety Precautions 

Prior to the use (including connection, wiring, operation, maintenance, inspection, etc.), be sure to read 

this instruction manual as well as the "RS-485 Communication User's Manual", instruction manuals 

and user's manuals, as needed, to gain an understanding of how to handle the product and ensure 

correct use of related devices. Incorrect handling may hinder normal operation or result in inverter 

failure or shortening of product life. 

Use your devices after ensuring a thorough understanding of device knowledge, safety information, 

and all related precautions. 

Safety precautions contained in this instruction manual have been categorized as follows. 

 
Failure to heed the information indicated by this symbol may result in 

death or serious injury. 

 
Failure to heed the information indicated by this symbol may result in 

minor or light injury and/or substantial property damage. 

Failure to heed the information contained under the CAUTION title may also result in serious 

consequences. 

All items indicate important content and therefore must be observed. 
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Wiring 

 

 Before wiring the RS-485 ports and connecting the cables, ensure that the power is off (the switch is 

open). 

 Failure to observe this could result in electric shock. 

 

 

 Before connecting wires to the RJ-45 connectors on the inverter (such as the RJ-45 connector for 

keypad connection, the RS-485 communication card's RJ-45 connector, and the inverter's RJ-45 

connector for RS-485 communication), check the wiring of the devices to be connected. Refer to the 

" RS-485 Communication User's Manual" for details. 

 Failure to observe this could result in a failure. 

 

 

Operating Precautions 

 

 Carefully note that resetting the alarm with the operation command on causes the inverter to start 

unexpectedly as soon as the alarm is cleared. 

Failure to observe this could result in an accident. 

 

 

 If the loader goes down or is forcibly terminated during the operation with the test drive screen open, 

it will be impossible to stop the inverter operation with the loader. If this is the case, stop the inverter 

by doing one of the following: 

Failure to observe this could result in an accident. 

<How to stop the inverter when the loader goes down or is forcibly terminated> 

1) If an emergency stop switch is available, use the switch to stop the inverter. 

2) Turn off the inverter power. 

3) Turn off the inverter operation command and switch the inverter from "remote command mode" 

to "local command mode".  

More specifically, do one of the following:  

- Turn off the terminal to which the "LE" command is assigned.  

- Zero the data for the link function for support (function code: y99).  

- Zero the data for the link function (function code H30). 

 

 Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test drive 

screen open. Doing so would be dangerous because it would be impossible to stop the inverter 

operation with the loader. 

Failure to observe this could result in an accident. 
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Chapter 1 

Before Use 
 

This chapter provides an overview of the inverter support loader software VFD Doesa-Loader 

(hereinafter referred as "the Loader"), descriptions about preparations before using the Loader, and 

procedures for installation and uninstallation. 
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1.1. Overview 

1.1.1. Features 

- The Loader is a software that supports remote operation of our inverters from a personal 

computer (hereinafter referred as "the PC") using the RS-485 communication port and the 

USB connection (including the connection via the Keypad), and is designed to operate on the 

Windows operating system (hereinafter referred as "the OS"). 

- The Loader facilitates simple operation to set or manage function codes of the inverter. 

 

 

[Function code] 

Can be used to read or write, edit, compare, initialize, save, or print 

the parameters (function code setting data) that set the inverter 

operations. 

 

[Operation monitor] 

Can be used to check the status of the external I/O (I/O monitor), the 

Loader information or maintenance information (system monitor), 

alarm occurrence information (alarm monitor), or information such as 

the current frequency (operation monitor). 

 

[Customizable logic] 

Can be used to extend the inverter functionality and to customize for 

the user interface. 

 

[Real-time trace] 

Can be used to monitor operation conditions in the form of continuous 

waveform information with the maximum of four analog channels and 

the maximum of eight digital channels (to the maximum total of eight 

channels). 

 

[Historical trace] 

Can be used to monitor inverter operation conditions in the form of 

waveform information in a sampling time that is shorter than the 

realtime trace. (The number of samplings is limited.) 

 

[Test run] 

Can be used to manipulate the frequency command or operation 

command on the Loader screen to test run the inverter. 

 

[Communication setting] 

Can be used to make communication settings between the PC and 

the inverter or with the remote keypad with USB. 
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1.1.2. Loader Functions by VF1A Series Inverter Model 

This section lists functions that can be used by each VF1A series inverter. 

Table 1-1  Correspondence between VF1A Series Inverter Models and Loader Functions 

Function VF1A series Inverter 

 
 

[Function code window] ◎ 

[Customizable logic 

function code window] 
◎ 

 
[Operation monitor]  ◎ 

 
[Customizable logic]  ◎ 

 
[Real-time trace] ◎ 

 
[Historical trace]  ◎ 

 
[Test run]  ◎ 

 

[C
o

m
m

u
n

ic
a

ti
o

n
 s

e
tt

in
g

] 

RS-485 (Loader ( Doesa)) ◎ 

USB (via VF1A-PH1) ◎ 

 
Remote keypad with USB 

(VF1A-PH1) Copy function 

◎ 
*1 

◎: Supported, : Supported with restrictions, : Not supported 

 

*1 Supported by the VF1A-PH1 remote keypad with USB (ROM version 1600 or later). 
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The following table shows the Loader functions that can be used when accessing the keypad 

memory from the Loader. 

 

Table 1-2  Correspondence between the Keypad and Loader Functions 

Function 
Keypad 

VF1A-PH1 

 
[Function code window] 

 
*1 

 
[Operation monitor]  ◎ 

 
[Customizable logic]  

 
*2 

 
[Real-time trace]  

 
[Historical trace]   

 
[Test run]   

 
[Communication setting] 

USB 

(Data in Keypad) 
◎ 

◎: Supported, : Supported with restrictions, : Not supported 

*1 Auto tuning cannot be used.  

*2 Start/stop and monitoring functions of the customizable logic cannot be used. 
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1.1.3. Product Warranty 

Limitation 

of liability 

IDEC CORPORATION accepts no responsibility for any losses (this includes, 

but is not restricted to lost profits, suspension of business, loss of business 

information, or other financial loss) arising from the use, or inability to use this 

software or its documentation. 

 

 

1.1.4. Menu Command and Operation Button Notation 

Menu commands and operation buttons for each screen are expressed as follows in this user's 

manual. 

For example, [Open…] is abbreviated as [Open] ("…" is omitted ). 

 

However, square brackets [ ] are omitted, and bold font is used in chapter and section titles, as 

well as in captions. 
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1.2. Connecting Inverters to the PC 

1.2.1. Connection Methods 

This section describes basic connection methods. Connection methods are different depending 

on the type of inverters to be connected. Check the relevant instruction manuals for the inverters 

and use the correct connection method. 

Number of 

connections 
PC side 

Inverter 

side 
Connection Methods 

Reference 

section 

1:n 

(n = 1,2,..., 

32) 

USB 
RS-485 

(Note 3) 

Connection via the USB/RS-485 

converter  (Note 1) 

1.2.2.1 

COM port 

(RS-232C) 

RS-485 

(Note 3) 

Connection via the RS-232C/ 

RS-485 converter  (Note 1) 

1:1 USB 

Remote 

keypad 

with USB 

(Note 2) 

Connection using the USB cable. 

If the keypad cannot be attached 

to the inverter, connect the 

keypad to the inverter using the 

LAN cable. 

1.2.3.1. [1] 

 

Note 1: When using the RJ-45 connector, use a branch adapter for multi-drop connection from the second 

inverter onward. 

Note 2: This connection is possible only for inverters that support the remote keypad with USB. For 

information on the keypad support details, refer to "1.1.2. Table 1-1  Correspondence between 

VF1A Series Inverter Models and Loader Functions" or catalogs of relevant inverters. 

Note 3: Inverter models with different RS-485 communication protocols cannot be placed in the same 

network for communication. For the RS-485 communication protocol by model, refer to "1.1.2. 

Table 1-1  Correspondence between VF1A Series Inverter Models and Loader Functions" or 

catalogs of relevant inverters. 

 

 
1) For information on the RS-232C/RS-485 converter and USB/RS-485 converter, refer to 

"1.2.2.2. Devices Required for RS-485 Connection". 

2) When connecting inverters with the LAN cable using the RJ-45 connector, refer to "1.2.2.2. 

[2] Cables" and "1.2.2.2. [4] Branch Adapter for Multi-drop Connection". 

3) If the RS-485(RJ-45 connector) is commonly used with the keypad connection connector 

for the inverter, the keypad must be removed from the inverter. 

4) To minimize the effects of noise, avoid wiring in the same bundled cable as for the power 

supply and, instead, wire in a separate line. (Refer to "1.2.2.3．Noise Countermeasures for 

RS-485 Communication".)  
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5) It is not possible to use the Loader with a PLC or other host devices at the same time. 

Before using the Loader, disconnect the connection cables to other host devices. 

6) For configuring the multi-drop connection, assign different station addresses to inverters to 

be connected. 

 

 

 Be sure to turn off the power to the inverters and related devices before wiring or making RS-485. 

Failure to observe this could result in electric shock. 

 

 

 Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the inverter using the 

LAN cable.  

The RJ-45 connector of the inverter is not for LAN communication.  

The voltage level and pin arrangement are different from those of the LAN terminal of the PC.  

A trouble such as a power short-circuit or signal line collision may occur and may damage the 

product. 

Failure to observe this could result in a product failure. 

 

 

 When connecting cables to the RJ-45 connectors on the inverter (RJ-45 connector for connecting to 

the keypad, RJ-45 connector for connecting to the RS-485 communication card, and RJ-45 connector 

for the inverter’s RS-485 communication), be sure to check the wiring of the devices to be connected. 

For details, refer to the "RS-485 Communication User's Manual". 

Failure to observe this could result in a product failure. 
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1.2.2. RS-485 Communication Port Connection 

1.2.2.1. Basic Connection Drawings 

[1] Multi-drop Connection Using the RJ-45 Connectors 

The following diagram shows an example of multi-drop connection using RJ-45 connectors. 

 

Figure 1-1  RS-485 Connection Diagram (RJ-45 connector Connection) 

 

The following devices are used for the connection. For information on recommended devices, 

refer to "1.2.2.2. Devices Required for RS-485 Connection". 

Devices used Description 

Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485 

converter or USB/RS-485 converter is required. 

To connect to the RJ-45 connector of the inverter, a converter equipped with the 

RJ-45 connector is required on the RS-485 port side. 

Cable 1 Follow the specifications of the converter. 

Cable 2 Use commercially available LAN cable (straight). 

Branch adapter for 

multi-drop 

connection 

The branch adapter is convenient to use when using the cable with RJ-45 

connector for the multi-drop connection. The branch adapter is not necessary for 

the inverter equipped with the RJ-45 connector for functional extension. 

 

 

 The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45 connector 

for the RS-485 communication (communication port 1). When connecting to other devices, 

be careful not to connect to pins assigned to the power supply. Connect only pin 4 and pin 

5. 

 Do not connect the LAN terminal of the PC directly with the RJ-45 connector of the 

inverter using the LAN cable. 

Failure to observe this could result in a product failure. 

  

PC 

VFD 
Doesa- 
Loader 

Converter 

Branch adapter for 
multi-drop connection 

Doesa VF1A series 
Inverter 

RJ-45 connector 

RS-485 
Communication 
device 

RJ-45 connector 

RJ-45 connector 

Terminating resistor 
(100 – 120 ohm) ON Terminating 

resistor SW 
OFF 

Terminating 
resistor SW 
OFF 

Terminating 
resistor SW 
ON 

Cable 2 

Cable 2 Cable 1 
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For information on RS-485 communication settings, refer to the following. 

Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side 

Loader side:  1.5.5. Communication Setting and Connection Setting for the Loader 

 

For information on the inverter's terminating resistor switch, refer to the instruction manuals or 

the RS-485 Communication User's Manual. 

 

 
 For the selection of connection devices to prevent damage or malfunction in the 

control PCB caused by an external noise and to eliminate the influence of the 

common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485 

Connection". 

 The maximum wiring length must be 500 m in total. 
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[2] Multi-drop Connection Using Terminal Blocks 

The following diagram shows an example of multi-drop connection using terminal blocks. 

 

Figure 1-2  RS-485 Connection Diagram (Terminal Block Connection) 

 

The following devices are used for the connection. For information on recommended devices, 

refer to "1.2.2.2. Devices Required for RS-485 Connection". 

Devices used Description 

Converter PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485 

converter or USB/RS-485 converter is required. 

To connect to the terminal block of the inverter, a converter equipped with the 

terminal block is required on the RS-485 port side. 

Cable 1 Follow the specifications of the converter. 

Cable 2 Use a shielded twisted-pair cable for long distance transmission. 

 

For information on RS-485 communication settings, refer to the following. 

Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side 

Loader side:  1.5.5. Communication Setting and Connection Setting for the Loader 

 

 
 For the selection of connection devices to prevent damage or malfunction in the 

control PCB caused by an external noise and to eliminate the influence of the 

common mode noise, be sure to refer to "1.2.2.2. Devices Required for RS-485 

Connection". 

 The maximum wiring length must be 500 m in total. 

  

Doesa VF1A series 
Inverter 

PC 

VFD 
Doesa- 
Loader DX(+) 

DX(-) 

DX(+) 

DX(-) 

DX(+) 

DX(-) 

Converter DX(+) 

DX(-) 

Shield Cable 1 

Cable 2 

Terminating resistor 
(100 – 120 ohm) ON 

Terminating 
resistor SW 
OFF 

Terminating 
resistor SW 
OFF 

Terminating 
resistor SW 
ON 
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1.2.2.2. Devices Required for RS-485 Connection 

This section describes about the devices required when connecting to a PC with non RS-485 

interface. 

[1] Converter 

PCs are not normally equipped with RS-485 ports. Therefore, an RS-232C/RS-485 converter or 

USB/RS-485 converter is required. Always use a converter that meets the recommended 

specifications shown below in order to ensure correct use. Note that the software may not 

function properly if a converter other than those recommended is used. 

Recommended converter specifications 

Transmission/receipt 

switching method: 

Automatic switching through monitoring transmission data at the PC 

side (RS-232C) 

Isolation: Must be dielectrically isolated from the RS-485 side. 

Fail-safe: Must be equipped with a fail-safe function (*). 

Other requirement: Must have excellent noise resistance properties. 

* The fail-safe function is a function capable of ensuring that the RS-485 receiver output is 

logic high even when the RS-485 receiver input is open or shorted or when all the RS-485 

drivers are inactive. 

Recommended converters 

Manufacturer:  System Sacom Industry Corp. 

Model:  KS-485PTI (RS-232C/RS-485 converter) 

 USB-485I RJ-45-T4P (USB/RS-485 converter) 

 

Transmission/receipt switching method 

RS-485 communication involves half-duplex operation (two-wire system), and therefore 

converters require a function for switching between transmission and receipt. There are the 

following two switching methods. 

(1) Automatic switching through monitoring transmission data 

(2) Switching with RS-232C flow control signals (RTS or DTR) from the PC 

The VFD Doesa-Loader does not support the above switching method (2). Therefore, use the 

converter with the above switching method (1). 
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[2] Cables (for RJ-45 connector connection) 

The connection cable specifications are set as follows to ensure reliable connection. 

 Specifications 

Common specifications 10BASE-T/100BASE-TX straight cables (commercially 

available LAN cable) that satisfies the US ANSI/TIA/EIA-568A 

Category 5 standard. 

When connecting to the keypad, use an 8-conductor straight cable. Use commercially available 

LAN cable (20 m or less). 

 

Recommended LAN cable 

Manufacturer:  Sanwa Supply Inc. 

Model:  KB-10T5-01K (1 m) 

 KB-STP-01K (1 m shield cable: possible to conform to the EMC Directive) 

 

 
 The power supply (1, 2, 7, and 8 pins) for the keypad is connected to the RJ-45 

connector for the RS-485 communication (communication port 1). When connecting 

to other devices, be careful not to connect to pins assigned to the power supply. 

Connect only pin 4 and pin 5. 

 

 

[3] Cables (using terminal blocks) 

Use a shielded twisted-pair cable for long distance transmission with the wire gauge of AWG 16 

to AWG 26 to ensure reliable connection. 

Recommended cable 

Manufacturer:  Furukawa Electric Co., Ltd. 

Model:  AWM 2789 Long-distance connection cable 

 

 

[4] Branch Adapter for Multi-drop Connection 

The RJ-45 connectors are used as communication connectors. When configuring a multi-drop 

connection using the standard LAN cable, a branch adapter for the RJ-45 connector is required. 

Manufacturer:  SK KOHKI CO., LTD. 

Model:  MS8-BA-JJJ 
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1.2.2.3. Noise Countermeasures for RS-485 Communication 

Depending on the operating environment, the system may malfunction due to noise generated 

by the inverter. To prevent such malfunction, countermeasures can be taken by separating 

wiring lines, using shielded cables, isolating the power supply, or adding an inductance. As an 

example, addition of an inductance is shown below. 

Addition of an inductance 

Form an inductance component in the circuit to generate a high-impedance state against the 

high frequency noise by inserting a choke coil in series with the signal circuit or by passing the 

wiring through the ferrite core. 

 

Figure 1-3  Addition of an Inductance 
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1.2.3. USB Communication Port Connection 

1.2.3.1. Basic Connection Drawings 

 [1] Connection with the Inverter via the remote keypad with USB 

The following section describes a connection of the PC with the inverter via the remote keypad 

with USB. Connect the keypad to the keypad coupling connector on the inverter with a 

communication cable. Be careful with the connector. If it is connected to any connector or port 

other than the keypad coupling connector, no communication will be possible. 

 

Inverters with removable keypad that support the remote keypad with USB 

The keypad mounted on the inverter as standard must be removed.  

 

Figure 1-4  USB Connection Diagram (Connection with the Inverter via Remote keypad with USB (1)) 

 

Devices used Description 

Remote keypad 

with USB 

For the inverter models that support the remote keypad with USB as an optional 

item, the keypad needs to be purchased separately. 

Cable 1 Use a commercially available USB cable (mini B connector). 

Cable 2 Use a commercially available LAN cable (straight). 

 

For information on USB communication settings, refer to the following. 

Inverter side:  1.5.1. Setting Function Codes Related to Communication on the Inverter Side 

Loader side:  1.5.5. Communication Setting and Connection Setting for the Loader 

On the Loader side, select [Data in Inverter (via VF1A-PH1)] for the USB connection under [Port] 

on the [Communication setting] window. 

 

 

 
 This connection is possible only for inverters that support the remote keypad with 

USB. For information on the keypad support detail, refer to "1.1.2. Table 1-1  

Correspondence between VF1A Series Inverter Models and Loader Functions" or 

catalogs of relevant inverters. 

 Be sure to connect the remote keypad with USB to the keypad coupling connector 

on the inverter.  

For example, the keypad coupling connector for the VF1A is available only on the 

RS-485 communication port 1. Therefore, if the keypad is connected to the RS-485 

communication port 2, no communication is possible. 

USB A connector 

VFD  

Doesa- Loader 

Cable 1 

Doesa VF1A series 
Inverter 

USB mini B connector 

RJ-45 connector 

on back side 

Cable 2 
Remote keypad with USB 

PC 

Keypad coupling connector 

(RJ-45) 
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  A USB driver must be installed on your PC. For information on the installation 

methods, refer to "1.4.1.5. Checking the USB Driver". 

 When connecting the inverter to the PC Loader via the USB communication port, 

use 1:1 connection. (Do not use the USB hub.) 

 

 

 

 

1.2.3.2. USB Specifications 

[1] USB Specifications for the remote keypad with USB 

Table 1-3  USB Specifications for the VF1A-PH1  

Specifications Conforming to USB1.1 

Transfer speed 12 Mbps 

Wire length 5 m max. 

Connector USB Mini-B connector 

Power supply 
When connected to the inverter: Self power 

When connected to the PC: Bus power 
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1.3. Connection between the PC and the Keypad with USB 

1.3.1. Memory Function of the keypad 

The remote keypad with USB (VF1A-PH1) can be used as a temporary memory medium. 

Retrieve the inverter operation condition data into the keypad, remove the keypad, and, at a 

location such as an office other than the work site, connect the keypad to the PC with the Loader 

installed. Using the Loader, the retrieved function code data can be edited, set, or monitored.  

The settings edited using the Loader can be retrieved into the keypad and, at the work site, the 

data can be written into the inverter from the keypad. 

Even if the inverter does not support the USB communication via the keypad (see 1.2.3.1. Basic 

Connection Drawings [1]), the keypad can be used as a temporary memory medium as long as 

the inverter support the copy function of the remote keypad. 

 

1.3.2. Connection between the PC and the keypad 

The following section describes a connection between the PC and the remote keypad with USB 

when using the keypad as a temporary memory medium. 

 

Figure 1-5  Connection Diagram between the PC and the keypad 

 

Devices used Description 

Remote keypad 

with USB 

For the inverter models that support the remote keypad with USB as an optional 

item, the keypad needs to be purchased separately. 

Cable Use a commercially available USB cable (mini B connector). 

 

For information on USB communication settings, refer to "1.5.5. Communication Setting and 

Connection Setting for the Loader". 

There is no function for communication setting on the keypad side. 

On the Loader side, select [Data in Keypad] for the USB connection under [Port] on the 

[Communication setting] window. 

 

 
 A USB driver must be installed on your PC. For information on the installation 

methods, refer to "1.4.1.5. Checking the USB Driver". 

 When connecting the inverter to the PC Loader via the USB communication port, 

use 1:1 connection. (Do not use the USB hub.) 

  

Remote keypad with USB 

USB A connector 

VFD Doesa Loader 

Cable 

USB mini B connector 

PC 
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1.3.3. Connection between the keypad and the Inverter 

The following section describes a connection between the remote keypad with USB and the 

inverter when using the keypad as a temporary memory medium. 

Use the copy function of the keypad to retrieve the data from the inverter into the keypad and to 

write the function code setting data into the inverter from the keypad. For information on the 

copy function, refer to the instruction manuals. 

 

 

 

Inverters with removable keypad that support the remote keypad with USB 

The keypad mounted on the inverter as standard must be removed. 

 

Figure 1-6  Connection Diagram between the keypad and the Inverter (1) 

(Connection Using a Communication Cable) 

  

Doesa VF1A series 

Inverter 

RJ-45 connector 

on back side 

Cable 

Remote keypad 

with USB 

Keypad coupling connector  

(RJ-45) 

 

Removal 

Keypad 

supported as 

standard 
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1.4. Installation and Uninstallation 

1.4.1. Installation Methods 

1.4.1.1. Flowchart of Installation Procedures 

Perform installation according to the following procedure. 

 

  

START 

END 

Perform pre-installation check. 

Install the Loader and a set of required 

applications. 

Install the USB driver. 

  

[No] 

[Yes] 

Use USB communication (*1) with the 

Loader? 

  

(*1) The following devices can be used for USB 

communication with the VFD Doesa-Loader. 

- Remote keypad with USB: VF1A-PH1 

(*2) For the installation of the USB driver, connect the PC 

with the USB device. Therefore, the following devices 

are required. 

- USB device 

(Remote keypad with USB: VF1A-PH1) 

- USB cable 

(Used for connecting the PC with the USB device) 

(See section 1.4.1.2.) 

(See section 1.4.1.3.) 

(See section 1.4.1.4.) 

 

Perform pre-installation check before 

installing the USB driver. (*2)(*3) 
(See section 1.4.1.4.) 

(*3) The VFD Doesa-Loader and the Message Manager 

must be closed. 
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1.4.1.2. Perform Pre-installation Check. 

Perform the following tasks prior to installation. 

Task Description 

Checking Windows version Make sure that the version is one of the following.  

Windows 8.1 (32-bit/64-bit) 

Windows 10 (32-bit/64-bit)  

Exiting running applications Exit any applications that are currently running. 

 

 

 
 For installing the Loader, use an account authorized to install this software. 
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1.4.1.3. The Loader Installation Procedure 

This application requires the following applications. 

At the time of installation, these applications are installed as required. Follow the instructions on 

the screen to install them. 

1 Microsoft .NET Framework 4.5.2 Full 

2 Microsoft Visual C++ 2015 Redistributable Package 

3 Message Manager (MsgMgr USB Setup) 

 

The following section describes the Loader installation procedure. 

 

  

 

START 

END 

Install a set of required applications. 

Install the Message Manager. 

Install the VFD Doesa-Loader. 

It is automatically executed.  

Not executed if it is not selected at the 

above stage (a). 

Follow the instructions on the wizard.  

Not executed if it is not selected at the 

above stage (a). 

Execute the installer 

VFD Doesa-Loader_ setup.exe. 

Install the Microsoft Visual C++ 2015 

Redistributable Package. 

Follow the instructions on the wizard. 

Select the language for installation. 

Select required applications. 
Automatically selected.  

Applications that are already installed are 

not selected. 

(a) 

Automatically executed.  

Not executed if it is not selected at the 

above stage (a). 

Install the Microsoft .NET Framework 

4.5.2 Full Package. 
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Install the Loader according to the instructions on the wizard. 

The following shows installation procedures in English. 

 

 

 

Right-click 

[VFD Doesa-Loader__setup.exe] 

and select [Run as administrator] from 

the right-click menu that appears.  

The setup will automatically run the 

installation wizard. 

 
 

 

Select the language, either [Japanese] or 

[English], to be used in the installation. 

The selected language affects 

registration items of the start menu. 

Select [English] here. 

 

 

Click [OK]. 

 
 

[1] Installation of Required Software 

If all the required softwares have already been installed, the following screen does not appear. 

Proceed to [[3] Installation of the ]. 

 

 

 

 

 

A list of required softwares is displayed. 

 

 

 

 

 

Click [Install]. 
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When the screen on the left is 

displayed, click [Yes]. 

 

 

 

 

[2] Installation of the Message Manager 

 

 

 

If "MsgMgr USB Setup" is displayed on the 

screen shown to the left after clicking [VFD 

Doesa-Loader_ setup.exe], the 

Message Manager will be installed. 

 

If "MsgMgr USB Setup" is not displayed, it 

means that the Message Manager has 

already been installed. 

 

If the Message Manager has already been installed, the following screen does not appear.  

Proceed to [[3] Installation of the ]. 
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First, select the language to be used in 

the installation of the Message 

Manager. 

 

Select [English] here. 

 

 

 

Click [Next]. 

 

 

 

 

 

 

 

 

 

 

 

Click [Next]. 

 

 

Carefully read the Software End User 

License Agreement. 

To view the full text of the contract 

agreement: 

Press the [Page Down] key or [Page 

Up] key. 

You can also use the scroll bar to view 

the whole page. 

 

 

 

If you agree to the terms of the 

agreement, click [Yes]. 
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Select a destination folder. 

 

 

To install in a different folder, click the 

[Browse] button and select another 

destination folder. 

 

 

 

 

When the above selection is finished, 

click [Next]. 

 
The default folder for the 32-bit OS is C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message 

Manager. 

Here,“C:” is a drive letter for the disk or partition where the Windows is installed. If the Windows is installed 

in a different drive, substitute a drive letter for that drive. 

With the 64-bit OS, "Program Files" in the above address string is replaced with "Program Files (x86)". 
 

 

Set up a program folder. 

 

The default folder name is "Message 

Manager". 

 

 

 

When the setup is finished, click [Next]. 

 

 

 

A confirmation screen is displayed. 

 

 

 

 

If a change is required, click [Back] to 

return to the previous screen. 

 

If no change is required, click [Next]. 
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When the installation of the Message 

Manager is finished, the screen shown 

to the left is displayed. 

 

 

 

 

 

Click [Finish]. 

 
 

When installations of all the required softwares are completed, proceed to install the Loader. 
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[3] Installation of the Loader 

 

 

 

 

 

 

 

 

 

 

 

Click [Next]. 

 

 

 
Carefully read the Software End User 

License Agreement. 

To view the full text of the agreement: 

Press the [Page Down] key or [Page 

Up] key. 

You can also use the scroll bar to view 

the whole page. 

 

 

 

If you agree to the terms of the 

agreement, select [I accept the terms in 

the license agreement] and then click 

[Next]. 

 

 

 

 

 

Enter the user name and company 

name. 

 

When the input is finished, click [Next]. 
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Select the destination folder. 

The default folder is ¥IDEC 

VFD¥Doesa-Loader in the C or D drive. 

(Note: The drive that has the largest 

hard disk space is selected.) 

 

 

To install in a different folder, click the 

[Change] button and select another 

destination folder. 

 

 

When the above selection is finished, 

click [Next]. 

 

 

 

A confirmation screen for selected 

contents is displayed. 

 

 

If a change is required, click [Back] to 

return to the previous screen. 

 

If no change is required, click [Install]. 

 

 

 

 

 

 

When the screen on the left is 

displayed, click [Yes]. 
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When the installation of the Loader is 

finished, the screen shown to the left is 

displayed. 

 

 

 

 

To end the installation work and to 

return to the Windows, click [Finish]. 

 

  



 

 1-28 

 

1.4.1.4. USB Driver Installation Procedure 

To establish communication by connecting to the USB device (VF1A-PH1 remote keypad with 

USB), first you must install the USB driver. This installation work is required only once at the 

start of using your system. 

 
  

 

  If the USB driver is not properly installed, communication is not possible via the 

USB connector on the VF1A-PH1. 

 

 

[1] Before Installing the USB Driver 

Preparing Devices 

For the installation of the USB driver, connect the PC with the USB device.  

Prepare the following devices. 

USB devices: VF1A-PH1 remote keypad with USB  

USB cable: Used for connecting the PC with the USB device. 

 

Installation of the Loader 

Install the Loader in advance.  

The files required for the installation of the USB driver are saved in the Loader installation folder.  

For information on the installation methods, refer to "1.4.1.3. The Loader Installation Procedure". 

 

Close the Loader 

If the Loader was started after installation, close the Loader. 

 

Close the Message Manager. 

Close the Message Manager. The Message Manager is automatically started when the Loader 

is started. However, it does not close automatically. 

The following section describes how to close the Message Manager. 

Procedure for Closing the Message Manager 

 
 

Left-click here, and hidden icons are displayed as shown below. 

Right-click the Message Manager icon, and an option for exiting the Message Manager 

appears.  

Select the option, and the Message Manager is closed. 
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The icon may be displayed here. 

 

  If an attempt is made to install the USB driver with the Message Manager 

already started, the Message Manager cannot recognize the USB driver and, as 

a result, a communication failure may occur in the communication between the 

Loader and connected devices. In such a case, close the Loader and the 

Message Manager and then start the Loader again. 

 

 

[2] Installation of the USB Driver. 
 

Windows 10 

Connect the PC with the USB device (VF1A-PH1) using the USB cable. 

When the OS recognizes the USB device of this Loader, the following display appears. 

 

The wizard used to install the USB driver does not start automatically. Therefore, install the USB 

driver according to the following procedure. 

 

 

 

Select [START] -> [Control Panel] and 

then left-click. 
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When the Control Panel home screen 

is displayed, select [Device Manager] 

and then left-click. 

 

 

  

 

When the Device Manager screen is 

displayed, select "Unknown device" 

and then right-click to display options. 

 

 

 

 

 

 

 

 

 

 

Select "Update Driver Software" and 

then left-click. 

 

 

 

 

 

 

When the screen on the left is 

displayed, select "Browse my computer 

for driver software". 
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When the screen on the left is 

displayed, click [Browse]. 

 

 

 

 

Select "…¥Driver¥VF1A" inside the 

Loader destination folder and then click 

[OK]. 

 

The default folder is C:¥ IDEC 

VFD¥Doesa-Loader¥Driver¥VF1A 

when the installation drive is C. 

(Note: The drive that has the largest 

hard disk space is selected.) 

 

 

 

 

 

 

 

 

 

 

 

 

Click [Next]. 
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The installation will begin. 

 

 

 

When the installation of the Loader is 

finished, the screen shown to the left is 

displayed. 

 

 

To end the installation work and to 

return to the Windows, click [Close]. 
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Windows 8.1 

Connect the PC with the USB device (VF1A-PH1) using the USB cable. 

When the OS recognizes the USB device of this Loader, the following display appears.  

 

The wizard used to install the USB driver does not start automatically. Therefore, install the USB 

driver according to the following procedure. 

 

 

Select the [Computer] icon and then 

right-click to display options. 

 

Select "Properties" and then left-click. 

 

 

 

When the Control Panel home screen 

is displayed, select "Device Manager" 

and then left-click. 
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When the Device Manager screen is 

displayed, select "Unknown device" 

and then right-click to display options. 

 

 

 

 

 

 

 

Select "Update Driver Software" and 

then left-click. 

 

 

 

 

 

 

When the screen on the left is 

displayed, select and click "Browse my 

computer for driver software". 

 

 

 

 

When the screen on the left is 

displayed, click [Browse]. 
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Select "…¥Driver¥VF1A" inside the 

Loader destination folder and then click 

[OK]. 

 

The default folder is C:¥ IDEC 

VFD¥Doesa-Loader¥Driver¥VF1A 

when the installation drive is C.  

(Note: The drive that has the largest 

hard disk space is selected.) 

 

 

 

 

 

 

 

 

 

 

 

When the screen on the left is 

displayed, click [Next]. 
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The installation will begin. 

 

 

 

When the installation of the Loader is 

finished, the screen shown to the left is 

displayed. 

 

 

To end the installation work and to 

return to the Windows, click [Close]. 
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1.4.1.5. Checking the USB Driver 

Check whether the USB driver for VF1A-PH1 remote keypad with USB is properly installed or 

not using the Device Manager of Windows. 

 

 

Windows 10 

Select as follows to open the Device Manager: [Start] -> [Control Panel] -> [Device Manager]  

 

Windows 8.1 

Right-click the icon  on the [Computer], select [Properties] and then select [Device 

Manager]. 

 

 

Confirm that [Driver for FRENIC USB interface] is displayed under [Loader USB device] on the 

Device Manager. 

 

○: Installation succeeded.  ×: Installation failed. 
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1.4.1.6. Installation of the Message Manager 

Normally, when the VFD Doesa-Loader is installed, the Message Manager is installed at the 

same time. Therefore, there is no need to separately install the Message Manager. 

However, after the VFD Doesa-Loader is installed. The Message Manager may need to be 

uninstalled as a step to recover a communication failure. In such a case, the Message Manager 

can be separately installed.  

 

 

To install only the Message 

Manager, double-click [MsgMgr 

USB Setup.exe].  

The installation wizard will be 

started automatically. 

 

Install the Message Manager 

according to the instructions on the 

wizard. 

 

 
 After you uninstall the Message Manager, the VFD Doesa-Loader installer can 

also be used to install the Message Manager.  

When using the VFD Doesa-Loader installer, after you install the Message 

Manager according to the procedure in "1.4.1.3. The Loader Installation 

Procedure" click [Cancel] on the step "[3] Installation of the ". 

  If the VFD Doesa-Loader installer does not recognize the Message Manager as 

one of the installation targets even if the Message Manager has been uninstalled, 

use [MsgMgr USB Setup.exe] to install the Message Manager. 
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1.4.2. Uninstallation Methods 

 
 All files inside the Loader destination folder will be deleted. 

If necessary, move or back up the user files created by the Loader before uninstalling. 

 

1.4.2.1. The Loader Uninstallation Procedure 

Windows 10 

On the Windows, select icon   [  START]  [IDEC VFD]  [Doesa-Loader 

Uninstall]. 

Windows 8.1 

Left-click [All apps] icon  and then select [IDEC VFD]  [Doesa-Loader Uninstall].  

 
 

 

 

The uninstallation confirmation screen 

will be displayed as shown here. 

 

Upon confirmation, click [Yes]. 
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The uninstallation progress screen is 

displayed. 

Click [Cancel] to stop uninstallation. 

 

 

 

 

 

 

When the screen on the left is 

displayed, click [Yes]. 

 

 

Uninstallation will continue.  

 

Uninstallation is executed according to the above procedure. 
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1.4.2.2. Uninstallation of the Message Manager 

Uninstall the Message Manager according to the following procedure. 

 

 

  

START 

Close all the Loaders. 

Click [Uninstall Message Manager]. 

Close the Message Manager. 

Execute uninstallation according to the 

instructions on the wizard. 

(a) 

 

Tasks required prior to uninstallation 

Restart the Windows. 

[Yes] 
  

Is [Message Manager] listed in the 

start menu? 

[No] 

A 

END 
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END 

Delete the installation folder for the 

Message Manager. 

Did you close the Message Manager in 

the above step (a)? 

  
[Yes] 

[Yes] 

Does the installation folder for the 

Message Manager exist? 

  

  

[No] 

[No] 

Tasks required after uninstallation 

A 



 

Chapter 1 Before Use 

 1-43 

[1] Before uninstalling the Message Manager 
 

Close the Loaders. 

Make sure that the loaders are not running before uninstalling (deleting) the Message Manager. 

If any one of the loaders is running, close the loader before starting uninstallation. 

 

Close the Message Manager. 

Be sure to close the Message Manager before uninstalling (deleting) the Message Manager. 

The Message Manager is automatically started when the Loader is started. However, it does not 

close automatically. 

The following section describes how to close the Message Manager. 

Procedure for Closing the Message Manager 

 
 

Left-click here, and hidden icons are displayed as shown below. 

 

Right-click the Message Manager icon and select [Exit MessageManager] on the context 

menu, and a dialog box appears. Click [Yes], and the Message Manager is closed. 

   
 

 
 

The icon may be displayed here. 

 

 
 If the Message Manager cannot be closed using the above procedure, shut down 

Windows or log out. 

 
 If an attempt is made to uninstall without closing the Message Manager, some of 

the files will not be deleted. Under such situation, if an attempt is made to install 

the Message Manager again, the installation will turn out to be incomplete and a 

communication failure may occur in the communication between the Loader and 

connected devices. Be sure to start uninstallation after the Message Manager is 

closed.  

If uninstallation is performed while the Message Manager is running, execute "[3] 

After Uninstalling the Message Manager" after uninstallation. 
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[2] Uninstallation of the Message Manager 

This section describes how to uninstall the Message Manager from the start menu by selecting 

[Message Manager] -> [Uninstall Message Manager]. 

 

Windows 10 

On the Windows, select [Start] -> [All apps] -> [Message Manager] -> [Uninstall Message 

Manager]. 

Windows 8.1 

Left-click [All apps] icon  and then select [Message Manager] -> [Uninstall Message 

Manager]. 

 

 

 

When [Uninstall Message 

Manager] is selected, the 

uninstallation confirmation screen 

will be displayed as shown here. 

 

 

 

Upon confirmation, click [Yes]. 

Uninstallation is executed according to the above procedure. 

 

 

 

 

If the system is considered to be in 

a good state for restarting after 

uninstallation, click [Finish]. 

 

Restarting is particularly important 

if uninstallation is performed 

without closing the Message 

Manager. Be sure to restart the 

system. 
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[3] After Uninstalling the Message Manager 

The following actions are required if uninstallation is performed without closing the Message 

Manager. 

 

Restarting the PC 

Be sure to restart the PC at the end of "[2] Uninstallation of the Message Manager" on the 

previous page. 

 

Checking the Installation Folder for the Message Manager 

When the PC is started, using the Windows Explorer, access the installation folder for the 

Message Manager and confirm that the installation folder is deleted. 

 

 
 The installation folder for the Message Manager is a folder specified under 

"1.4.1.3 [2] Installation of the Message Manager" if the Message Manager has 

been installed using the VFD Doesa-Loader. 

The default folder is as follows. 

- 32-bit OS 

C:¥Program Files¥Common Files¥Fuji Electric Shared¥Message Manager 

- 64-bit OS 

C:¥Program Files (x86)¥Common Files¥Fuji Electric Shared¥Message 

Manager 

Here,"C:" is a drive letter for the disk or partition where the Windows is installed. If 

the Windows is installed in a different drive, substitute a drive letter for that drive. 

 

Deleting the Installation Folder for the Message Manager 

If the installation folder for the Message Manager exists, delete the installation folder. 
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[4] Supplement: Presence of Files during Uninstallation 

The following table shows the presence of files contained in the Message Manager installation 

folder during uninstallation. 

 

Uninstallation 

Presence of files inside the installation folder 

When the Message 

Manager is stopped 
When the Message Manager is executed 

Before starting 

uninstallation 

 

All the files 

required are 

present. 

   

When 

uninstallation is 

completed 

The installation folder 

does not exist. 

 

Some files are 

present. 

   

After restarting the 

PC 

The installation folder 

does not exist. 

The installation folder 

does not exist. 
 

 Some files may 
be present. 

 

 
   

When the 

installation folder is 

manually deleted 

  
The installation folder 

does not exist. 

 

 
 Do not install the Message Manager when some files are present in the folder. 

Otherwise, the installation will turn out to be incomplete and a communication 

failure may occur in the communication between the Loader and connected 

devices. 

 
  



 

Chapter 1 Before Use 

 1-47 

1.5. Settings Required Before Using the Loader 

1.5.1. Setting Function Codes Related to Communication on the 

Inverter Side 

The following section describes the function codes on the inverter side that are related to the 

communication with the Loader. Be sure to perform this setting before connecting the Loader 

with the inverter. 
 
  

 

Table 1-4  Inverter Function Codes Related to Communication with the Loader 

Function 

code 
Name Setting range 

y01, y11 Station address 1 to 255  

y04, y14 Baud rate 

0: 2400 bps 

2: 9600 bps 

4: 38400 bps 

 

1: 4800 bps 

3: 19200 bps 

 

y10, y20 Protocol selection 

0: Modbus RTU protocol 

1: Doesa protocol (Loader protocol) 

etc. 

The setting range and setting contents might differ depending on the model of the using inverter. 
 
 

Function codes that require settings depend on where the Loader is connected to. The function 

code setting ranges and guidelines by connection point are shown below. 

 

Table 1-5  Function Code Setting Ranges by Loader Connection Point 

 

Loader connection point 

RS-485 communication 
port 1 on the inverter  

(via a converter) 

RS-485 communication 
port 2 on the inverter  

(via a converter) 

USB connector on the 
VF1A-PH1 

F
u

n
c
ti
o

n
 c

o
d

e
 

y01 1 to 255 - 1 to 255 

y04 0 to 7 - - 

y10 0 to 2 - - 

y11 - 1 to 255 - 

y14 - 0 to 7 - 

y20 
Other than 1 

(In case of y10 = 1) 
0 to 2 - 

-: Not used. 
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Setting Guidelines 

Table 1-6  Setting Guidelines when the RS-485 Ch.1 and RS-485 Ch.2 are Connected 

Function code Setting Guidelines 
Reference section for 

Loader setting 

y01, y11 

Match with the [RS-485 station address] of the Loader. 

For multi-drop connection, avoid giving a duplicate 

address for other inverters. 

1.5.5.2. 

Connection Setting 

y04, y14 Match with the [Baud rate] of the Loader. 
1.5.5.1 

Communication Settings 

y10, y20 

◆ For models that support “Loader (Doesa)” protocol 

RS-485 Communication Port 1 

Set "1" to y10 and a number other than 1 to y20. 

RS-485 Communication Port 2 

Set "1" to y20. 

 

1.5.5.1 

Communication Settings 

 

 

 
 For Doesa protocol (Loader protocol), the Loader cannot be used simultaneously by 

multiple communication ports of the inverter. If the Doesa protocol (Loader protocol) 

is used simultaneously by multiple communication ports, the Loader communicates 

with the communication port that has the highest priority.  

The order of priority of the communication ports is as follows: the lowest priority is 

given to the RS-485 communication port 1 and the higher priority is given to the 

RS-485 communication port 2, and the next higher priority to the USB (via the 

remote keypad with USB). 

For example, if 1 is set to both y10 and y20, the Loader cannot communicate with 

the RS-485 communication port 1. So, be careful with the setting. 

 

Table 1-7  Setting Guidelines when the USB Connector on the VF1A-PH1 is Connected 

Function code Setting Guidelines 
Reference section for 

Loader setting 

y01 Match with the [RS-485 station address] of the Loader. 
1.5.5.2. 

Connection Setting 

y11 Not used. - 

y04, y14 Not used. - 

y10, y20 Not used. - 
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1.5.2. Checking Communication Ports on the PC (when Using a 

Converter) 

The communication port (COM) is used for the interface between the Loader on the PC and the 

inverter. 

Because of this, the converter to be used requires a function that operates as a virtual 

communication port (COM) and it is necessary to check the communication port (COM) number of 

the connected PC. 

(For details about the converter to be connected, refer to "1.2.2.2. Devices Required for RS-485 

Connection".) 

 

The following section describes the procedure to check the communication port number for each 

operating system. 

 

Windows 10 

Right-click the icon  and select [Device Manager] to open it. 

Windows 8.1 

Right-click the icon  on the [Computer], select [Properties] and then select [Device 

Manager]. 

 

 

 

 

 

 

 

Click the mark for Ports (COM & 

LPT) and check the number indicated 

in the square box in "USB Serial Port 

(COM)". 

 

In the example shown to the left, the 

number is assigned as"COM13". 
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1.5.3. Starting the Loader 

Windows 10 

On the Windows, select the icon   [  START]  [IDEC VFD]  [Doesa-Loader Start]. 

Windows 8.1 

Left-click [All apps] icon  and then select [IDEC VFD]  [Doesa-Loader Start].  
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Setting the Operating Environment 

When the Loader is started for the first time after installation, the language selection screen and 

region selection screen are displayed. 

These screen are displayed only once at the start of using your system. 

 

 

On the [Select language] window, select a language 

to be used for subsequent displays. 

 

 
 The language can be changed from the main menu by selecting [Setup] -> 

[Language].  

For details, refer to "2.4.3. Language". 

 

 

 

Next, select the "regional spec." for the inverter to be 

used. 

 

 
 The "regional spec." of the inverter can be found in the nameplate on the inverter. For 

details, refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" or the 

instruction manuals of relevant inverters. 

 

 
 The "regional spec." can be changed from the main menu by selecting [Setup] -> 

[Regional spec.]. For details, refer to"2.4.4. Region Spec.". 
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1.5.4. Overview of the Message Manager 

The Message Manager is software that is used to control the Loader communication. 

Unless the Message Manager is started, the Loader cannot communicate with devices 

connected. 

 

 

1.5.4.1. Checking the Startup of the Message Manager 

When the Loader is started, the Message Manager is automatically started. 

Confirm that the Message Manager icon  is displayed on the task bar.  

The display examples of the Message Manager icon are as shown below. 

 

Display Examples of the Message Manager Icon 

 
  

Left-click here, and hidden icons are displayed as shown below. 

 
 

 
 

The icon may be displayed here. 

 

 
 If the Message Manager icon  is not displayed even after the Loader is started, 

reinstall the Message Manager.  

For information on the installation procedure, refer to "1.4.1.6. Installation of the 

Message Manager". 

 You can also check the status of the message manager on the communication 

setting screen. Refer to “1.5.5.1 Communication Settings”. 
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1.5.4.2. Procedure for Closing the Message Manager 

The Message Manager does not automatically close even when the Loader is closed. 

Normally, there is no need to close the Message Manager. However, the Message Manager 

must be closed when it needs to be uninstalled, when the USB driver needs to be installed, or 

when the Message Manager needs to be restarted as a step to recover a communication 

failure. 

 

For information on procedures for closing the Message Manager, refer to "1.4.1.4. [1] Before 

Installing the USB Driver]" or "1.4.2.2. [1] Before uninstalling the Message Manager". 

 

 
 If an attempt is made to close the Message Manager while the Loader is running, a 

communication failure will occur in the Loader. When closing the Message 

Manager, be sure to close the Loader first. 
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1.5.5. Communication Setting and Connection Setting for the 

Loader 

When the Loader is started, the following screen (Quick Access menu) is displayed. 

By clicking an icon on the screen, you can start the corresponding function. The details of these 

functions are described in the later section. 

This section starts with an explanation on the communication setting function. 

 
 

 

 

 
 If the Quick Access menu is not displayed, click the  icon on the toolbar (the bar 

with various icons below the main menu as shown below) to display the Quick Access 

menu. 

 

 

 

 
  

Communication settings 

Quick Access Menu 
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1.5.5.1. Communication Settings 

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the 

[Communication setting] window. 

 

 

The [Communication setting] window can also be displayed, without using the Quick Access 

menu, by selecting [Setup] -> [Communication Settings] on the main menu or by clicking the 

icon on the toolbar. 

 

 

 

Referring to the following explanation, set the [Communication setting] window. 

 

 

 

 

Click the [Communication Setting 

Wizard] button to start a wizard to set 

communication settings easily. 

Refar to “1.5.5.1 [1] Communication 

Setting Wizard”. 

Click the [Connection setting] button to 

display the [Connection setting] 

window.  

For information on the [Connection 

setting] window, refer to "1.5.5.2. 

Connection Setting". 

 

  

Communication settings 
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[1] Communication Setting Wizard 

Communication settings can be completed by selecting the inverter to be used and the 

connection method in step by step , and the setting results are reflected in [1.5.5.1.[2] Port]. 

The next setting screen changes depending on what you select, so you can set it easily. 

The following is an example of screen transition when connecting to the VF1A series using USB 

via VF1A-PH1 remote keypad. 

 

 

  

Model Selection Connection Type Selection 

Keypad Selection Communication setting 

Setting Confirmation 
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[2] Port 

Set the following items related to communication. 

 

 
 If the communication settings using the settings wizard on the previous page have 

been completed, you do not need to reconfigure in this section. 

 

RS-485 Connection 

Select this for connecting the PC directly to the inverter via RS-485.  

For information on connection examples, refer to "1.2.2.1. [1] Multi-drop Connection Using the 

RJ-45 Connectors" or "1.2.2.1. [2] Multi-drop Connection Using Terminal Blocks". 

- Protocol 

Select the communication protocol. 

The supported protocols differ depending on the inverter. 

- COM port 

Select the communication port of the PC connected to the USB/RS-485 converter or 

RS-232C/RS-485 converter. 

 
 Check the communication port of the PC using the Device Manager of the OS. 

Refer to "1.5.2. Checking Communication Ports on the PC (when Using a 

Converter)". 

 

- Baud rate 

Set the baud rate. It must be set to the same value as the baud rate set for the inverter. 

 
 For information on the baud rate of the inverter, refer to "1.5.1. Setting Function 

Codes Related to Communication on the Inverter Side". 

 

- Parity 

Cannot be set in case the protocol is “Loader (Doesa)”. It is internally fixed to "Even". 

- Stop bit 

Cannot be set in case the protocol is “Loader (Doesa)”. It is internally fixed to "1 bit". 

 

 

 
 For information on recommended conditions of the RS-232C/RS-485 converter or 

USB/RS-485 converter, refer to "1.2.2.2. [1] Converter". 
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USB Connection 

Select when connecting the PC to the inverter or keypad using a USB cable. 

Select the following depending on the connection target.  

- Target Data 

- Data in Inverter (via VF1A-PH1) 

Select this when connecting the PC to the inverter using the USB connector of the 

VF1A-PH1.  

For information on connection examples, refer to "1.2.3.1. [1] Connection with the Inverter 

via the remote keypad with USB". 

- Data in Keypad 

Select this to access the memory in the VF1A-PH1.  

Select this when using the kepyad as a temporary memory medium.  

For information on connection examples, refer to "1.3.2. Connection between the PC and 

the keypad". 
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[3] Communication Conditions 

Set the following items related to communication retries. 

- Retry count 

Set the number of retries for when a communication failure occurs. If you set to a high 

number of retries, the possibility of recovering communication becomes high. However, the 

time until the error dialog is displayed becomes long as well.  

1 time or more is recommended. 

- Timeout 

If a response is not returned from the inverter within the time set here, the communication 

error dialog will be displayed. The shorter the timeout time is set, the more quickly the error 

display appears. However, if it is too short, a communication error may occur even when 

communication is normal because of the time taken up by the inverter for its processing. 

 

 

[4] Other 

 

- Device Manager 

Open Windows Device Manager to check the installation status of the USB driver. 

- Message Manager 

Displays the startup status of Message Manager. (ON: Indicates that it is working) 

For the Message manager, refer to [1.5.4 Overview of the Message Manager]. 

 
  



 

 1-60 

1.5.5.2. Connection Setting 

Click the [Comm Setting] icon on the left column of the Quick Access menu to display the 

[Communication setting] window. On this window, click the [Connection setting] button to display 

the [Connection setting] window. 

The [Connection setting] window displays information corresponding to the equipment name 

(inverter) on each row as shown below. Double-click the row for the equipment to be changed or 

added, and the [Advanced...] window shown on the next page is displayed. 

 
  

 

Selection of inverters for communication 

Put the  mark in the checkbox to the left of the "No." column to assign the corresponding inverter 

to be the communication target. 

 

 

Communication status 

Displays the state of communication between the 
Loader and the inverters. 

Unknown:  The communication status has not 
been confirmed. 

Connected:  Communication has been established.  

Disconnected:  Communication has not been 
established. 

 

  

 

 

Model 

Displays the model read from the 

inverter.  

If communication has not been 

established at all, [Unknown 

Model] is displayed. 

 
 

Equipment name, RS-485 

station address 

Displays what has been set on 

the [Advanced...] window.  

Number of display rows 

The number of rows depends on 

the port selected on the 

[Communication setting] window. 

If [RS-485] is selected, a multiple 

number of rows are displayed. 

If [USB] is selected, only one row 

is displayed. 

 Connection check 

Click the [Browse] button to check whether the connection is established between the Loader and the 

inverter specified by the  mark in the checkbox to the left of the "No." column.  

The check result is displayed in the "Status" column. 

 Setting 

Select the row to be edited and then click the [Advance...] button to display the [Advanced...] 

window shown below.  

It is also possible to double-click the row to be edited to display the [Advanced...] window.  

Settings on the [Advanced...] window are provided on the next page. 

 Delete 

Used to delete the inverter registered on the selected row.  

Used when removing inverters are disconnected from the Loader.  
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The [Advanced...] window is used to set [Equipment name] and [RS-485 station address]. 

 

Equipment name 

Enter the name of equipment where connected inverters 

are installed.  

Not used for communication.  

As shown in the display example below, the equipment 

name is used in the list menu for selecting target 

inverters on each screen. 

 

 
Display example of target inverters 

 

 Equipment name 
RS-485 station address 

RS-485 station address 

According to the port setting on the [Communication setting] window, follow the setting guidelines shown below to set 

the address. 

Port setting on the [Communication setting] window Setting Guidelines 

RS-485 Connection 

Used for communication. 

Match with the inverter's station address (function code 

y01 or y11). 

USB 

Connection 

  

Data in Inverter (via VF1A-PH1) 

Used for communication. 

Match with the inverter's station address (function code 

y01). 

Data in Keypad Used for communication. Only "1" can be set. 
 

 

 
 For information on the station address of the inverter, refer to "1.5.1. Setting 

Function Codes Related to Communication on the Inverter Side". 

 

 
 If a communication failure occurs due to a disconnection or other faults in one of 

the inverters registered under the [Connection setting] window, the response 

becomes extremely slow. Remove the faulty inverter from the list for the 

connection setting. 

 When using the operation monitor function, be sure to register the target inverter 

for monitoring in the No.1 row. When you want to monitor multiple devices 

connected in multi-drop connection, specify the monitored inverters serially in rows 

No.1, No.2, No.3, and so on. 

Example: When monitoring two inverters using the operation monitor function 

Good example 

 No. Communication 

status 

Model 

 1 Connected VF1A 

 2 Connected VF1A 

 3   
 

  



 

 1-62 

 

 
Bad example 

 No. Communication 

status 

Model   No. Communication 

status 

Model 

 1 Connected VF1A   1   

 2 Unknown status VF1A   2 Connected VF1A 

 3 Connected VF1A   3 Connected VF1A 

 

 

 

 



 

 
 

 
 
 
 

Chapter 2 

Function Description 
 

 

This chapter describes the main functions of the loader. 
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2.1. Main Window 

This is the window that first appears when the loader is started. The Quick Access menu is 

displayed on this screen when the loader starts. (The display has been omitted here.)  

Main menu 

You can select all the loader functions. 

Toolbar 

You can select the primary loader functions. 

 

Status Bar 

The text that describes the selected function appears in this 

area. It also displays the status of connection with the inverter 

in the lower right box. 

Main menu 

It contains six selectable functions: [File], [Menu], [Setup], [View], [Window], and [Help]. 

(When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options 

are added to the main menu.) 

 

Toolbar 

This allows you to select common functions quickly and easily. For example, to open a file which 

contains the function code data, you should normally click [File] on the main menu and then click 

[Open] under the [File] menu; accordingly two actions are required. Using the toolbar, you can 

open the file simply by clicking the  icon. 

 

Status Bar 

Hover the mouse pointer over a function icon or menu displayed. Then, the text appears that 

describes the meaning of the function or menu. 

 

Display example: The following text appears when you hover the mouse pointer over the 

[Perform Connection Check] icon on the toolbar. 

 

 

 

 

Descriptive text appears. 
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The lower right box is enabled when you configure the loader to "check the connection" using 

the communication settings (see "1.5.5.1. Communication Settings") or the [Connection Check] 

icon on the toolbar (see the display example above). 

When configured to check the connection, the loader checks the status of the devices marked 

with  in the [Connection Setting] window (see "1.5.5.2. Connection Setting") in the ascending 

order of their numbers at certain intervals and displays the result. 

 

Display example 

 

 No (number): Alarm status No (number): Communication status 

 

No (number): Identifies each device checked.  

The [Number] corresponds to the [No.] column of the [Connection Setting] 

window. 

Alarm status: Shows the inverter's alarm status. 

Displayed 

content 
Description 

Nothing is 

displayed 
The inverter is operating normally. 

Alarm detection 

(flashing) 
An alarm condition has occurred with the inverter. 

 

The alarm status is not displayed if the connection check is disabled or the 

connected device is the keypad. 

Communication 

status: 

Shows the status of the communications between the loader and the 

connected device. 

Displayed 

content 
Description 

Connected The communications link has been established. 

Not connected The loader cannot communicate with the device. 

 

"Unknown" appears when the connection check is disabled. 
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2.2. File 

The [File] menu provides the following submenus: 

 

 

 

 

 

 

 

[Print selected Symbol] 

[Print Preview selected Symbol] 

These submenus are available when the 

[Customizable logic] window is open. 

 

This section describes the main functions available under the [File] menu. 

 

 

2.2.1. Create a New File 

This function creates a new file of function code data. 

 

From the main menu, click [File] > [New...] to open the [Select function code data to edit] 

window. 

 

 
 

Standard function code window 

Select this when you want to edit standard 

function codes (such as F, E, C). 

 

Customizable logic function code 

window 

Select this when you want to edit 

customizable logic function codes (such 

as U, U1, UA, UB). 

Click either button to open the [Default setting] window. 
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The [Default setting] window lets you configure the information on the inverter for which you 

want to edit function codes.  

 

 

Model 

Select the model number. 

 

Regional specification 

Displays the region specified by selecting 

[Setup] -> [Region spec.] from the main menu. 

 

Voltage 

Select the inverter voltage. 

 

Capacity 

Select the inverter capacity. 

Change 

Change the definition file according to the 

inverter ROM version.  

Refer to "[2] Guidelines on Selecting a 

Definition File" on the next page. 

Definition file 

From the definition files installed, the loader 

automatically selects the most recent definition file. 

 

 

[1] Model, Regional Specification, Voltage, Capacity 

Correctly set these values according to the inverter for which you are editing function codes. 

You can identify these values from the inverter model number printed on the rating nameplate of 

the inverter. 

The following example shows the format of an inverter model number. For details, refer to the 

instruction manual of your inverter. 

 

 

For inverter type VF1A-G□□□□S4, the destination value (function code H101) is “5: Americas” 

by the factory default. 
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You can change the regional specification by selecting [Setup] -> [Region spec.] from the main 

menu. Once you have changed the regional specification, you have to quit and restart the loader. 

Refer to "2.4.4. Region Spec." for details. 

 

 
 If your specified model, regional specification, voltage, or capacity is different from 

that of the inverter, an error may occur when reading or writing function codes due 

to unmatched function code attributes or other reason. 

 

 

[2] Guidelines on Selecting a Definition File 

A definition file contains the information required to identify each inverter model and its functions. 

Select the appropriate definition file based on the definition file version, revision index, and 

inverter ROM version. 

 

Definition file version and revision index 

The displayed four-digit number is the ROM version, and one letter following to the version is the 

revision index.  

 In case of the Simplified display 

 

Display example: 

 
ROM version: 1300, and Revision index: a. 

 

 In case of the File name display 

Format of the definition file name (Example: VF1A) 

 

Display example: 

 ROM version: 900, and Revision index: -. 

 

  

_XXXXXX 

ROM version 

 

Revision index  

(Initially omitted and newer revisions are given a, b, c...) 

  

fnc_E_ x_8 __XXXXXX.csv 

ROM version 

 

Language (omitted for Japanese, E for English) 

 

Code representing the inverter model 

 

Revision index (Initially omitted and newer 

revisions are given a, b, c...) 
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ROM version of the inverter 

You can identify the inverter ROM version from the inverter keypad. For more information, refer 

to the instruction manual of your inverter. 

 

 
 When the Loader is connected to an inverter, you can identify the inverter ROM 

version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation 

Monitor] window, which you can access by selecting [Operation Monitor] from the 

Quick Access menu. 

 When the Loader is connected to an inverter, you can automatically select the 

optimum definition file by selecting [Read from the Inverter] (to read the settings 

from the inverter) from the [Edit data selection] window, which you can access by 

selecting [Menu] -> [Setting function code] -> [Edit data selection]. 

 

 
 If the selected definition file is not appropriate for the inverter ROM version, an 

error such as failure to read or set the desired function code may occur due to the 

difference in the number of function codes or other reason. If this is the case, you 

will have to use a different method such as the inverter keypad to access the 

desired function code.  

 

 
 If the inverter ROM version is unknown when creating a new definition file, you 

can change the definition file later. For more information, refer to "2.3.1.3. [3] 

Changing a Definition File". 

Changing a definition file may, however, cause an error due to the difference 

between definition files. You are recommended to select a definition file that is as 

appropriate as possible when creating a new one. 

 

 

Guidelines for selecting definition files 

Some guidelines on selecting a definition file are shown below. 

 If there is a definition file of the same version as the inverter ROM version: 

Select the definition file that is of the same version as the inverter ROM version and has the 

newest revision index. 

 

If there is not a definition file of the same version as the inverter ROM version, select the 

appropriate definition file as described below. 

 If the inverter is VF1A 

Select the definition file that is of the same version as the replaced version according to the 

"3.2.5. Replacement of Inverter ROM Versions" and has the newest revision index. 

 If there is not the inverter ROM version in "3.2.5. Replacement of Inverter ROM Versions": 

The inverter may have been upgraded after the release date of your loader. Access the 

technical support page on IDEC website and check for the latest loader version upgrade file. If 

one exists, download and use it. 

If the loader or the definition file is up-to-date but the inverter ROM version is still later than the 



 

Chapter 2 Functional Description 

 2-7 

versions of all the definition files, select the definition file that is of the version earlier than but 

closest to the inverter ROM version and has the newest revision index. 

 

 If there are only definition files whose versions are different and later than the inverter ROM 

version: 

Select the definition file that is of the version earlier than but closest to the inverter ROM 

version and has the newest revision index. 

 

 

 
 If an error occurs in reading or writing function codes after you have selected a 

definition file in accordance with the above guidelines on selecting a definition file, 

contact your IDEC representative. 
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2.2.2. Open 

Selecting [Open] displays a window that allows you to open and edit or view a saved, existing 

file that contains function code, realtime trace, historical trace, trace back, customizable logic, or 

scheduled operation information.  

 

 

 

Filter 

Select the type of files displayed in 

the list. Change the filter to display 

the files saved from a loader other 

than VFD Doesa-Loader. 

 

Open 

Opens the selected file. 

 

File types 

 VFD Doesa-Loader 

Function code data 
*.FNL 

*.FBL 

Realtime trace data 
*.RT2 

(*1) 

Historical trace data *.HT2 

Customizable logic project data *.CML 

 

 

(*1) To open an RT2 file that contains the traces of the signals added using the trace monitor 

function and correctly display the signal names, units, and data step sizes, you have to 

provide the customizable logic project data with which the trace monitor information was 

saved. 

 
 For more information on the trace monitor function, refer to "2.3.4.10. 

Combination with the Customizable Logic Function". 
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 The file types shown on the previous page are the types of the files available in the 

[Open] dialog. For more information on the file types used in VFD Doesa-Loader, 

refer to "3.2.1. Type of Files Used by VFD Doesa-Loader". 

 

 

You can also drag and drop a file on the loader screen to open it. 
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2.2.3. Close 

Closes the currently active window. 

 

 

2.2.4. Save 

This function is available when [Function Code List], [Customizable Logic], [Realtime Trace], 

[Historical Trace], or [Trace back] window is active. Selecting [Save] saves the data in the active 

window. 

If the data has not been saved before, the [Save] function does the same operation as "2.2.5. 

Save As". 

 

 

2.2.5. Save As 

This function opens the following dialog, which allows you to enter the name of the active file 

and save it under the entered name. 

 

* The types of files you can save are as follows: 

- Function code data:  *.FNL, *.FNB 

- Realtime trace data:  *.RT2, *.CSV 

- Historical trace data:  *.HT2, *.CSV 

- Trace data (graph image):  *.JPG, *.BMP 

- Customizable logic project file:  *.CML 

 

 
 The length of the path and file name should be up to 200 single-byte characters (up 

to 100 double-byte characters). Otherwise the file cannot be saved. 
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2.2.6. Print 

This function allows you to specify the printer, its properties, the print range, and the number of 

copies to be printed. 

 

 

Printer Name 

Select an available printer 

Properties 

Specify the detailed settings 

specific to the selected printer 

Print Range 

Currently fixed to the [All] 

option 

Number of copies 

Specify how many copies to 

print 

OK 

Click this button to start 

printing 

 
 
 
 

2.2.7. Print Preview 

This function allows you to view the print preview of the data in the currently active [Function 

Code List], [Trace], or [Customizable logic] window. 

 

Example:  Print preview of the data in the [Function Code List] window 
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2.2.8. Page Setup 

This function, which is available when the [Function Code List] or [Trace] window is active, 

allows you to configure page settings. 

 

 

 

2.2.9. Exit 

This function allows you to exit from the loader. 
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2.3. Menu 

[Menu] provides the following submenus: 

 

 

 

 
 

 

 

 

All the options except [Terminal operation] and [Quick Access Menu] are accessible from the 

[Quick Access Menu] window as well. 

This section describes the main functions available under [Menu]. 
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2.3.1. Function Code Settings 

Select [Menu] > [Function code edit] from the main menu or click  on the main window 

toolbar and click [Function Code] to open the [Select function code to edit] window. 

 

The [Select function code data to edit] window allows you to select the source of the function 

code data you want to view/edit. 

 

 

Standard function code list 

Select this when you want to edit standard 

function codes (such as F, E, C). 

Customizable logic function code list 

Select this when you want to edit customizable 

logic function codes (such as U, U1, UA, UB).  

[Create new function setting] 

Click this button to open the [Function Code List] 
window when you want to create a function code from 
scratch. 
Refer to "2.2.1. Create a New File". 

[Read from the file] 

Click this button to open a function code data file 
saved in your PC. 
Refer to "2.2.2. Open". 

[Select inverter] 

([Select keypad]) 

From the list of the registered inverters in the 

[Connection Setting] window, select the inverter you 

want to read function code data from. 

Refer to "1.5.5.2. Connection Setting". 

 

Once you select [Data in Keypad] for [USB Connection] 

on the [Communication Setting] window, this label 

changes to [Select keypad]. 

[Read from the inverter] 

([Read from the keypad]) 

Click this button to read function code data from 

the selected inverter and open the [Function 

Code List] window. 

 

Once you select [Data in Keypad] for [USB 

Connection] on the [Communication Setting] 

window, this label changes to [Read from the 

keypad]. 

In this case, click this button to read function 

code data from the selected keypad and open 

the [Function Code List] window. 
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2.3.1.1. Function Code Edit 

The following is the description the [Function code edit] tab of the [Function Code List] window. 

This tab allows you to edit function code data while viewing the function code settings and their 

ranges.  

You can sort function codes based on various criteria. 

When the [Function Code List] window is displayed, the [Edit] and [FunctionCodeEdit] options 

are added to the main menu. 

Tree view 

[Function]:  Display the function codes by group. 

[Change from Factory-set Values]:  Displays the function codes with settings different from the factory-set values  

(excluding communication codes).  

[Contents of change (blue)]:   Displays the edited function codes before written to the inverter or keypad.  

[R/W failure (pink)]:  Displays the function codes that could not be written to or read from the inverter 

or keypad. 

[User Definition]:  The user can freely define the display items.  

 

[Communication Code]:  Displays communication function codes only.  

[Comparison Result]:  Displays the results of the comparison with the inverter or keypad function code 

settings or saved files only. 

[Search Result]:  Displays the result of the [Edit] -> [Search] operation only. 

Edit 

This menu item is added once you open the 

[Function Code List] window. [Edit] provides the 

following menu options: [Undo], [Factory-set] (see 

"2.5. Edit"), and [Search] (see "2.3.1.1 [8] 

Search"). 

Function Code Edit 

These menu items are added once you open the [Function Code 

List] window.  

You can save and load function code settings in the CSV format.  

This feature is useful when you want to edit function code settings 

in an external application such as Microsoft Excel and then load 

them into the loader. 

Refer to "2.7. Function Code Edit" for details. 

View 

Once you open the [Function Code List] window, the following menu options are added 

to [View]: 

[Function code info]:  Same as the [Function code info] button displayed at the bottom.  

[Font size]:  Allows you to change the font used for function code names, etc.  

Refer to "2.6.3. Parameter Information and Character size" for 

details. 

Change of Setting 
Values 

You can select the function 

code data from the drop 

down-menu or edit window. 
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The following buttons are available at the bottom of the [Function code Edit] tab: 

 

[Read]: Allows you to read the function codes from the selected 

inverter or keypad and load them into the loader.  

[Write]: Allows you to write the edited function codes to the inverter 

or keypad. 

[Factory-set]: Resets the selected function code to the factory-set value. 

[Func. code set]: Displays the selected function code setting in the [Setting 

value] window. For function codes whose settings are 

available for selection from the list, however, the [Setting 

value] window does not appear.  

[Func. code info.]: Displays the selected function code information in the 

[Function code info] window. 

[Initialization]: This button, available when an inverter is selected, 

initializes the function code settings within the inverter.  

It is not available when a keypad is selected.  

[Advanced]: Displays a dialog that allows you to change the display 

items and print settings. Select [Error Clear] to delete the 

list of function codes that could not be written or read so 

that no function codes are displayed in [R/W failure (pink)] 

in the tree view. 

[Print]: Prints the function code list selected in the tree in the left 

pane. 

[Comparison]: Allows you to compare the inverter data with the list, the 

keypad data with the list, or the function code settings in a 

saved file with the list.  

The results of comparison appear in [Comparison Result] in 

the tree view. 

[Select inverter] 

([Select keypad]) 

Refer to the description 

below. 

 

[Close] 

Closes the [Function Code 

Setting] window. 

 

 

[Select inverter] ([Select keypad]) 

Select the inverter or keypad you want to write the data to. When there is only one inverter or 

keypad, you do not have to select it. When you are using RS-485 multi-drop connection, you 

have to select the desired one from the list.  

As described in the following table, whether you should select an inverter or keypad as the 

read/write target is determined by the port setting in the [Communication Setting] window. The 

list corresponds to rows marked with in the [No] column in the [Connection Setting] window, 

and the number of list entries is equal to the number of  marks. 

For information on the [Communication Setting] window, refer to "1.5.5.1. Communication 

Settings".  

For information on the [Connection Setting] window, refer to "1.5.5.2. Connection Setting". 

 

Table 2-1  Relationship between [Communication Setting] and your inverter (keypad) selection 

Port setting in the [Communication Setting] window 
Target inverter (Target keypad) 

Target List entries 

RS-485 connection Inverters 1 or greater 

USB 

connection 

Data in inverter (via VF1A-PH1) Inverters 1 

Data in keypad Keypad 1 
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[1] Read the Function Code Settings from the Inverter or Keypad 

If you have selected an inverter, click [Read] button to open the following dialog.  

Click [OK] to read the function code setting values from the inverter.  

 

 

The above applies also if you have selected a keypad. Click [OK] to read the function code 

setting values from the keypad. 

 

 
 Be sure to read from a keypad that contains data. You cannot read from a keypad 

that contains no data, as is the case when you have purchased a new keypad. 

 

- If function codes you want to read or write are password-protected: 

 
 If the inverter has password protection enabled, do not read function codes from it. 

Before reading from the inverter, be sure to disable password protection. If you 

attempt to read from the inverter with password protection enabled, you may fail to 

read your desired function codes or the read operation may take a long time.  

This applies also to the write operation. Disable password protection before writing 

to the inverter. 
 

 
 For more information on password protection, refer to the instruction manual or 

user's manual. 

 

 

 [2] Write the Function Codes from the Loader to the Inverter or Keypad 

To write function codes to the inverter or remote keypad with USB, use the [Write] button 

displayed at the lower left of the [List Edit] window that appears when editing function codes. 

The [Select function code data write operation] window opens. 
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These option buttons are only enabled for inverter models that have function code y97. They 

are disabled (as shown below) for inverter models that do not have function code y97 or when 

you write to a remote keypad with USB. 

 

 

Hereinafter in this manual, the inverter or remote keypad with USB you want to read to or write 

from is referred to as the "target device". 

 

- [Editing function code data (blue part) only] 

Writes to the target device only the function code settings edited in the loader but not yet 

written to the target device (blue part). 

 

- [Registered user definition function code data only] 

Writes to the target device only the function code settings registered as user definitions in 

the [List Edit] window. 

 

- [Different from the factory function code data (with *) only] 

Writes the settings to the target device only when they are different from the factory-set 

values (with *) (excluding Read-only function codes). 

 

- [All function code data] 

Writes all the function code settings to the target device (excluding Read-only function 

codes). 

 

- [Write function code to the EEPROM (Write 2 to y97)] 

This option is disabled for inverter models that do not have function code y97 or remote 

keypads with USB. 

Select this option if you want to: 

 Save your edited function codes to an inverter configured to save the data in the 

temporary storage memory (i.e., with y97 set to 1) and retain them in the non-volatile 

memory 

 Change the setting of function code y97 (from 1 to 0 or from 0 to 1) 

 Write a large number of changed function code settings to an inverter configured to 

save the data to the non-volatile memory (with y97 set to 0) 

The loader sets y97 to 2 to save the function code settings to the non-volatile memory of 

the inverter. This ensures that the function code settings are saved to the non-volatile 

memory even if y97 is set to 1 (i.e., the inverter is configured to write to the temporary 

storage memory). 

(However, some function codes such as S01 are saved to the temporary storage 

memory.) 

In addition, when function code y97 exists in the [Function code edit] window and you 

write the function codes, the loader writes the setting of y97 as well. 
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 Therefore, when function code y97 exists in the [Function code edit] window and you 

write the function codes, do not forget to edit y97 in the [Function code edit] window 

as appropriate. Even if you do not select y97 as the function code to be written, the 

loader writes y97. If you do not want to change y97 in the inverter, ensure that the 

y97 setting in the loader is the same as in the inverter. 

 

 
 Be sure to select this option when you write a large number of changed function 

code settings to an inverter configured to save the data to the non-volatile memory 

(with y97 set to 0). You can shorten the write time by selecting this option rather than 

the [Write function code following y97 setting (Do not write y97 function code)] 

option. 

 

 
 Selecting this option causes the loader to save all function codes (including those 

not selected) to the non-volatile memory. 

 

 
 When the inverter is configured to save the data in the temporary storage memory 

(i.e., with y97 set to 1) but you want to save the selected function codes to the 

non-volatile memory, follow these steps:  

First select [Write function code to EEPROM (write 2 to y97)] to set y97 to 0.  

Next, select [Write function code following y97 setting (Do not write y97 function 

code)] to write settings to the function codes you want to change.  

Finally, select [Write function code to EEPROM (write 2 to y97)] to set y97 to 1. 
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The loader writes function codes in accordance with the following flowchart when [Write 

function code to EEPROM (write 2 to y97)] is selected: 

 

 

 
 If the write operation is cancelled during the period between (b) and (c) in the 

flowchart above, function code y97 is set to 1. Therefore, when you restore the 

settings before the write operation after cancellation, you should also restore the 

original setting of y97. 

 

  

Write standard function codes from 

the [Function code edit] window to 

the inverter  

START 

Write 1 to y97 

Write settings to all the specified 

function codes 

Write 2 to y97 

Write the setting to y97 

Write 2 to y97 

END 
  

Write customizable logic function codes 

from the [Function code edit] window to 

the inverter  

START 

Write 1 to y97 

Write settings to all the specified 

function codes 

Write 2 to y97 

Write the setting read in (a) to y97 

Write 2 to y97 

END 
  

Read y97 from the inverter (a) 

(b) 

(c) 
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- [Write function code following y97 setting (Do not write y97 function code)] 

This option is disabled for inverter models that do not have function code y97 or remote 

keypads with USB. 

Select this option if you want to: 

 Save your edited function codes to an inverter configured to save the data in the 

temporary storage memory (i.e., with y97 set to 1) and retain them in the temporary 

storage memory (you do not want to save them in the non-volatile memory). 

 Write a smaller number of changed function code settings to an inverter configured to 

save the data to the non-volatile memory (with y97 set to 0). 

The setting of y97 in the inverter determines whether the function code settings written are 

saved in the non-volatile or temporary storage memory of the inverter. 

When you write to an inverter configured to save the data to the non-volatile memory (with 

y97 set to 0), the settings are saved one by one to the non-volatile memory of the inverter. 

For this reason, when you write a large number of changed function code settings, the write 

time is longer than when you select [Write function code to EEPROM (write 2 to y97)]. 

Even if the function codes written include y97, the setting of y97 is not written to the 

inverter. If you want to write the setting of y97 to the inverter, select [Write function code to 

EEPROM (write 2 to y97)]. 

 
 If you want to update to the latest settings after the write operation. check [After 

writing read out the function code data from the inverter] ().  

The above applies also if you have selected a keypad. Check [After writing read out 

the function code data from the keypad] (). 

 

 

- What to do if the write operation fails 

The loader is not able to identify function codes whose write attribute (write 

enabled/disabled) dynamically change (for example, function codes that cannot be changed 

during operation). If you attempt to write such function codes, the write operation may fail. 

If your selected function codes include those that cannot be written, the loader attempts to 

write all the selected function codes and, after the write operation, displays a list of the 

function codes that could not be written. 

 

You can save the displayed list to a CSV file by clicking [Save...] at the lower right of the screen. 
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After you closed the error window, you can save same information in CSV format by [Export 

to CSV (Last error Info.] in [Function Code Edit] (see [2.7.Function Code Edit]) on the Main 

Menu. 

 

To check the function codes that could not be written, select [R/W failure (pink)] from the 

[Function code edit] tree. 

 

The settings of the function codes that could not be written are displayed in pink. 

 

 

 

Displayed in pink. 

The write operation may fail due to the following reasons: 

 An attempt was made to write to a function code that cannot be changed during inverter 

operation. 

 An attempt was made to write to a function code protected from edit via a link 

(communication).  

Example: When the frequency command for RS-485 communication port 1 was enabled 

(with H30 set to 1) and the loader was connected to RS-485 communication port 2, an 

attempt was made to write to S01 (frequency command). 

 An attempt was made to write to a password-protected function code. 

 Write was cancelled in the middle. 

 

To hide function codes from [R/W failure (pink)], right-click [R/W failure (pink)] in the 

[Function code edit] tree. 

 
 

Then click [Clear] on the context menu to hide the function 

codes that could not be read or written. 
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Alternatively, you can also hide the function codes that could not be read or written by 

clicking the [Advanced] button at the bottom of [Function code edit] and then clicking [Error 

Clear]. 

 

 

- Writing customizable logic function codes from the list 

 

 
 When customizable logic function codes (U, U1, UA, UB, etc.) are displayed in the 

[Function code edit] window and you wish to write your edited function codes by 

selecting [All function code data], edit UA00 to UA69, rather than U01 to U70, for 

customizable logic steps 1 to 14. 

 

U01 and UA00, U02 and UA01, ..., U70 and UA69 are written, respectively, to the same 

memory addresses of the inverter. If you write by selecting [All function code data], U01 to 

U70 are overwritten with UA00 to UA69, which are written later. 
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[3] Change the Settings 

How to change the setting varies among function codes. 

(1) To change the setting of a function code that sets frequency, time, voltage, or other numeric 

value, click the field of the function code setting. 

 

 

Select the desired function code and click the [Set] button at the bottom of the screen or 

double-click the setting field. In the [Setting value] window that appears, change the 

setting. 

 

 

For function codes whose settings are available for selection from the list, however, the 

[Setting value] window does not appear. 

 

 

(2) For function codes whose settings are available for selection from the list (for example, F00 

"data protection" or F01 "frequency setting 1"), click the desired function code setting field 

to display the  button. Then click the  button to select the desired data from the list. 

 
 
 

 
 When the changed function code data has not been written to the inverter, the data 

is displayed in blue. 

  When the changed function code data is different from the factory-set values, the 

[Change] column is marked with * in the [Function code edit] window. 
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[4] Save 

To save the function code settings opened in the loader, select [File] -> [Save] or [Save As ...] 

from the main menu. 

 
 

When selecting [Save] for the data for the first time, the following dialog will open in the same 

manner as when selecting [Save As …]. 

Select [Save to ...] and enter the file name under which the data is saved in [File Name]. Then 

click [Save] to save the file.  

 
 

*.FNL: File format specific to the loader. Standard function code data (such as F, E, C). Files in 

this format can be opened only in the VFD Doesa-Loader. 

*.FBL: File format specific to the loader. Customizable logic function code data. Files in this 

format can be opened only in the VFD Doesa-Loader. 

 

 
 You can also save standard function code data (such as F, E, C) in the CSV format.  

For more information, refer to "2.7. Function Code Edit". 

 

 
 The length of the path and file name should be up to 200 single-byte characters (up 

to 100 double-byte characters). Otherwise the file cannot be saved. 
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[5] Print 

You can print the items selected from the tree in the left pane of the [Function code edit] window. 

Once you select [Function] or [Code group] from the tree in the left pane of the [Function code 

edit] window, function codes such as F, E, C, ... or the group name appears. 

Click the [Print] button displayed at the lower right of the [Function code edit] window or select 

[File] -> [Print] from the main menu to display the [Print] window. 

Refer to "2.2.6. Print". 

 

How to set simple printing... 

To print only the function code numbers and setting values from among the items displayed in 

the [Function code edit] window, click the [Advanced] button at the bottom of the window to open 

the [Advanced] dialog and click [Print Setting]. On the [Print Setting] dialog that appears, check 

() [Simple Printing] and click [OK]. Note that this operation only determines the settings and 

does not actually print the data. 

 
 

 
 

How to view the print preview before actually printing... 

Select [File] -> [Print Preview] from the main menu. 
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[6] Compare 

You can compare the function code setting data you are currently editing with the function code 

settings in the inverter selected in [Select inverter], the function code settings in the selected 

keypad, or the function code settings saved in a file and view the results. 

 

 

[Compared with 

inverter] ([Compared with keypad]) 

If the target device is an inverter, the loader 

compares the function code setting data you 

are currently editing with the function code 

settings in the inverter. 

If the target device is a keypad, the label 

changes to [Compared with keypad] and the 

loader compares the function code setting 

data you are currently editing with the 

function code settings in the keypad. 

 

[Compared with file] 

The loader compares the function code 

setting data you are currently editing with the 

function code setting data saved in the file. 

 

[Comparison results include 

ReadOnly] 

Check this checkbox to include "Read-Only" 

function codes in the scope of comparison. 

 

[Comparison results include 

Communication code] 

Check this checkbox to include 

"Communication Code" function codes in the 

scope of comparison. 

 

Close 

Close this dialog. 

 

* You should select the inverters to be compared in advance by clicking  next to the [Select 

Inverter] box at the bottom of the [Function code edit] window. 

 

Upon completion of comparison, the focus automatically moves to [Comparison Result] in the 

left pane tree of the [Function code edit] window and the comparison results are listed. 

 
VF1A-G21A5S4 
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[7] User Definition (Display desired function codes only) 

Registration 

To register function codes in a user definition, select your desired function code(s) from the list 

of function codes displayed in the [Function code edit] window and click the right mouse button. 

The available user definition group names ("User Definition 1" to "User Definition 5" in the 

example below) are displayed on the submenu. Click your desired user definition name. The 

selected function codes are then registered in that user definition. 

 
 

Display 

From the list of user definition groups displayed in the tree in the left pane ("User Definition 1" to 

"User Definition 5" in the example below), select and left-click your desired group to display the 

function codes registered in that group. 

 

 

Unregistration 

To unregister a function code(s), select your desired function codes and click the right mouse 

button. Select your desired user definition group from among the user definition groups marked 

with  on the submenu, and left-click it. The selected function codes are unregistered. 

If your selected function code is registered in two or more user definition groups, you can 

unregister that function code from all the user definition groups by left-clicking [Release user 

definition] on the submenu. 
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Renaming a user definition name 

 

To rename a user definition, left-click or 
right-click one of "User Definition 1" to "User 
Definition 5" in the tree in the left pane and 
left-click [Name change]. 

 

About writing and reading to the inverter 

For supported inverter models, the contents of favorites (formerly known as quick setup) set in 

the inverter are read as user-defined, and conversely, the contents of user-defined are written as 

inverter favorites. 

Refar to “2.3.1.1 [1] Read the Function Code Settings from the Inverter or Keypad”. 
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[8] Search (Search function code terminologically) 

Select [Edit] -> [Search] from the main menu to open the [Search] dialog. 

 

From among the words contained in the 

Function code edit window, enter the keyword 

to be searched and click the [OK] button. 

 

The focus automatically moves to [Search 

Result] in the left pane tree of the [Function 

code edit] window and the function codes that 

include the entered keyword are listed. 

 

The following is an example of searching keywords "voltage" and "current" with the OR 

condition. 

 

 

Delimit keywords "voltage" and "current" with 

a single-byte space. 

 

Select [OR]. 

 

Function codes that include "voltage" OR "current" are listed. 

 

 

 
 The search target range includes all items (changes, No., function code names, 

setting values, and so on).  

However, the items hidden by clicking [Advanced] -> [Display Item] are also 

included in the search target. 

 The text of function code information are not included in the search target. 
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2.3.1.2. Auto Tuning 

This function automatically measures the motor parameters and saves them to the inverter.  

 

 
 Before performing tuning, carefully check the description of tuning (including the 

settings required before tuning, machine preparation, precautions, etc.) in the 

User's Manual of your inverter. 
 

  

 
 

[Motor tuning (Select)] 

Select the tuning method. 

Check the condition of the machine to determine whether to perform "Inactive tuning" or "Active tuning".  

(For more information, refer to the User's Manual of your inverter.) 

[Motor] 

Displays the currently 

selected motor. 

[Tuning result] 

Displays the tuning result 

upon completion of tuning. 

[Tuned result] 

Clicking the [START] button causes the loader to read the 

motor parameters from the inverter and display them in 

the [Before] column. 

Upon completion of tuning, the loader reads the motor 

parameters from the inverter and displays them in the 

[After] column. 

 

[Rotation 
direction] 

[Loader (FWD)]: Forward 
rotation  
[Loader (REV)]: Reverse 
rotation 

Select either of the two 
rotation directions 
according to the direction 
in which the machine 
actually rotates. 

[Motor parameter] 

Clicking the [START] 

button causes the loader 

to read the motor 

parameters from the 

inverter and display 

them. 

[Auto tuning] 

Click the [START] button to start 

tuning. 

When you click the [START] 

button, a confirmation dialog 

appears. Click [OK] on the 

confirmation dialog to start tuning 

in the direction selected under 

[Rotation direction]. 

[Select inverter] 

Select the inverter 

you want to tune. 
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2.3.1.3. File Information 

This function displays the information related to the currently displayed list of function codes. 

You can change [Voltage], [Capacity] and [Current definition file] as you want. 

 

[Properties] 

- If you have read function codes from the inverter, this area 

displays the inverter information. 

- If you have read function codes from the keypad, this area 

displays the inverter information saved in the keypad. 

- If you have opened the [Function Code Setting] window by clicking 

[Create new function setting], this area displays the initial settings 

for creating a new function code. 

- If you have opened a saved data file by clicking [Open] under the 

[File] menu, this area displays the information contained in the 

saved file. 

Comment 

You can save a comment as needed. 

 

[Change] 

Click this button to open the [Setting] dialog shown at 

right.  
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[1] Changing the Input Power Supply Voltage 

You can change the input power supply voltage of the inverter whose function code data is 

currently displayed in the function code list. 

Correctly set these values according to the inverter for which you are editing function codes. 

 

 
 You can identify the input power supply voltage from the inverter model number 

printed on the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional 

Specification, Voltage, Capacity" for details. 

 

Changing the value in the [Voltage] box automatically modifies the [Setting], [Factory-Set Values], 

[Minimum] and [Maximum] values of function codes whose factory-set values change depending 

on the voltage setting (for example, function codes whose data copy attribute is set to "1"). 

  

 

 
 As shown in the above dialog, changing the voltage setting automatically 

initializes the settings of the function codes related to the voltage. So, save the file 

you are currently editing as needed. 
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[2] Changing the Inverter Capacity 

You can change the capacity of the inverter whose function code data is currently displayed in 

the function code list. 

Correctly set these values according to the inverter for which you are editing function codes. 

 

 
 You can identify the inverter capacity from the inverter model number printed on 

the rating nameplate of the inverter. Refer to "2.2.1. [1] Model, Regional 

Specification, Voltage, Capacity" for details. 

 

Changing the value in the [Capacity] box automatically modifies the [Setting] and [Factory-Set 

Values] values of function codes whose factory-set values change depending on the capacity 

setting (for example, function codes whose data copy attribute is set to "2") to the values 

associated with the new capacity value. 

  

* For some models, current types are displayed enclosed in (). Example: 11 kW (0022) 

 

 
 As shown in the above dialog, changing the capacity setting automatically 

initializes the settings of the function codes related to the capacity. So, save the 

file you are currently editing as needed. 
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[3] Changing a Definition File 

Select a definition file appropriate for the inverter ROM version. 

For example, your selected definition file may not be appropriate if you have been using a 

definition file with default settings because the inverter ROM version was unknown when you 

created the function code list. If this is the case, you should select a different definition file. 

 

 
 If the selected definition file is not appropriate for the inverter ROM version, an 

error such as failure to read or write function codes may occur due to the 

difference in the number of function codes or other reason. 

 

 
 If you read the settings from the inverter by selecting [Read from the inverter] on 

the [Menu] -> [Function code edit] -> [Select function code to edit] window, the 

loader automatically selects the optimum definition file and therefore you usually 

do not have to select a different definition file. 

 

To change the definition file, click the [Change] button on the [Setting] dialog.  

 

 

 

 

 

From among the definition files 

displayed on the list, select the 

definition file appropriate for the 

inverter ROM version and click the 

[OK] button. 

 

For information on how to select a 

definition file, refer to "2.2.1. [2] 

Guidelines on Selecting a Definition 

File". 
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Changing a definition file may, however, cause an error due to the difference between the 

definition files before change and after change. 

The figure below shows an example of an error that may occur when you change the definition file 

from "fnc_E_x_8_0900.csv" to "fnc_E_x_8_0600.csv". The function code settings not affected by 

the file read error are applied as-is. 

 

 

 

 

 
 Any function codes that existed before the change of the definition file but do not 

exist after the change are deleted from the [Function code edit] window. 
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2.3.2. Operation Monitor 

You can monitor the status of the inverter during operation. 

Select [Menu] > [Operation Monitor] from the main menu or click  on the main window 

toolbar and click [Operation Monitor Setting] to open the [Operation Monitor] window. 

 

 

 
 You should use the [Operation Monitor] window only when the loader is connected 

to an inverter or keypad. The loader displays no signal if you open the [Operation 

Monitor] window without connection. 

 Depending on the communication link condition, it may take a long time to detect 

the communication target. The loader does not respond until the communication 

target is detected. To avoid the inability to operate the loader for a long time, you 

should use the loader in an environment with as good communication conditions 

as possible. 

 Whenever you use the [Operation Monitor] window, specify the monitored inverter 

in the No.1 row on the [Communication Setting] -> [Connection Setting] window. 

When you want to monitor multiple devices connected in multi-drop connection, 

specify the monitored inverters serially in rows No.1, No.2, No.3, and so on. For 

information on [Connection Setting], refer to "1.5.5.2. Connection Setting". 

 

If you have selected [Data in Keypad] for [USB Connection] on the [Communication Setting] 

window and the loader is connected to a keypad, the [Operation Monitor] window displays the 

inverter information saved in the memory of the keypad. For information on the memory function 

of the remote keypad with USB, refer to "1.3.1 Memory Function of the keypad". 

 

 
 Be sure to read from a keypad that contains data. You cannot read from a keypad 

that contains no data, as is the case when you have purchased a new keypad. 
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2.3.2.1. I/O Monitor (for monitoring inverter input and output terminals) 

You can monitor the status of an inverter's input and output terminals. 

 
 

[Save CSV file] 

Allows you to save the I/O 

monitor data to a CSV file. 

[Refresh] 

Update the terminal 

function, status, and 

values. 

[Advanced] 

Click this button to 

show/hide signals and 

change the display order. 

[Target inverter] 

Select the inverter you 

want to monitor. 

 
 

Status color 

Green if a normally-open terminal is open or a normally-closed terminal is closed; orange otherwise. 

[Normal] [Status (Open)] [Status (Closed)] 

Open Green Orange 

Close Orange Green 

 

Special value 

If '3276.7' is displayed as the value for an output terminal, it means that the output terminal is not 

associated with an output type expressed with a unit of measurement (voltage output [V], current 

output [mA], pulse output [p/s]). 

For example, when the value for 

terminal FM is displayed as 

shown at right, this terminal is 

not associated with current 

output (unit: mA). 

 

 

 
 When the loader is connected to an inverter that has password protection enabled, 

the functions of terminals may not be displayed (with [READ_ERR] displayed 

instead). If this is the case, you should disable password protection to have the 

terminal functions correctly displayed. For more information on password protection, 

refer to the instruction manual or user's manual of your inverter. 
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How to show/hide signals and change the display order 

Click the [Advanced] button to open the [I/O monitor display item select] window. 

This window allows you to select which signals to display in the [I/O Monitor] window and 

change the display order. 

 

 
 
 

Initialize 

Click this button to initialize 

the settings. 

Select 

Click this button to open a 

saved setting file. 

Save 

Click this button to save 

the settings to a text file 

Close 

Click this button to close 

the window. 

 

 

To hide a signal 

 

 
Left-click the signal you want to hide. 
 

 

 
Left-click it again to activate the list box. 
 

 

 
Select the blank from the list. 
 

 

 
Click [Save] to save the settings 
to a file. 
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To change the display order 

For example, suppose you want to move [FWD] to the position of [X1]. 

 

 

Hide the signal you want to move. 
(Refer to "To hide a signal" above.) 
 
[FWD] is hidden in the example at left. 

 

 
Left-click the destination position. 
 
[X1] is left-clicked in the example at left. 

 

 
Left-click it again to activate the list box. 
 

 

From the list, select the signal you want to move. 
(The list displays the currently selected signal and the hidden 
signal.) 
 
[FWD] is selected in the example at left. 

 

 
Click [Save] to save the settings 
to a file. 
 

 

 
 If you close the [I/O monitor display item select] window without saving the settings, 

your changes will not be reflected to the [I/O Monitor] window. 
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2.3.2.2. System Monitor 

(for monitoring the internal setup information and maintenance 

status of the inverter) 

The system monitor allows you to check the inverter's ROM version, model, internal setup 

information, and maintenance information. 

 
 

[Save CSV file] 

Click this button to save the system monitor data to a CSV file. 

 

[Target inverter]  

([Target keypad]) 

Select the inverter you want to monitor. 
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2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information) 

Shows the inverter's alarm status. The alarm monitor allows you to check the content of the 

current alarm and the various operation information recorded when the alarm occurred. 

 
[Alarm Reset] 

Click this button to reset 

(clear) the current alarm. 

[Initialize the alarm history] 

Click this button to initialize the 

connected inverter's alarm history. 

[Data when alarm occurred] 

This list displays the operation information 

recorded at the time of the occurrence of the 

alarm you selected from the list box. 

 

 
 

[Save CSV file] 

Click this button to save the data when alarm occurred to a CSV file. 

[Target inverter]  

([Target keypad]) 

Select the inverter you want to monitor. 

 

 

 Carefully note that resetting the alarm with the operation command on causes the inverter 

to start unexpectedly as soon as the alarm is cleared. 

 Failure to observe this could result in an accident. 

 

 
 The [Initialize the alarm history] button may not work on an inverter that has 

password protection enabled. If this is the case, you should disable password 

protection so that you can use [Initialize the alarm history]. For more information on 

password protection, refer to the instruction manual or user's manual of your 

inverter. 
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Hexadecimal value 

If an item name in the [Item] column is followed by "(Hex)", the [Value] column shows a 

hexadecimal value and the [Unit] column shows the function code information. The function 

code information shows the most recent alarm, the second most recent alarm, the third most 

recent alarm, and the fourth most recent alarm, respectively, from left to right. 

 

Detailed information will be displayed by clicking  symbol on the "Unit" column if it is 

available. 

For example, when the loader is connected to VF1A and the operation status value for the most 

recent alarm is '0021' (as shown below):  

 

Detailed information 
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2.3.2.4. Operation Status Monitor (for monitoring the inverter operation 

status) 

Allows you to check information such as the present output frequency and output voltage. 

 
 

[Save CSV file] 

Click this button to save the 

operation information to a CSV 

file. 

[Advanced] 

Click this button to show/hide signals 

and change the display order. 

For more information, refer to 

"2.3.2.1How to show/hide signals and 

change the display order". 

[Target inverter]  

([Target keypad]) 

Select the inverter you want to 

monitor. 

 

Special value 

If the torque limit value is '32767', it means "no operation". 

 

Hexadecimal value 

If an item name in the [Item] column is followed by "(Hex)", the [Value] column shows a 

hexadecimal value. The function code is shown in the pair of parentheses immediately preceding 

"(Hex)". 

  



 

Chapter 2 Functional Description 

 2-45 

Detailed information will be displayed by clicking  symbol on the "Item" column if it is 

available. 

For example, when the loader is connected to VF1A and the operation status value is '0028' (as 

shown below): 

 

Detailed information 
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2.3.3. Customizable Logic 

The customizable logic function allows you to create logic circuits using a graphical editor tool 

and transfer them to the inverter. 

Also, you can debug your circuits on screen. 

Select [Menu] > [Customizable Logic] from the main menu or click  on the main window 

toolbar and click [Customizable Logic] to open the [Select customizable logic project to edit] 

window. 

 

The [Select customizable logic project to edit] window allows you to select the customizable 

logic you want to view/edit. 

  



 

Chapter 2 Functional Description 

 2-47 

2.3.3.1. Select Customizable Logic Project to Edit 

When you start the editor, the [Select customizable logic project to edit] window (shown 

below) appears first. 

 

 

- [Create new project] 

Click this button to create a new customizable logic project.   

The model and version numbers affect how many steps you can use, what types of 

circuits you can create, etc. So, correctly set the model and version numbers according to 

the target inverter. 

 

Model 

Select the model number of the target 

inverter. 

Number of steps 

Shows the maximum number of steps. 

 

Version 

Select the ROM version of the target inverter. 

For VF1A ROM version 5600 or later, interpret the ROM version in accordance with the instructions in "3.2.5 

Replacement of Inverter ROM Versions"  

If the list of choices does not contain the same version as the inverter ROM version, select the version earlier than 

and the closest to the inverter ROM version.  

If the inverter ROM version is later than all the versions in the list of choices, the inverter may have been upgraded 

after the release date of your loader. Access the technical support page on IDEC website and check for the latest 

loader version upgrade file. If one exists, download and use it. 

 

 
 You can identify the inverter model number you should select in the [Model] list 

box from the inverter model number printed on the rating nameplate of the inverter. 

Refer to "2.2.1. [1] Model, Regional Specification, Voltage, Capacity" for details. 

 You can identify the inverter ROM version from the inverter keypad.  

For more information, refer to the instruction manual of your inverter.  

When The Loader is connected to an inverter, you can identify the inverter ROM 

version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation 

Monitor Setting] window, which you can access by selecting [Operation Monitor 

Setting] from the Quick Access menu. 
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 If the inverter ROM version is unknown when creating a new definition file, you 

can change the version number later. For more information, refer to "2.3.3.12. 

Project Properties". 

However, changing the version number changes how many steps you can use 

and what types of circuits you can create. As the result, an error may occur during 

step number assignment. You are recommended to select a version number that 

is as appropriate as possible when creating a new circuit. 

 

 

- [Read from the file] 

Click this button to load a customizable logic project file saved in your PC and open a window 

for editing the file data. 

 

 

 

 

 

 

 

 

 

Filter 

Select the type of files displayed 

in the list. 

 

[Open] 

Opens the selected file. 

 

File types 

 VFD Doesa-Loader 

Customizable logic data *.CML 
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2.3.3.2. Editor Screen 

Project management window 

Allows you to manage the project files and function block 

properties. 

 

Toolbox 

Allows you to access the symbols provided by the 

customizable logic function. 

 

Icons for customizable logic 

 

[Select inverter] 

([Select keypad]) 

Select the device you 

want to connect to. 

 

[Update] 

Click this button to update 

the number of steps. 

[Grid] 

Click this button to 

change the grid size. 

Zoon in/Zoom out 

Allows you to zoom in or 

out to the layout area. 

 

[Clear log] 

Click this button to 

clear the messages in 

the output window. 

[Execution cycle] 

Shows the approximate time 

between two executions of a step.  

The execution cycle is determined 

by the model and the maximum 

number of steps.  

You cannot set the execution 

cycle as you want. 

Output window 

Displays information 

such as the results of 

auto assignment of 

function codes. 

Layout area 

Allows you to place symbols 

to draw a customizable logic 

function circuit. 

 

Icons for customizable logic 

(1)    (2)   (3)   (4)     (5)   (6)     (7)     (8)    (9)   (10)  (11)    (12)  (13) 

 

 

No. Icon name Function 
Related 

section 

(1) Toolbox Show or hide the toolbox. 2.6.4 

(2) Project management window Show or hide the project management window. 2.6.4 

(3) Output window Show or hide the output window. 2.6.4 

(4) Search symbol 
Search symbols placed on the editor screen based 

on the specified keyword. 
2.3.3.5 
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No. Icon name Function 
Related 

section 

(5) Auto step number assignment 
Perform auto step number assignment and circuit 

check. 
2.3.3.7 

(6) 
Step number assignment 

screen 
Display the screen for managing step numbers. 2.3.3.7 

(7) 

Settings for the user setting 

area and the customizable logic 

memory area 

Display the list screen of function codes U121- and 

U171-, the list screen of the input/output terminal 

properties, and the list screen of the function code 

settings for each step. 

2.3.3.6 

(8) 
Write to inverter 

(Write to keypad) 
Write the edited circuit to the inverter or keypad. 2.3.3.9 

(9) Comparison 
Compare the edited circuit with a circuit in the 

inverter, keypad, or saved file. 
2.3.3.10 

(10) Monitor 
Monitor the operation status of the circuit written to 

the inverter. 
2.3.3.11 

(11) Save trace monitor information 

Create and save the signal information for using the 

realtime trace function to monitor the operation 

status of the circuit written to the inverter. 

2.3.4.10 

(12) Start/stop customizable logic Start/stop the circuit written to the inverter. - 

(13) Online batch processing 

Simplify the series of operations from [Step number 

assignment] to [Write to the inverter] to [Start 

customizable logic] to [Start monitor]. 

2.3.3.11 

 

Toolbox 

 

  

Symbol selection tab 

You can select the desired logic type group of 

symbols by selecting one of these tabs. 

Symbol selection list box  

You can select the desired symbol type by 

selecting from this combo box. 

 
Common symbols 

Input/output 

These symbols represent an input/output 

terminal. 

Branch 

These symbols represent a circuit branch. 

Comment 

Use this symbol to add a comment. 

Logic symbols 

This area displays function symbols of the type 

determined by your selected tab and list box 

choice. 
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2.3.3.3. Workflow of Creating a Circuit 

The following is the basic workflow of creating a customizable logic circuit. The steps for creating 

a circuit are described in the remainder of this section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

START 

END 

Design a customizable logic 

function circuit 

Create the customizable 

logic function circuit 

Step number assignment 

Write to the inverter or 

keypad 

Debug 

Online monitor 

Realtime Trace 

Draw a logic 

function circuit 

using the graphical 

editor tool 

(Refer to Section 2.3.3.3) 

(Refer to Section 2.3.3.9) 

(Refer to Section 2.3.3.11) 

(Refer to Section 2.3.3.7) 



 

 

 2-52 

[1] Placing Customizable Logic Function Symbols 

Select the desired symbols from the toolbox and drag & drop them in the layout area. 

 

The execution order of customizable logic functions is determined by the order you placed them 

in the layout area. 

Refer to "2.3.3.7. Step Number Assignment" for details.  

 

[2] Configuring Customizable Logic Function Symbols 

To configure the signal selection, timer value, and other parameters of each symbol, use the 

dialog you can open by selecting and double-clicking a symbol. 

Alternatively, you can open this dialog by selecting and right-clicking a symbol and selecting 

[Property] on the context menu. 

 

 

The properties of the respective symbols are as follows. 
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- Properties of an Input Terminal 

 

Function code 

The function code is displayed once 

the auto step number assignment 

completes successfully. 

Signal name 

Displays the code and name of the configured signal. 

 

 button 

Click this button to open the list of available signals. 

 

Signal code setting field and [SET] button 

You can specify a signal by entering its code.  

For information on what code you can enter, 

refer to the setting range for function code 

U02 and U03. 

 

For details on signals, refer to "2.3.3.16. List 

of Input Terminal Signal Codes". 

[Set Customize Logic Signal] 

This check box is enabled if you select a terminal input signal (number 40XX or 50XX).  

Checking this check box allows you to write the "disable function" settings to the function codes for which you 

configure the terminal function when writing to the inverter. 

For example, when you are configuring an X1 terminal, you may want to write "100[NONE]" to the X1 terminal 

function E01. 

 

 
 Once you have written the input terminal properties with the [Set Customize Logic 

Signal] check box checked, you cannot restore the original terminal function by 

re-writing the properties with the check box cleared. To restore the original 

terminal function, use some other method such as editing the function code list in 

the loader or using the keypad connected to the inverter. 

 

 
 With the [Set Customize Logic Signal] check box checked, you cannot write the 

properties to an analog input terminal (such as terminal 12). To disable the 

analog input terminal function, set the related function codes (such as F01 and 

E61) by some other method such as editing the function code list in the loader or 

using the keypad connected to the inverter. 
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- Properties of an Output Terminal 

 

In the [Output selection] area on the properties screen, configure the 

customizable logic output signals 1 "CLO1" to 10 "CLO10" connected to the 

internal step outputs. 

In the [Function selection] area on the properties screen, configure the inverter signals 

connected to the customizable logic output signals 1 "CLO1" to 10 "CLO10". 

Hereinafter, a customizable logic output signal is referred to as a "CLO". 

Output selection   

CLO assignment 

Displays the assigned CLO.  

When you place an output terminal symbol, an 

unused CLO is automatically assigned. 

To change the assignment, use the  button. 

  button 

Select the desired CLO from the list. 

You cannot select a CLO already 

used by another output terminal. 

To use a CLO already used by 

another output terminal, temporarily 

clear the selection of that CLO for that 

output terminal. 

Once you configure a CLO, [Fixed] is 

automatically checked. 

 

Internal step output 

Once the auto step number assignment 

completes successfully, this field is 

automatically populated with the step number. 

Function code 

Once you configure a CLO, this field is 

automatically populated with the function code 

corresponding to that CLO. 

 Fixed 

You can select whether to allow or 

disallow the auto CLO assignment by 

the auto step number assignment. 

 : Allow the auto assignment  

 : Disallow the auto assignment 

 

 Function selection 

 Function code 

Once you configure a 

CLO, this field is 

automatically populated 

with the corresponding 

function code. 

Signal name 

Displays the code 

and name of the 

inverter signal 

connected to the 

CLO. 

 button 

Select the 

desired signal 

from the list. 

Signal code setting field and 

[SET] button 

You can specify a signal by 

entering its code.  

For information on what code you 

can enter, refer to the setting 

range for function code U81. 

 Digital output 

Refer to the next page. 

Analog output 

Refer to the next page. 
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 Digital output 

Select the digital output terminal (Y terminal) you want to connect to the CLO.  

Checking this check box allows you to write the [CLO assignment] setting to the function code for which you 

configure the terminal function when writing to the inverter. 

For example, if you select CLO1 for the [CLO assignment] setting 

(see the previous page) in the [Output selection] area and select 

"E20:[Y1]" under [Digital output], you can write "111 [CLO1]" to E20  

 Analog output 

Configure the analog output terminal connected to the CLO.  

Checking this check box allows you to write the [CLO assignment] setting to the function code for which you 

configure the terminal function when writing to the inverter. 

For example, if you select CLO1 for the [CLO assignment] setting 

(see the previous page) in the [Output selection] area and select 

"F31:[FM]" under [Analog output], you can write "111 [CLO1]" to F31.  

 

 
 Once you have written the properties with the [Digital output] or [Analog output] 

check box checked, you cannot restore the original terminal function by re-writing 

the properties with the check box cleared. To restore the original terminal 

function, use some other method such as editing the function code list in the 

loader or using the keypad connected to the inverter. 
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- Properties of a Link Terminal (output) 

 

 

Terminal number 

Specify the number to identify the symbol. 

The number must be unique to this 

particular terminal. 

Specifying a number already used by 

another terminal would cause an error 

during the auto step number assignment. 

Comment 

You can add a comment. 

Your entered comment will be displayed 

next to the symbol. 

 

- Properties of a Link Terminal (input) 

 

 

Terminal number 

Specify the terminal number of the 

connection source link terminal (output). 

Output terminal selection 

From the list, select the terminal number of 

the connection source link terminal 

(output). 

The list displays the terminal numbers of 

link terminals (output) existing in the layout 

area along with comments. 
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- Properties of a Function Block 

 etc. 

Step 

Step No. 

Once the auto step number assignment 

completes successfully, this field is 

automatically populated with the step number. 

The customizable logic steps will be executed 

in the ascending order of step numbers. 

Output 

Once the auto step number assignment completes 

successfully, this field is automatically populated with the 

internal step outputs, such as "SO01". 

 

 

 

Logic function 

Function code 

Once the auto step number assignment 

completes successfully, this field is 

automatically populated with the function 

code. 

Function name 

This field is populated with the block 

selection code and the function block name.  

For details on function blocks, refer to 

"2.3.3.18. List of Logic Symbols". 

Parameter 1, Parameter 2 

Each logic symbol represents a different 

function. 

For example, the "AND + ON" delay logic 

lets you specify the ON-delay time for 

[Parameter 1]. 

For a Function Code logic, specify the 

function code type and the function code 

number. 

Link to the following parameter: 

Set a link that the setting value of 

parameter 1 or 2 refers to the user 

setting/memory area (example: U121). 

Setting a link requires 1 step for each. 

Description 

Describes the functions of the logic symbol. 

Logical selection 

Input 1, Input 2 

These buttons are enabled for a logic symbol with digital input. Use them to specify the input terminal logic.  

For example, this feature is useful when you want to input the logical inversion of an internal step output. 

The following is an example of using a negative logic for input 1 in step 2. 

 

The contact symbols of and  

represent a positive logic and a negative logic, 

respectively. 
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- Properties of a Comment 

 

 

 

 

Comment 

You can add a comment. 

 

 

 

 

 

 

 

[Font] 

To display the [Font] window, right-click 

the comment symbol and select [Font] on 

the context menu. 

 

The [Font] window allows you to change 

the font size for comments. 

Your changes to the font size are applied 

to all comments. 

You can change the font size within the 

range of 8 to 99.  

If you specify a value smaller than 8, the 

font size is set to 8; if you specify a value 

greater than 99, it is set to 99. 
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[3] Connecting Logics 

To connect logics, select and right-click the symbol and select [Connect line] on the context menu. 

 

 

The connection line appears. Hover the mouse pointer on the red square at one end of the 

connection line and move it to the symbol you want to connect while holding down the left 

mouse button. 

 

 
Once the connection line is connected to the symbol, the square at one end of the connection 

line changes from red to black. 

 
When you release the left mouse button, the square at one end of the connection line changes 

from a black square to a gray circle, indicating that the connection line is complete. 
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[4] Creating a Function Block (FB) 

To create a function block (FB), select and right-click [FB (Common)] from the tree and select 

[New...] on the context menu. 

The [New function block] dialog appears. Enter necessary information and click [OK]. 

 

 

Name 

You can enter a name of your choice. 

Number of inputs 

Specify the number of inputs for the FB. 

Specify the exact number of signals you want 

to use. You can also create a FB without input 

by specifying '0'. 

Number of outputs 

Specify the number of outputs for the FB. 

Specify the exact number of signals you want 

to use. You can also create a FB without output 

by specifying '0'. 

Description 

You can enter any description you want. 

 

 
 You can change these parameters even after you create the FB. To change them, 

right-click the FB symbol or name under [FB (Common)] in the project management 

window and select [Properties] on the context menu. 

 

 
 Be sure to specify the exact number of inputs/outputs you want to use.  

The following example shows a FB symbol with the number of inputs set to 5 and 

the number of outputs set to 2 placed in the layout area. 

 

If the circuit that contains this FB symbol use four 

inputs and one output only, and you perform the 

auto step number assignment, an error message 

will appear indicating that the setting of the number 

of input terminals differs from that in the actual logic 

or that the setting of the number of output terminals 

differs from that in the actual logic. 

 

 
 The input/output terminals for an FB are numbered 1, 2, ... from top to down.  

In the above example, the terminals on the left side are numbered [Input1], 

[Input2], ...[Input5] from top to down, and the terminals on the right side are 

numbered [Output1] and [Output2] from top to down. 
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Select [FB001] (or a FB with your specified name) that appears in the tree and double-click it to 

display the [FB001*FB (Common) edit*]. 

 

 

 

 

To edit the internal customizable logic functions of a new function block, do the following steps: 

 (1) Place input/output symbols in the layout area. 

 (2) Assign the required functions to the input/output symbols. 

 (3) Select the logic symbol from the toolbox, configure the logic, and connect the input/output 

symbols. 

An example is shown below. 

To edit the input for the FB, select [Function block input] -> [Input1]. 
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To edit the output for the FB, select [Function block output] -> [Output1].  

 

 

 
 You can select [Function block input] and [Function block output] on the FB edit tab 

only. 

 

When you are finished editing the FB, select and right-click [FB (Common)] from the tree and 

select [Save] on the context menu.  
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Once you save an [FB (Common)], the FB symbol appears on the [FB] tab of the toolbox. 

 

 

  Once you save an FB (Common), you can use the same FB in another project. 

 

Return to the [Program00] sheet, select the FB symbol from the toolbox and drag & drop in the 

layout area. 
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Once you place "FB001_1" in the layout area, "FB001_1" is added to the project management 

window. Select and double-click "FB001_1" to open the edit tab for "FB001_1". 

 

 

 
 "FB001_1" is an FB that belongs to the project and therefore is handled 

separately from FB (Common) "FB001". Changes made to either of the two FBs 

will not be automatically reflected to the other. 

 

 
 You can check the circuit you edited with the auto step number assignment.  

For more information on the auto step number assignment, refer to "2.3.3.7. Step 

Number Assignment". 

 

 
 The function blocks (FBs) under [FB (Common)] are not checked by the auto step 

number assignment. To check the function blocks (FBs) under [FB (Common)], 

you should add them to the project. 
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2.3.3.4. Precautions to Take when Creating a Circuit 

[1] Timer Time 

A circuit that uses a timer does not operate exactly according to the timer time setting if: 

The timer time setting is smaller than the execution cycle 

The timer time will become equal to the execution cycle if the timer time setting is smaller than 

the execution cycle. 

Example: If the execution cycle is 20 ms, the timer time setting of 0.01 s is changed to 0.02 s 

when the circuit operates. 

 

The timer time setting is not equal to a multiple of the execution cycle 

The timer time will be rounded up to the next multiple of the execution cycle if the timer time 

setting is not equal to a multiple of the execution cycle. 

Example: If the execution cycle is 20 ms, the timer time settings of 0.03 s and 0.05 s are 

changed to 0.04 s and 0.06 s when the circuit operates. 

 

[2] "CLC" and "CLTC" Functions of General-purpose Input Terminals 

The "CLC" and "CLTC" of a general-purpose input signal are signals for customizable logic. 

"CLC" : Allows you to stop the customizable logic circuit operation. 

"CLTC" : Allows you to clear all the customizable logic timers. 

However, you cannot set "CLC" or "CLTC" (E01=80, 81) in the [Function selection] area on the 

editor screen.  

To configure these functions, use some other method such as editing the function code list in 

the loader or using the keypad connected to the inverter. 

 

[3] Circuit Read From the Inverter 

The editor screen cannot display a circuit read from the inverter. 

However, you can load a circuit as a function code by selecting [Function code edit...] -> [Read 

from the inverter] from the Quick Access menu (or, for some models, checking the [Open the 

customizable logic setting screen] check box). 

 

[4] Function Block 3001: conversion 1, 3002: conversion 2 

To write a circuit to the keypad and then write it to the inverter using the keypad's copy function, 

use [Manually set the conversion coefficient]. 

The [Auto calculate the conversion coefficient] setting is ignored by the keypad's copy function. 

Even if you set it, you cannot write the circuit to the inverter. 

When you write the circuit directly from the loader to the inverter, you can use either [Manually 

set the conversion coefficient] or [Auto calculate the conversion coefficient]. 
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2.3.3.5. Useful Features 

[1] Undo/redo 

You can select the undo or redo command from the right-click menu of the layout area. 

 
Undo 

You can undo up to 3 previous layout changes such as 

moving and deleting a symbol or connection line.  

You can also use [Ctrl] + [Z].  

You cannot undo changes to the properties. 

Redo 

You can redo the last action. You can also use [Ctrl] + [Y]. 

 

 

[2] Copy/paste 

 

You can select the copy command from the 

right-click menu of a symbol. You can also 

use [Ctrl] + [C]. 

You can select the paste command from the 

right-click menu of the layout area (rather 

than a symbol). You can also use [Ctrl] + [V]. 
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[3] Range Selection 

You can select a range by dragging the mouse pointer in the layout area while holding down the 

left or right mouse button. 

 

Once you release the mouse button, the symbol(s) in the range is selected. 

 

 

  You can select all the symbols by pressing [Ctrl] + [A]. 
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[4] Symbol Search 

The [Symbol search] feature allows you to search for a symbol in the layout area. 

Click the [Symbol search] icon on the toolbar. 

 

 

The [Search] dialog appears. 

 

Condition 

Combo box 

Enter the search keyword. 

Check boxes 

Use these check boxes to specify the search 

conditions.  

If you check two or more check boxes, they will 

be ORed. 

Once you select at least one check box, the 

[Next], [Prev], and [Search] buttons are enabled. 

 

Search results 

The search results are displayed. 

When you double-click one of the search results, 

the focus moves to the matching symbol. 

 

The following is an example of searching for symbols that use an X terminal as an input terminal. 

 
 
Double-clicking one of the search results moves the 
focus to the matching symbol. 
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2.3.3.6. Settings for the User Setting Area and the Memory Area 

You can use function codes U121- and U171- as you want. 

You can use these function codes as analog inputs by reading them with the function code read 

logic. 

For example, when you want to double the input of terminal 12, you can use function code U121 

by setting it to the constant of 2.00 as shown below. 

 

 

To use function codes U121- and U171-, click the [User parameter/Customizable logic storage 

area setting] icon on the toolbar. 

 

 

 

The [User parameter/storage area, input/output and logic] window appears. 

Logic version 

Clicking the [Read from the inverter] button on the [User parameter/storage] tab displays the settings of function codes 

U197 and U199 read from the inverter. 

 

 

Logic check 

You can view the list of the settings 

for each step. 

User setting area  

- Customizable logic storage area 

You can edit function codes U121- and U171-. 

Input/output check 

You can view the list of the settings of input and output terminals. 

 

  

Read '2' from U121 
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Open the [User parameter/storage] tab. 

Inverter settings before initialization 

You can configure the settings of function codes U121- and U171-. 

If you open this window by clicking [User parameter/Customizable logic storage area setting] on the toolbar, '0.00' 

appears. 

If you click [Write] or [Write to the inverter] and have this window automatically displayed upon completion of write, the 

settings read from the inverter before write appear. 

 

 

Write to the inverter 

(Write to the keypad) 

Write the settings of function codes 

U121- and U171- to the inverter or 

keypad. 

Save param file 

Click this button to save 
the settings to a CSV file. 

Load param file 

Click this button to load a 
saved setting file. 

Read from the inverter (Read from the keypad) 

Click this button to read the settings from the inverter or 
keypad. 

 

Configure necessary settings in the [Inverter setting value (before initialization)] column. 

When you finish configuring the settings, save the parameters by clicking [Save param file]. 

 

 
 Once you close the [User parameter/storage area, input/output and logic] window 

without saving the settings, they are lost and will not be restored the next time 

you open the window. Whenever you want to save the settings, be sure to click 

[Save param file]. 

 

Before writing to the inverter, check that the inverter can operate safely if function codes U121- 

and U171- are written to it. 

 

 
 You can write function codes U121- and U171- while the inverter is operating and 

while the customizable logic function is starting but the inverter may exhibit 

unexpected behavior, which can be very dangerous. 

If you cannot ensure the safety, stop the inverter and the customizable logic 

function before the write. 

 

 
 The [User parameter/storage] tab is not available with inverters that do not have 

function codes U121- and U171-. 
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2.3.3.7. Step Number Assignment 

Once you created a customizable logic function circuit, you have to assign step numbers to the 

respective symbols and FBs. There are three methods of assignment. 

 
 The customizable logic functions are executed in the ascending order of step 

numbers. 

 

Assignment method 1: Auto step number assignment (function check)  

Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number 

assignment and circuit check. 

 

 

If no error is detected as the result of the circuit check, step numbers are assigned. 

 

Step numbers are assigned even if a warning occurs. 
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If any error is detected as the result of the circuit check, step numbers are not assigned.  

 

If this is the case, you can double-click the warning or error message displayed in the output 

window to jump to the symbol in which the error occurred.  
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- Rules of auto step number assignment 

The rules of the auto step number assignment to customizable logic function symbols are 

as follows: 

(1) The step numbers are assigned in the ascending order from top to down in the layout area.  

(2) If two or more symbols are at the same height in the layout area, they are assigned step 

numbers in the ascending order from left to right. 

 

An example is shown below. 

 
 

In the above example, the XOR circuit is assigned Step 4, and the OR circuit Step 2.  

As the result, the output of Step 4 is connected to the input of Step 2 

In this case, the output of Step 4 is input to Step 2 in the next execution cycle. 

Execution cycle Execution order 

Current cycle (1) -> (2) -> (3) -> (4) -> (5) -> (6) -> (7) 

 Output of Step 4 

Next cycle (1) -> (2) -> (3) -> (4) -> (5) -> (6) -> (7) 

 

To input the output of the XOR circuit to the OR circuit in the same execution cycle as the 

OR circuit, adjust the positions of the symbols. 

  

Smaller step numbers 

Larger step numbers 

Larger step numbers 

(1) (2) (3) 

(4) 

(5) (6) 

(7) 

(4) 

(2) (1) (3) 

(5) (6) 

(7) 

XOR 

OR 
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The following example shows the result of moving down (2), (3), (6), and (7) shown on the 

previous page and then performing the auto step number assignment again. 

 

Now the XOR circuit and the OR circuit are assigned Step 2 and Step 3, respectively.  

This means that the output of the XOR circuit is input to the OR circuit in the same 

execution cycle as the OR circuit. 

  

XOR 
OR 
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Assignment method 2: Manual step number assignment 

You can opt to manually assign step numbers. 

To do so, select and right-click a customizable logic function symbol and select [Step 

No./Priority setting] on the context menu.  

 

 

Specify your desired step number. 

 

 

Click the [Step No. automatic allotment] icon on the toolbar to check the edited circuits. 

 

 

 
 You have to perform the auto step number assignment even if you have manually 

assigned a step number. 

Without performing the auto step number assignment, you cannot write to the 

inverter. 
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 If the inverter is one in which the execution cycle depends on the maximum step 

number and you specify a larger step number, the execution cycle will follow the 

specified step number even if you use one step only. 

 

 

Assignment method 3: Step number priority setting 

You can specify the priorities applied when automatically assigning step numbers. 

To do so, select and right-click a customizable logic function symbol and select [Step 

No./Priority setting] on the context menu.  

 

 

Specify your desired priority by entering a number equal to or greater than 1. The smaller the 

number, the higher the priority and the smaller the step number assigned.  
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Click the [Step No. automatic allotment] icon on the toolbar to perform auto step number 

assignment.  

 

 

 

 

The above three step number assignment methods are prioritized as follows: 

Auto assignment < priority setting < manual step number assignment 

 

 

To check the step number assignment 

The step number assignment screen allows you to view and change the assignment status. 
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2.3.3.8. Circuit Check 

You can view the lists of the input/output terminal properties and the settings for each step. 

Click the [User parameter/Customizable logic storage area setting] icon on the toolbar. 

 

 

 

The [User parameter/storage area, input/output and logic] window appears. 

 

 
 A limited set of functions is available with some inverter models. Refer to 

"1.1.2Loader Functions by VF1A Series Inverter Model" for details. 

 

[1] Input/output Check 

To view the list of the input/output terminal properties, open the [Input/Output] tab. 

 

 Input terminal 

Allocation number 

Shows the signal code of the input terminal. 

Exclusive 

Displays [Yes] if the [Set Customize Logic Signal] 

check box is checked on the input terminal properties 

window. 

Terminal 

Displays the function code assigned to the terminal 

function if [Exclusive] is [Yes]. You can write the 

"disable function" setting to this function code when 

writing to the inverter. 

Description 

Displays the assigned number and signal name.  

This signal name is the same as shown on the input 

terminal properties screen. 

Output terminal 

Name 

Displays customizable logic output signals 1 "CLO1" to 

10 "CLO10". 

Allocation number 

Displays the inverter signal codes connected to 

customizable logic output signals 1 "CLO1" to 10 

"CLO10". 

Exclusive 

Displays [Yes] if the [Output terminal digital] or [Output 

terminal analog] check box is checked on the output 

terminal properties window. 

Terminal 

Displays the function code assigned to the terminal 

function if [Exclusive] is [Yes]. You can write customizable 

logic output signals 1 "CLO1" to 10 "CLO10" to this 

function code when writing to the inverter. 

Description 

Displays the assigned number and signal name. This 

signal name is the same as shown on the output terminal 

properties screen. 

 

[Save CSV file] 

Click this button to save the displayed information to 

a CSV file. 
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[2] Logic Check 

To view the list of the settings for each step, open the [Logic] tab. 

  

 Step No. 

Displays the step number. 

In1, In2 

Displays the signal code of the input terminal 

connected to the logic symbol. 

For information on what code you can enter, 

refer to the setting range for function code U02 

and U03. 

 

Func Name 

Displays the function block name. 

Func 

Displays the block selection code.  

For information on this code, refer to the setting 

range for function code U01 or "2.3.3.18. List of 

Logic Symbols". 

Prm1, Prm2 

Displays the [Parameter 1] and [Parameter 2] settings 

on the logic symbol properties window (or the function 

code type and the function code number). 

 

Convert to [Func Code Edit] 

Converts and displays the listed contents in the 

"Function Code Edit" window. 

[Save CSV file] 

Click this button to save the displayed information to 

a CSV file. 
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2.3.3.9. Write 

Your edited circuits are assigned step numbers and converted to the inverter function code 

settings when the function check completes successfully.  

Once the conversion completes successfully, the [Write] button is enabled. 

 

[1] To Write to the Inverter 

To register these settings in the inverter, check that the inverter is stopped and then click the 

[Write] button or the [Write to the inverter] icon on the toolbar. 

 

 

Click [OK] to start the write operation. 

 

 

 
 The write operation fails while the inverter is running. Stop the inverter and then 

perform the write operation. 

 If you stop the customizable logic function while the inverter is running, an "ECL: 

Customizable logic error" alarm occurs. 

 The write operation may fail with an inverter that has password protection 

enabled. If this is the case, you should disable password protection to perform the 

write operation. For more information on password protection, refer to the 

instruction manual or user's manual of your inverter. 
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Upon completion of write, you are presented with a dialog that prompts you to confirm the write 

operation to the user setting and customizable logic memory area (function codes U121- and 

U171-). 

 

 

At this time, the settings of function codes U121- and U171- in the inverter have been initialized 

to 0. 

Click [OK] if you want to restore the setting of function codes U121- and U171- in the inverter. 

Click [Cancel] if you do not use function codes U121- and U171- or you accept the settings of 0. 

When you want to write new settings to function codes U121- and U171-, click [Cancel] and, 

upon completion of write, perform the write operation from the [User parameter/storage area, 

input/output and logic] window. 
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[2] To write to the Keypad 

If you have selected [Data in Keypad (in VF1A-PH1)] for [USB Connection] on the 

[Communication Setting] window, you can write your edited circuits to the VF1A-PH1 remote 

keypad with USB. In this case, the write operation to the inverter uses the keypad's copy 

function. 

  

 

Figure 2-1  Workflow of writing circuits to a keypad 

Preparation 

The write operation through the keypad's copy function writes, not only the customizable logic 

related function code data, but also all other function code data (such as F codes, E codes, and 

C codes) to the inverter. Therefore, you should write the function code data other than related to 

the customizable logic to the keypad in advance. 

To write the function code data to the keypad, use one of the following two methods: 

(1) Read the function code setting data from the target inverter to the keypad using the copy 

function. (As needed, read the data from the keypad to the loader and write the data back to 

the keypad after editing the data in the loader.)  

 

 
 When you read data from the keypad to the loader for backup or similar purposes 

and work with the inverter that has the customizable logic function codes, be sure to 

save both the list of basic function codes (such as F, E, C) and the list of the 

customizable logic function codes. 

  

VFD 

DoesaLoader 

Doesa VF1A series 

Inverter 

Remote Keypad 

PC 

  

Write edited 

circuits 

Use the copy 

function 

to perform 

the write 

operation 

Bring the 

keypad to 

the field 

Doesa VF1A series 

Inverter 

Read the data from 

the target inverter 

using the copy 

function. 

 
Doesa Loader 

PC 

Read the function 

code settings 

from the keypad. 

As needed, edit the data in the 

[Function code edit] window 

and write the F, E, and C code 

and other data to the keypad. 

Save the data 

to a file.  
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(2) From the loader to the keypad, 

write the function code setting data 

for the target inverter you have 

created from scratch or loaded 

from a saved file. 

 

 

 
 To the inverter that has the customizable logic function codes, write the list of basic 

function codes (such as F, E, C). In this case, you do not have to write the list of the 

customizable logic function codes. The customizable logic function codes are written 

from the customizable logic editor screen. 

 

The workflow of the preparation is shown below: 

 

  

VFD 

Doesa Loader 

From the [Function code edit] 

window, write the F, E, and C 

code and other data. 

Remote Keypad 

PC 

 

START 

END 

From the target inverter to the keypad 

Read the function code setting data into 

the keypad, using the copy function 

 

From the loader to the keypad 

Write the function code setting data (such 

as F, E, and C codes) to the keypad 

Loader 

Create the function code setting data for 

the target inverter from scratch or load it 

from a saved file 

Loader 

Edit and save the function code setting 

data 

From the keypad to the loader 
Read the function code setting 

data into the loader 
    

  

  

[Data backup or edit is 

required] 

[Prepare the function code data in the loader] 

[Read the function code 

data from the inverter] 

[Data backup or edit 

is not required] 



 

 

 2-84 

Write the edited circuits to the keypad 

Click the [Write] button or the [Write to the keypad] icon on the toolbar 

 

 

 

Read the precautions displayed on the dialog box that appears. 

 

 

Click [Change information] to open the project properties window. 

Correctly configure the model, regional specification, voltage, capacity, and inverter ROM 

version according to the target inverter. For more information, refer to "2.3.3.12. Project 

Properties". 

 

 
 If the model, regional specification, voltage, capacity, and inverter ROM version 

are not correctly configured, the write operation from the keypad to the inverter 

may fail with a [CPEr] warning or error displayed. 

 

Click [Write start] to open the following dialog. 

Click [OK] to start the write operation. 

 

 

Upon completion of write, you are presented with a dialog that prompts you to confirm the write 

operation to the user setting and customizable logic memory area (function codes U121- and 

U171-). 
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At this time, the settings of function codes U121- and U171- in the keypad have been initialized 

to 0. 

Click [OK] if you want to restore the setting of function codes U121- and U171- in the keypad. 

Click [Cancel] if you do not use function codes U121- and U171- or you accept the settings of 0. 

When you want to write new settings to function codes U121- and U171-, click [Cancel] and, 

upon completion of write, perform the write operation from the [User parameter/storage area, 

input/output and logic] window. 
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[3] Workflow of Writing the Circuits 

The workflow of writing the circuits is shown below: 

 
  

 

[Fails] 

Write to inverter START 

END 

Automatically performed 

Cancel the write operation 

User setting area/memory area 

(U121,..., U171,...) 

are read 

Customizable logic area (Uxx) 

is initialized 

Write customizable logics (U,UA,...,UJ) 

Write "disable function" settings to 

input terminal functions (such as E01) 

Write customizable logic output signals 

1 to 10 to the output terminal functions 

(such as F31 and E20) 

User setting area/memory area 

(U121,..., U171,...) 

Are you sure to write to the above? 

Write the values read out in (a) 

(a) 

 
[Completes 

successfully] 

[OK] 

[Cancel] 

* Write operation fails while inverter is running 

Automatically 

performed 

Automatically 

performed 

Automatically 

performed 

Click [Write] or [Write to the inverter] 

Are you sure to write? 

[OK] 

[Cancel] 
Cancel the write operation 

* The customizable logic function stops.  

* The terminal functions are not initialized.  

* If the write target is inverter, H03=12 is written. 

* The "disable function" settings are written to 

input terminal functions if the [Set Customize 

Logic Signal] check box is checked on the 

input terminal properties window. 

* Customize logic output signals 1 to 10 are 

written to output terminal functions if the 

[Output terminal digital] or [Output terminal 

analog] check box is checked on the output 

terminal properties window. 

 

 

 

Click [Write] or [Write to the keypad] 

Preparation: Writing the function codes 

to the keypad 

Check the model, regional 
specification, voltage, capacity, and 

inverter ROM version 

Write to keypad START 
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2.3.3.10. Comparison 

Your edited circuits are assigned step numbers and converted to the inverter function code 

settings when the customizable logic function check completes successfully. 

Once the conversion completes successfully, [Compare] on the toolbar is enabled. 

Click [Compare] to compare the settings of the edited circuits with those in the inverter, keypad, or 

saved file. 

 

 

 

 

 
 

If the target device is a keypad, the label 

changes to [Compared with keypad]. 

 

The comparison results are displayed using the inverter function codes. You can save the 

comparison results to a CSV file. 
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Differences are displayed for symbols as well.  
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2.3.3.11. Debug Function 

Using the online monitor or the trace monitor, you can check how the customizable logics written 

to the inverter operate on the inverter. In addition, the online batch processing is a useful feature 

that reduces the number of button clicks when you edit circuits. 

 

 
 You can use all of the online monitor, the trace monitor, and the online batch 

processing when the loader is connected to the inverter. These features are not 

available if you have selected [Data in Keypad] for [USB Connection] on the 

[Communication Setting] window. 

 A limited set of functions is available with some inverter models. Refer to "1.1.2. 

Loader Functions by VF1A Series Inverter Model" for details. 

 

 

 

[1] Online Monitor 

The online monitor allows you to monitor the timer values or signals for a symbol as numeric 

values. 

Once you convert the customizable logic function settings you created, perform the step number 

assignment, and write the settings to the inverter or you confirm that there are no differences the 

result in the comparison results, you can run the online monitor on your selected symbol. 

Select and right-click the symbol you want to monitor and select [Monitor select] on the context 

menu.  
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The following example shows the result of selecting [Monitor select] for all the symbols in the 

layout area shown on the previous page. 

 

 

Start the inverter customizable logic. 

 

 

 

 

 

Once you start the inverter customizable logic, the online monitor starts. 
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You can check the status of the inputs/outputs, logic symbols, and function blocks (FBs) 

highlighted in red in the layout area. 

 

 

The display examples are shown below. 

- Digital input 

 

The logical values of OFF and ON are 0 and 1, 

respectively. 

The status of "0: Open /1: Closed" is shown under the 

function name. 

- Digital input (logical inversion) 

 

The "~" character prefixed to the function name 

represents logical inversion. 

For logical inversion, the status of "0: Closed /1: Open" is 

shown under the function name. 

- Analog input 

 

A value is shown under the function name. 

For information on the meaning of this value, refer to the 

page regarding "U code (customizable logic)" in the 

User's Manual of your inverter. 

Example: For Out-Freq1, the unit is % and "100%" 

means the maximum output frequency. 
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- Customizable logic function symbol 

 

 

The output data is shown at the upper right. 

Functions (1) and (2) are shown under the symbol. 

 

 

List of function names 

Monitor name Name Range 

T.P Timer period 0.00 to 9990 s 

CNT Count 0.00 to 9990 

U.L Upper Limit -9990 to 0 to 9990 

L.L Lower Limit -9990 to 0 to 9990 

1ST 1st Additional Value -9990 to 0 to 9990 

2ND 2nd Additional Value -9990 to 0 to 9990 

DEV Deviation -9990 to 0 to 9990 

HYST Hysteresis Width -9990 to 0 to 9990 

REF Reference Value -9990 to 0 to 9990 

MAX Maximum Scale -9990 to 0 to 9990 

MIN Minimum Scale -9990 to 0 to 9990 

KA Factor KA -9990.0 to +9990.0 

KB Factor KB -9990.0 to +9990.0 

T.C(T/C) Time constant 0: No filter / 0.01 to 5.00 s 

FIX Fixed as 0  

ACC ACC 0: No limit. 0.01 to 600 s 

DEC DEC 0: No limit. 0.01 to 600 s 

Gain Gain ratio 0 to 200% 

Frq Lower frequency limit 0 to 500 Hz 

Val1 Set Value -9990 to 0 to 9990 

Val2 Set Value2 -9990 to 0 to 9990 

Step Step number 1 to 200 

 

 
 The value of the online monitor is displayed with 3 significant digits. 

Minimum step in each range of value is shown in following table. 

Range of value Minimum step 

±0.00 – 9.99 0.01 

±10.0 – 99.9 0.1 

±100 – 999 1 

±1000 – 9990 10 
 

 

 

[2] Trace Monitor 

The online monitor allows you to monitor the timer values or signals for a symbol as waveforms. 

Refer to "2.3.4.10. Combination with the Customizable Logic Function". 
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[3] Online Batch Processing 

Until your desired circuits complete, you will repeat a series of tasks such as editing circuits, 

performing step number assignment, wiring to the inverter, starting the customizable logic, and 

starting monitors. 

During such time, you can simplify the series of tasks from performing step number assignment 

to starting monitors by using the online batch processing. 

Prior to using the online batch processing, make sure that the inverter is stopped and that 

[Monitor select] has been selected for at least one of the symbols in the layout area. 

To use the online batch processing, click the [Online operation] icon on the toolbar. 

 

 

 

 

The loader compares the circuits you are editing with those in the inverter and, if all the 

comparison results match, automatically starts the monitors. 

If the comparison results do not match each other, the [Comparison result] window appears. 

 

Click the [Write to Inverter and Start] button 

at the lower left of the [Comparison result] 

window to write to the inverter and 

automatically start the monitors. 
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2.3.3.12. Project Properties 

The project properties window allows you to add a version and comment to the created 

project. 

To open this window, right-click the project name displayed at the top of the project 

management window and select [Property...] on the context menu. 

 

 

The [Property] window opens. 

 

 Logic version 

Use these fields if you want to version-control your project. This is different from the 

inverter ROM version. 

When you write the edited circuits to the inverter or keypad, the settings are written to 

function codes U197 and U199. 

 

 

Explanation 

You can add a 

comment. 

Edit 

Click the [Edit] button to open the [Inverter model selection] 

window shown at right. 

This window allows you to change the model, regional 

specification, voltage, capacity, and inverter ROM version. 

Configure these settings correctly according to the target 

inverter. 

Which items you should configure varies depending on how 

you write to the inverter. Refer to the Table on the next 

page. 
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Table 2-2  List of the items you should configure on the [Inverter model selection] window 

Setting item 

When directly writing 

from the loader to the 

inverter 

When writing from the loader 

to the keypad and then 

writing from the keypad to the 

inverter 

Model   

Regional 

specification 
― (*2) 

voltage ―  

Capacity ―  

Version (*1)   

: Configuration required  ―: Configuration not required 

(*1) This is the inverter ROM version. Here, you can change the version you set when 

creating a new project in "2.3.3.1. Select Customizable Logic Project to Edit". 

(*2) You can change the regional specification by selecting [Setup] -> [Region spec.] 

from the main menu. Once you have changed the regional specification, you have 

to quit and restart the loader. Refer to "2.4.4. Region Spec." for details. 

 

 
 You can identify the inverter model number you should select in the [Model] list 

box from the inverter model number printed on the rating nameplate of the inverter. 

Refer to "[1] Model, Regional Specification, Voltage, Capacity" in "2.2.1. Create a 

New File" for details. 

 You can identify the inverter ROM version from the inverter keypad.  

For more information, refer to the instruction manual of your inverter.  

When The Loader is connected to an inverter, you can identify the inverter ROM 

version from [Inverter ROM Version] on the [System Monitor] tab of the [Operation 

Monitor] window, which you can access by selecting [Operation Monitor setting] 

from the Quick Access menu. 
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2.3.3.13. Lock Function 

The lock function allows you to protect your created circuits from view and edit. 

 

 
 The lock function is only available on your PC. If you write circuits with the lock 

function enabled, they can be freely viewed and edited on the inverter. To 

restrict the view and edit of circuits on the inverter, use the inverter's password 

protection. For more information on password protection, refer to the instruction 

manual or user's manual of your inverter. 

 

[1] Locking the Project 

Locking the project protects it from view and edit. (However, this feature does not protect FBs 

under [FB (Common)] from view and edit.)  

To lock the project, 

 

Right-click the project name displayed at 

the top of the project management window 

and select [Lock...] on the context menu. 

 

Enter the password and click [OK]. 

 
 The password you use to lock the project is not within the knowledge of IDEC 

CORPORATION.  

Take sufficient care in configuring and managing the password because there is 

no way to release the password in the event you have lost it. 

 

 

Click [OK] to save the project. 

 

The icon preceding the project name 

changes to a locked one , meaning that 

the circuits in the project are protected 

from view. 
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To release the lock, 

 

Right-click the project name displayed at 

the top of the project management window 

and select [Unlock...] on the context menu. 

 

Enter the password and click [OK]. 

If your entered password is correct, the 

circuits are no longer protected from view. 

 

[2] Locking FBs (Common) 

You can protect an FB under [FB (Common)] from view and edit. (However, this feature does not 

protect the project itself from view and edit.) 

To lock an FB under [FB (Common)], 

 

Right-click an FB name under the [FB 

(Common)] in the project management 

window and select [Lock...] on the context 

menu. 

 

Enter the password and click [OK]. 

 

The FB protected with the password is 

then automatically saved. 
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 The password you use to lock an FB is not within the knowledge of IDEC 

CORPORATION.  

Take sufficient care in configuring and managing the password because there is 

no way to release the password in the event you have lost it. 

 

 

The icon preceding the FB changes to a 

locked one , meaning that the FB is 

protected from view. 

If you place a locked FB from the FB tab of the toolbox to the layout area, a locked mark appears 

on it. 

 

 

 

In addition, an FB with a locked icon is 

added under [FB (Included with project)] in 

the project management window. 

Double-clicking an FB with a locked icon 

does not display the circuits. 

 

To release the lock, 
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Right-click an FB name under the [FB 

(Common)] in the project management 

window and select [Unlock...] on the 

context menu. 

 

Enter the password and click [OK]. 

If your entered password is correct, the 

icon becomes an unlocked one and the 

circuits are no longer protected from view. 

 

[3] Locking an FB under [FB (Included with project)] 

You can protect an FB under [FB (Included with project)] from view and edit. (However, this 

feature does not protect the project itself from view and edit.) 

To lock an FB under [FB (Included with project)], 

 

Right-click an FB name under the [FB 

(Included with project)] in the project 

management window and select [Lock...] 

on the context menu. 

 

Enter the password and click [OK]. 
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 The password you use to lock an FB is not within the knowledge of IDEC 

CORPORATION.  

Take sufficient care in configuring and managing the password because there is 

no way to release the password in the event you have lost it. 

 

 

The icon preceding the FB changes to a 

locked one , meaning that the FB is 

protected from view. 

 

In addition, a locked icon appears on the 

FB when you place it in the layout area. 

 

To release the lock, 

 

Right-click an FB name under the [FB 

(Included with project)] in the project 

management window and select 

[Unlock...] on the context menu. 

 

Enter the password and click [OK]. 

If your entered password is correct, the 

icon becomes an unlocked one and the 

circuits are no longer protected from view. 
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2.3.3.14. Importing/exporting an FB under [FB (Common)] 

The import/export function allows you to use your created FB in the VFD Doesa-Loader software 

installed on another PC. 

 

[1] Exporting an FB 

You can save the desired FB(s) to a file. 

 

Right-click [FB (Common)] in the project 

management window and select [FB Select 

Mode] on the context menu. 

 

Check boxes appear on the left side of the 

icons in the project management window. 

 

From among the FBs under [FB (Common)], 

select the FB(s) you want to save to a file by 

checking their check boxes. 

Right-click the FB name and select [Export] 

on the context menu. 

 

 
 [Export] does not appear on 

the context menu of an FB 
other than under [FB 
(Common)]. 

 You cannot export any FBs 
other than under [FB 
(Common)]. 

 You can also export a locked 
FB. 
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Select [Save to ...] and enter the file name 

under which the data is saved in [File 

Name]. Then click [Save] to save the file. 

 

File types 

- FB export file: "*.exfbl" 

 

Click [OK]. 

 

 

[2] Importing an FB 

You can import FBs saved in a file to the project. 

 

Right-click [FB (Common)] in the project 

management window and select [Import] on 

the context menu. 

 

Select an FB file. 
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Click [OK]. 

 

The imported FB(s) is added under [FB 

(Common)] in the project management 

window. 

 

The imported FB(s) are added to the [FB] 

tab of the toolbox. 
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2.3.3.15. Printing the Customizable Logic 

When the [Customizable logic] window is active, you can print the content of the layout area by 

selecting [File] from the main menu. 

 

 

[Print] 

When the [Customizable logic] window is active, select this 

command to print the content of the layout area. 

For more information on the [Print] dialog, refer to "2.2.6. Print". 

[Print Preview] 

When the [Customizable logic] window is active, select this 

command to view the print preview of the layout area. 

For more information on the [Preview] window, refer to "2.2.7. Print 

Preview". 

[Print selected Symbol] 

This command is available when the [Customizable logic] window is 

active. Select it to print only the symbol selected in the layout area. 

[Print Preview selected Symbol] 

This command is available when the [Customizable logic] window is 

active. Select this command to view the print preview of only the 

symbol selected in the layout area. 

 

The following is an example printout. [Page Setup] is not available. The content of the layout 

area is automatically adjusted to fit in one A4 landscape page. 
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2.3.3.16. List of Input Terminal Signal Codes 

This section describes the signal codes specified in input terminal properties. Reference 

this section when creating circuits. The numbers up to 60XX represent logical value 

(ON/OFF) input signals. Numbers 80XX and greater represent numeric value input signals. 

For information on the input terminal properties, refer to "Properties of an Input Terminal" in 

"2.3.3.3. Workflow of Creating a Circuit". 

 

Restrictions 

The signal codes described below are only available when supported by the inverter. For 

information on the available signal codes, refer to the description of function code U02 and 

U03 in the User's Manual of your inverter. Alternatively, you can refer to the description of 

function code U02 and U03 in [Function code information] on the [Function code edit] 

window (also with selecting the "Create the customizable logic function code window", 

depending on the applied inverter models). 

Numbers from 0000 to 12XX 

Almost the same as general-purpose output signals (i.e., signals selectable for E20).  

(Some signals are excluded from the signals selectable for E20.) 

For information on these signals, refer to the description of function code E20 in the User's 

Manual of your inverter. 

Numbers 4000 to 50XX 

These numbers represent the digital terminal input signals to the inverter. 

Refer to the function codes U02 and U03 in the user's manual for the signals that can 

actually be used for each inverter model. 

An example is shown below. 

Allocation number 

Signal name Details Active 

ON 

Active 

OFF 

4001 - 5001 - X1, X2,... Represent the ON/OFF status of the inverter terminal blocks if 

the remote operation command is disabled. 

Represent the ON/OFF status of each bit of function code 

S06 when the remote operation command is enabled. 

4010 5010 FWD 

4011 5011 REV 

4021 - 5021 - I1, I2, ... Represent the ON/OFF status of input signals for option cards 

with digital terminal input signals.  

4041 - 5041 - CLI1, CLI2, … These are digital input signals dedicated to customizable logic 

that can be reassigned to any X terminal. 

4081 - 5081 - KP-RUN/FWD, 

KP-REV, … 

Represent the ON/OFF status of the keypad button. 

4101 - 5101 - X1-TERM, 

X2-TERM,... 

Represent always the ON/OFF status of the physical inverter 

terminal blocks even if the remote operation command is 

enabled. 
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 When you configure input terminals for these signals, be aware that other functions 

that use the configured signals can operate. For example, if you set the X1 terminal 

function selection (function code E01) to '0' ([SS1] multi-step frequency selection) 

and then turn the X1 terminal from OFF to ON, the multi-step frequency selection is 

enabled from disabled state in parallel with the change of the input terminal logical 

value. Care must be taken especially for the X terminal, the FWD terminal, and the 

REV terminal, whose functions are configured with the factory-set values. 

 

 
 To use a signal exclusively as the customizable logic input, you must check the [Set 

Customize Logic Signal] check box on [Properties of an Input Terminal] or explicitly 

set the signal function selection to "100[NONE]". 

 

Numbers 6000 to 70XX 

These signals cannot be selected for general-purpose output signals (i.e., signals 

selectable for E20). 

Refer to the function codes U02 and U03 in the user's manual for the signals that can 

actually be used for each inverter model. 

An example is shown below. 

Each function is described assuming the active ON logical (positive logic). 

Allocation number 
Signal 

name 
Description Active 

ON 

Active 

OFF 

6000 7000 FL_RUN 
Final operation command RUN. Turns ON when the operation 

command is issued.  

6001 7001 FL_FWD 
Final operation command FWD. Turns ON when the forward 

rotation operation command is issued. 

6002 7002 FL_REV 
Final operation command REV. Turns ON when the reverse 

rotation operation command is issued. 

6003 7003 DACC Turns ON when acceleration starts. 

6004 7004 DDEC Turns ON when deceleration starts. 

6005 7005 REGA Turns ON when regeneration avoidance starts. 

6006 7006 DR_REF Turns ON when the dancer is in the reference position. 

6007 7007 ALM_ACT 
Turns ON when an alarm occurs and the alarm can be reset 

(with no alarm cause identified). 

6100 - TRUE Always ON (TRUE). 

6101 - FALSE Always OFF (FALSE). 
 

Numbers 80XX 

Almost the same as inverter analog general-purpose output signals (i.e., signals selectable 

for F31). These assigned numbers are codes created by adding 8000 to F31 signal codes.  

(Some signals are excluded from the signals selectable for F31.) 

Numeric values are expressed in the unit of %. 

Refer to the function code F31 in the user's manual of each inverter model for the 

assignment number, function, and the definition of 100% of each signal. 
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An example of signal name is shown below. 

Signal name 

Out-Freq1 
Output frequency 1 (before slip compensation),  

or Reference speed (Final) 

Out-Freq2 
Output frequency 2 (after slip compensation),  

or Primary frequency 

Out-I Output current 

Out-V Output voltage 

Torque Output torque 

Load Load factor 

In-Power Consumed power 

PID-PV PID feedback value 

Speed Detected speed value/estimated speed value 

DC-Link-V DC intermediate circuit voltage 

M-out Motor output 

PID-SV PID command 

PID-MV PID output 

Deviation Position deviation during synchronous operation 

H-sink-tmp Cooling fin temperature 

Internal-tmp Internal air temperature 

F-ref Set frequency 

PG-fb PG feedback value 

Torque-I Torque current reference 

PID-ERR PID deviation 

Line-ref Reference line speed 

RollDiameter Roll diameter ratio 

F-ref (Final) Frequency set point (Final) 

PID-PV 1 PID feedback value 1 

PID-SV 1 PID command 1 

PID-PV 2 PID feedback value 2 

PID-SV 2 PID command 1 

EPID1-PV External PID feedback value 1 

EPID1-SV External PID command 1 

EPID1-Out External PID final output 1 

EPID2-PV External PID feedback value 2 

EPID2-SV External PID command 2 

EPID2-Out External PID final output 2 

EPID3-PV External PID feedback value 3 

EPID3-SV External PID command 3 

EPID3-Out External PID final output 3 
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Numbers 90XX 

These numbers represent the analog terminal input signals to the inverter. 

Refer to the function codes U02 and U03 in the user's manual for the signals that can 

actually be used for each inverter model. 

An example is shown below. 

Allocation 

number 
Name Details Numeric value 

9001 AI-[12] Analog terminal 12 input signal 

Scale-transformed physical 

quantity obtained by 

applying gain/bias to the 

input signal 

9002 AI-[C1] 

Analog C1 terminal input signal 

or 

Analog C1 terminal input signal (C1 

function) 

9003 AI-[V2] 

Analog V2 terminal input signal 

or 

Analog C1 terminal input signal (V2 

function) 

9004 AI-[32] 
Analog terminal 32 input signal (input 

signal for option card with analog input) 

9005 AI-[C2] 
Analog terminal C2 input signal (input 

signal for option card with analog input) 

9006 PtCh1 

Temperature detection Pt channel 1 

(Input signal for option card with a 

temperature measuring resistor) 

Filtered temperature 

(From the function code 

setting field, you can select 

one of the following units: 

[K], [ºC], and [ºF].) 9007 PtCh2 

Temperature detection Pt channel 2 

(Input signal for option card with a 

temperature measuring resistor) 

9008 AI-[V3] 
Analog C1 terminal input signal (V3 

function) 

Scale-transformed physical 

quantity obtained by 

applying gain/bias to the 

input signal 

9010 UP/DOWN Set point value by UP / DOWN control 0～100% 

 

To help understand the numeric values for an input terminal for which one of the numbers 

from 9001 to 9005 is selected, the following example shows the results of applying a gain 

and bias to each of the [12] and [C1] terminals: 

Input terminal 
If the gain = 100% and the bias = 0% If the gain = 200% and the bias = 0% 

Input value After application Input value After application 

[12] 
0 to +10 V 0 to 100% 0 to +5V 0 to 100% 

-10 to 0V -100 to 0% -5 to 0V -100 to 0% 

[C1] 
4 to 20 mA 0 to 100% 4 to 12mA 0 to 100% 

0 to 20 mA 0 to 100% 0 to 10mA 0 to 100% 
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The numeric value for an input terminal 

will be the value created by 

transforming the scale after the gain 

and bias application from "0 to 100%" 

to "minimum to maximum". 

Input terminal value

Analog input value

(After bias and gain application)

Maximum scale

Minimum scale
0% 100%

 

 

 
 When you configure input terminals for these signals, be aware that other 

functions that use the configured signals can operate. For example, if you set the 

frequency setting 1 (function code F01) to '1' (terminal 12) and then change the 

input voltage for terminal 12, the step frequency setting changes in parallel with 

the change of the input terminal numeric value. 

 

 
 To use a signal exclusively as the customizable logic input, you must explicitly 

configure the F01, C30, E61, E62, E63, and other related function codes not to 

use the signal configured for the input terminal. 

 By factory default, the F01, C30, and other related function codes are configured 

not to use such a signal. 
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2.3.3.17. List of Output Terminal Signal Codes 

This section describes the signal codes specified in output terminal properties. Reference 

this section when creating circuits. The numbers up to 12XX represent logical (ON/OFF) 

signal value output signals. Numbers 80XX and greater represent numeric value output 

signals. 

For information on the output terminal properties, refer to "Properties of an Output Terminal" 

in "2.3.3.3. Workflow of Creating a Circuit". 

 

Restrictions 

The signal codes described below are only available when supported by the inverter. For 

information on the available signal codes, refer to the description of function code U81 in 

the User's Manual of your inverter. Alternatively, you can refer to the description of function 

code U81 in [Function code information] on the [Function code edit] window (also with 

selecting the "Create the customizable logic function code window", depending on the 

applied inverter models). 

 

Numbers from 0000 to 12XX 

Almost the same as general-purpose input signals (i.e., signals selectable for E01).  

(Some signals are excluded from the signals selectable for E01 and 98[FWD] and 99[REV] 

are added.) 

For information on these signals, refer to the description of function code E01 in the User's 

Manual of your inverter. 

 

Numbers 80XX 

Almost the same as inverter analog general-purpose input signals (signals selectable for 

E61). These assigned numbers are codes created by adding 8000 to E61 signal codes.  

(Some signals are excluded from the signals selectable for E61.) 

Except for some signals, numeric values are expressed in the unit of percentage. 

Refer to the function code E61 in the user's manual of each inverter model for the definition 

of the assignment number, function, and numerical value of each signal. 

An example of signal names is shown below. 

Signal name 

Aux-freq1 Frequency auxiliary setting 1 

Aux-freq2 Frequency auxiliary setting 2 

Aux-freq3 Frequency auxiliary setting 3 

Aux-freq4 Frequency auxiliary setting 4 

N-Ref Unipolar 
Speed command (Not reversible operation 

by polarity) 

N-Ref Bipolar 
Speed command (Reversible operation by 

polarity) 
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Signal name 

PID-SV1 PID command 1 

PID-SV2 PID command 2 

PID-PV1 PID feedback value 

Ratio set Ratio setting 

Trq-lim.A Analog torque limit value A 

Trq-lim.B Analog torque limit value B 

Trq-bias Torque bias 

Trq-cmd Torque command 

Trq-curr Torque current command 

LampRatio Acceleration/deceleration time ratio setting 

Freq-lim.H Upper limit frequency 

Freq-lim.L Lower limit frequency 

Spd-lim.F Forward rotation (FWD) speed limit value 

Spd-lim.R Reverse rotation (REV) speed limit value 

Ai-mon Analog input monitor 

PID-PV2 PID feedback value 2 

Aux-SV1 PID process command auxiliary setting 1 

Aux-SV2 PID process command auxiliary setting 2 

FlowRate Flow sensor 

EPID1-SV External PID process command 1 

EPID1-PV External PID feedback value 1 

EPID1-MU External PID manual command 1 

EPID2-SV External PID process command 2 

EPID2-PV External PID feedback value 2 

EPID2-MU External PID manual command 2 

EPID3-SV External PID process command 3 

EPID3-PV External PID feedback value 3 

EPID3-MU External PID manual command 3 
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2.3.3.18. List of Logic Symbols 

This section describes the respective function blocks. Reference this section when creating 

circuits. 

 

Restrictions 

The function blocks described below are only available and displayed on the toolbox when 

supported by the inverter. Additionally even if the function blocks are displayed on the toolbox, 

some blocks might be not available depending on the version of the inverter. 

For information on the available function blocks, refer to the description of function code U01 in 

the User's Manual of your inverter. Alternatively, you can refer to the description of function code 

U01 in [Function code information] on the [Function code edit] window (also with selecting the 

"Create the customizable logic function code window", depending on the applied inverter 

models). 

 

2.3.3.18.1. [Digital] - Basic Logic 

To select a basic logic symbol, choose [Basic 

logic] from the [Digital] tab. 

 

 

10 to 15: Through 

Block 
selection 

Symbol Function block Description 

10 

Input Output 

  

 

Through output  

Through output without a logical circuit  

Use “2005: Analog through” for the through 

output an analog signal. 

 

11 

Input Output 

  

 

Through output  

+ ON-delay timer 

Turning ON the input starts the ON-delay timer. 
When the timer time has elapsed, the output 
turns ON. Turning OFF the input turns OFF the 
output.  

12 

Input Output 

  

 

Through output  

+ OFF-delay timer 

Turning OFF the input starts the OFF-delay 
timer. When the timer time has elapsed, the 
output turns OFF. 
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Block 
selection 

Symbol Function block Description 

13 

Input Output 

  

 

Through output  

+ Pulse (1 shot) 

Turning ON the input starts the timer. The 
output remains ON until reaching the timer time. 

While the output is ON, the timer operation 
continues without regard of the input status. 

Setting the timer time to 0 turns OFF the output. 

 

OFF ON

Timer time

Input

Output

OFF

OFF ON ON

OFF

OFF OFF

 

14 

Input Output 

  

 

Through output  

+ Retriggerable timer 

Turning ON the input starts the timer. The 
output remains ON until reaching the timer time. 

If an OFF to ON edge at the input occurs while 
the output is ON, however, the output remains 
ON from that time until reaching the timer time. 

Setting the timer time to 0 causes the output to 
turn ON when the input turns ON. 

 

OFF ON

Timer time

Input

Output

OFF

OFF ON ON

ON

OFF OFF

 

15 

Input Output 

  

 

Through output  

+ Pulse train output 

Outputs a pulse signal with a period twice the 
timer time and a duty of 50%. Useful for flashing 
a light emitting device. 

Turning ON the input turns ON the output and 
starts the timer. When reaching the timer time, 
the output turns OFF and the timer restarts. 
When reaching the timer time again, the output 

turns ON and the timer restarts. 

Setting the timer time to 0 turns OFF the output. 

 

OFF ON

Timer time

Input

Output
OFF ON

ON

OFF ON
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20 to 25: AND 

Block 
selection 

Symbol Function block Description 

20 

Input 1 

 

Output 

 

Logical product (AND)  This is an AND circuit with 2 inputs/1 output.  

 

Input 2 

 

21 

Input 1 

 

Output 

 

Logical product (AND)  

+ ON-delay timer 

This is a combination of an AND circuit with 2 
inputs/1 output and an ON-delay timer.  

Turning ON the AND circuit output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
AND circuit output turns OFF the output.  

 

Input 2 

 

22 

Input 1 

 

Output 

 

Logical product (AND)  

+ OFF-delay timer 

This is a combination of an AND circuit with 2 
inputs/1 output and an OFF-delay timer.  

Turning ON the AND circuit output turns ON the 

output.  

Turning OFF the AND circuit output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

23 

Input 1 

 

Output 

 

Logical product (AND)  

+ Pulse (1 shot) 

This is a combination of an AND circuit with 2 
inputs/1 output and a pulse (1 shot) output.  
For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 

Input 2 

 

24 

Input 1 

 

Output 

 

Logical product (AND)  

+ Retriggerable timer 

This is a combination of an AND circuit with 2 
inputs/1 output and a retriggerable timer.  
For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 

Input 2 

 

25 

Input 1 

 

Output 

 

Logical product (AND)  

+ Pulse train output  

This is a combination of an AND circuit with 2 
inputs/1 output and a pulse train output.  
For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 

Input 2 
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30 to 35: OR 

Block 
selection 

Symbol Function block Description 

30 

Input 1 

 

Output 

 

Logical sum (OR)  This is an OR circuit with 2 inputs/1 output. 

 

Input 2 

 

31 

Input 1 

 

Output 

 

Logical sum (OR)  

+ ON-delay timer 

This is a combination of an OR circuit with 2 
inputs/1 output and an ON-delay timer.  
Turning ON the OR circuit output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
OR circuit output turns OFF the output.  

 

Input 2 

 

32 

Input 1 

 

Output 

 

Logical sum (OR)  

+ OFF-delay timer 

This is a combination of an OR circuit with 2 
inputs/1 output and an OFF-delay timer.  
Turning ON the OR circuit output turns ON the 
output.  
Turning OFF the OR circuit output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

33 

Input 1 

 

Output 

 

Logical sum (OR)  

+ Pulse (1 shot) 

This is a combination of an OR circuit with 2 
inputs/1 output and a pulse (1 shot) output.  
For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 

Input 2 

 

34 

Input 1 

 

Output 

 

Logical sum (OR)  

+ Retriggerable timer 

This is a combination of an OR circuit with 2 
inputs/1 output and a retriggerable timer.  
For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer".  

 

Input 2 

 

35 

Input 1 

 

Output 

 

Logical sum (OR)  

+ Pulse train output  

This is a combination of an OR circuit with 2 
inputs/1 output and a pulse train output.  
For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 

Input 2 
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40 to 45: XOR 

Block 
selection 

Symbol Function block Description 

40 

Input 1 

 

Output 

 

Exclusive OR (XOR)  This is an XOR circuit with 2 inputs/1 output.  

 

Input 2 

 

41 

Input 1 

 

Output 

 

Exclusive OR (XOR)  

+ ON-delay timer 

This is a combination of an XOR circuit with 2 
inputs/1 output and an ON-delay timer.  

Turning ON the XOR circuit output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
XOR circuit output turns OFF the output.  

 

Input 2 

 

42 

Input 1 

 

Output 

 

Exclusive OR (XOR)  

+ OFF-delay timer 

This is a combination of an XOR circuit with 2 
inputs/1 output and an OFF-delay timer.  

Turning ON the XOR circuit output turns ON the 
output.  

Turning OFF the XOR circuit output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

43 

Input 1 

 

Output 

 

Exclusive OR (XOR)  

+ Pulse (1 shot) output  

This is a combination of an XOR circuit with 2 
inputs/1 output and a pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 

Input 2 

 

44 

Input 1 

 

Output 

 

Exclusive OR (XOR)  

+ Retriggerable timer 

This is a combination of an XOR circuit with 2 
inputs/1 output and a retriggerable timer.  

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 

Input 2 

 

45 

Input 1 

 

Output 

 

Exclusive OR (XOR)  

+ Pulse train output  

This is a combination of an XOR circuit with 2 
inputs/1 output and a pulse train output.  

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 

Input 2 

 

 

  



 

Chapter 2 Functional Description 

 2-117 

2.3.3.18.2. [Digital] - Flip-flop 

To select a flip-flop symbol, choose [Flip-Flop] 

from the [Digital] tab. 

 

 

50 to 55: SR-FF 

Block 
selection 

Symbol Function block Description 

50 

Input 1 

 

Output 

 

Set priority  

flip-flop  

This is a set priority flip-flop.  

When Input 1 (SET) turns ON, the output turns 
ON, and when Input 2 (RESET) turns ON, the 
output turns OFF. If there is no input, the 
previous state is maintained. 

When both inputs are ON, Input 1 (SET) has 
priority. 

For supported inverter, you can specify the 
initial state (OFF (0) or ON (1)) of the flip-flop 
immediately after starting the customizable 
logic with Parameter 2. For non-supported 

models, the initial state is OFF (0). 

 
Input 2 

 

51 

Input 1 

 

Output 

 
Set priority  

flip-flop  

+ ON-delay timer 

This is a combination of a set priority flip-flop 
and an ON-delay timer.  

Turning ON the flip-flop output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
flip-flop output turns OFF the output.  

 
Input 2 

 

52 

Input 1 

 

Output 

 
Set priority  

flip-flop  

+ OFF-delay timer 

This is a combination of a set priority flip-flop 
and an OFF-delay timer.  

Turning ON the flip-flop output turns ON the 
output.  

Turning OFF the flip-flop output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

53 

Input 1 

 

Output 

 
Set priority  

flip-flop  

+ Pulse (1 shot) 

This is a combination of a set priority flip-flop 
and a pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 
Input 2 

 

54 

Input 1 

 

Output 

 Set priority  

flip-flop  

+ Retriggerable timer 

This is a combination of a set priority flip-flop 
and a retriggerable timer. 

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 
Input 2 

 

55 

Input 1 

 

Output 

 Set priority  

flip-flop  

+ Pulse train output  

This is a combination of a set priority flip-flop 
and a pulse train output. 

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 
Input 2 
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60 to 65: RS-FF 

Block 
selection 

Symbol Function block Description 

60 

Input 1 

 

Output 

 

Reset priority  

flip-flop  

This is a reset priority flip-flop.  

When Input 1 (SET) turns ON, the output turns 
ON, and when Input 2 (RESET) turns ON, the 
output turns OFF. If there is no input, the 
previous state is maintained. 

When both inputs are ON, Input 2 (RESET) has 
priority. 

For supported inverter, you can specify the 
initial state (OFF (0) or ON (1)) of the flip-flop 
immediately after starting the customizable 
logic with Parameter 2. For non-supported 
models, the initial state is OFF (0). 

 
Input 2 

 

61 

Input 1 

 

Output 

 Reset priority  

flip-flop  

+ ON-delay timer 

This is a combination of a reset priority flip-flop 
and an ON-delay timer.  

Turning ON the flip-flop output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
flip-flop output turns OFF the output.  

 
Input 2 

 

62 

Input 1 

 

Output 

 
Reset priority  

flip-flop  

+ OFF-delay timer 

This is a combination of a reset priority flip-flop 
and an OFF-delay timer.  

Turning ON the flip-flop output turns ON the 
output.  

Turning OFF the flip-flop output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

63 

Input 1 

 

Output 

 
Reset priority  

flip-flop  

+ Pulse (1 shot) 

This is a combination of a reset priority flip-flop 
and a pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)".  

 
Input 2 

 

64 

Input 1 

 

Output 

 Reset priority  

flip-flop  

+ Retriggerable timer 

This is a combination of a reset priority flip-flop 
and a retriggerable timer.  

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 
Input 2 

 

65 

Input 1 

 

Output 

 Reset priority 

flip-flop  

+ Pulse train output  

This is a combination of a reset priority flip-flop 
and a pulse train output.  

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 
Input 2 
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140 to 145: D-FF 

Block 
selection 

Symbol Function block Description 

140 

Input 1 

 

Output 

 

D (delay) flip-flop  

This is a delay flip-flop.  

The rising edge of Input 2 (CK) reflects the 
state of Input 1 (D) to the output. 

For supported inverter, you can specify the 
initial state (OFF (0) or ON (1)) of the flip-flop 
immediately after starting the customizable 
logic with Parameter 2.  

 
Input 2 

 

141 

Input 1 

 

Output 

 

D (delay) flip-flop  
+ ON-delay timer 

This is a combination of a delay flip-flop and an 
ON-delay timer.  

Turning ON the flip-flop output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
flip-flop output turns OFF the output.  

 
Input 2 

 

142 

Input 1 

 

Output 

 

D (delay) flip-flop  

+ OFF-delay timer 

This is a combination of a delay flip-flop and an 
OFF-delay timer.  

Turning ON the flip-flop output turns ON the 
output.  

Turning OFF the flip-flop output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

Input 2 

 

143 

Input 1 

 

Output 

 

D (delay) flip-flop  

+ Pulse (1 shot) 

This is a combination of a delay flip-flop and a 
pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)".  

 
Input 2 

 

144 

Input 1 

 

Output 

 

D (delay) flip-flop  

+ Retriggerable timer 

This is a combination of a delay flip-flop and a 
retriggerable timer.  

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 
Input 2 

 

145 

Input 1 

 

Output 

 

D (delay) flip-flop  

+ Pulse train output  

This is a combination of a delay flip-flop and a 
pulse train output.  

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 
Input 2 
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150 to 155: T-FF 

Block 
selection 

Symbol Function block Description 

150 

Input  

 

Output 

 

T (toggle) flip-flop  

This is a toggle flip-flop.  

The output status is inverted by the rising edge 
of Input 1 (T). 

For supported inverter, you can specify the 
initial state (OFF (0) or ON (1)) of the flip-flop 
immediately after starting the customizable 
logic with Parameter 2.  

 
 

151 

Input 

 

Output 

 

T (toggle) flip-flop  
+ ON-delay timer 

This is a combination of a delay flip-flop and an 
ON-delay timer.  

Turning ON the flip-flop output starts the 
ON-delay timer. When the timer time has 
elapsed, the output turns ON. Turning OFF the 
flip-flop output turns OFF the output.  

 

 

152 

Input  

 

Output 

 

T (toggle) flip-flop  

+ OFF-delay timer 

This is a combination of a delay flip-flop and an 
OFF-delay timer.  

Turning ON the flip-flop output turns ON the 

output.  

Turning OFF the flip-flop output starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

 

 

153 

Input  

 

Output 

 
T (toggle) flip-flop  

+ Pulse (1 shot) 

This is a combination of a delay flip-flop and a 
pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)".  

 
 

154 

Input  

 

Output 

 
T (toggle) flip-flop  

+ Retriggerable timer 

This is a combination of a delay flip-flop and a 
retriggerable timer.  

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 
 

155 

Input 

 

Output 

 
T (toggle) flip-flop  

+ Pulse train output  

This is a combination of a delay flip-flop and a 
pulse train output.  

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 
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2.3.3.18.3. [Digital] - Edge Detection 

To select an edge detection symbol, choose 

[Edge detection] from the [Digital] tab. 

 

 

70, 72, 73: Rise Edge 

Block 
selection 

Symbol Function block Description 

70 

Input Output 

  

 

Rise edge detection  

This is a rise detection with 1 input/1 output.  

Once a rise of an input signal is detected, the 
ON signal is output until the end of one 
execution cycle time. 

72 

Input Output 

  

 

Rise edge detection + 
OFF-delay timer 

This is a combination of a rise detection with 1 
input/1 output and an OFF-delay timer.  

When a rise edge is detected, the output turns 

ON.  

Turning OFF the rise edge detection starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

73 

Input Output 

  

 

Rise edge detection + 
Pulse (1 shot) 

This is a combination of a rise detection with 1 
input/1 output and a pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 

80, 82, 83: Fall Edge 

Block 
selection 

Symbol Function block Description 

80 

Input Output 

  

 

Fall edge detection  

This is a fall detection with 1 input/1 output. 

Once a fall of an input signal is detected, the 
ON signal is output until the end of one 
execution cycle time.  

82 

Input Output 

  

 

Fall edge detection + 
OFF-delay timer 

This is a combination of a fall detection with 1 
input/1 output and a general-purpose timer.  

When a fall edge is detected, the output turns 

ON.  

Turning OFF the rise edge detection starts the 
OFF-delay timer. When the timer time has 
elapsed, the output turns OFF.  

83 

Input Output 

  

 

Fall edge detection + 
Pulse (1 shot) 

This is a combination of a fall detection with 1 
input/1 output and a pulse (1 shot) output. 

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 
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90, 92, 93: Both Edges 

Block 
selection 

Symbol Function block Description 

90 

Input Output 

  

 

Rise and fall edge 
detection  

This is a rise and fall detection with 1 input/1 
output.  

Once a rise or fall of an input signal is detected, 
the ON signal is output until the end of one 
execution cycle time. 

92 

Input Output 

  

 

Rise and fall edge 
detection  

+ OFF-delay timer 

This is a combination of a rise and fall detection 
with 1 input/1 output and an OFF-delay timer.  

Turning OFF the rise and fall edge detection 
starts the OFF-delay timer. When the timer time 
has elapsed, the output turns OFF.  

93 

Input Output 

  

 

Rise and fall edge 
detection  

+ Pulse  

(1 shot)  

This is a combination of a rise and fall detection 
with 1 input/1 output and a pulse (1 shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 

  



 

Chapter 2 Functional Description 

 2-123 

2.3.3.18.4. [Digital] - Digital Other 

To select a "digital other" symbol, choose [Digital 

Other] from the [Digital] tab. 

 

 

100 to 105: Hold 

Block 
selection 

Symbol Function block Description 

100 

Input 1 

 

Output 

 

Hold  

This is a "hold previous value" function with 2 
inputs/1 output. 

Input 2 is the hold control signal. 

Turning OFF Input 2 outputs Input 1. 
Turning ON Input 2 holds the previous output 
value.  

 
Input 2 

 

101 

Input 1 

 

Output 

 

Hold  

+ ON-delay timer 

This is a combination of a "hold previous value" 
function with 2 inputs/1 output and an ON-delay 
timer.  

Turning ON the hold output starts the ON-delay 
timer. When the timer time has elapsed, the 
output turns ON. Turning OFF the hold output 
turns OFF the output.  

 

Input 2 

 

102 

Input 1 

 

Output 

 

Hold  

+ OFF-delay timer 

This is a combination of a "hold previous value" 
function with 2 inputs/1 output and an 

OFF-delay timer.  

Turning ON the hold output turns ON the output.  
 

Input 2 

 

103 

Input 1 

 

Output 

 

Hold  

+ Pulse (1 shot) 

This is a combination of a "hold previous value" 
function with 2 inputs/1 output and a pulse (1 
shot) output.  

For information on the operation of a pulse (1 
shot), refer to Block selection 13 "Through 
output + Pulse (1 shot)". 

 
Input 2 

 

104 

Input 1 

 

Output 

 

Hold  

+ Retriggerable timer 

This is a combination of a "hold previous value" 
function with 2 inputs/1 output and a 

retriggerable timer.  

For information on the operation of a 
retriggerable timer, refer to Block selection 14 
"Through output + Retriggerable timer". 

 
Input 2 

 

105 

Input 1 

 

Output 

 

Hold  

+ Pulse train output  

This is a combination of a "hold previous value" 
function with 2 inputs/1 output and a pulse train 

output.  

For information on the operation of a pulse train 
output, refer to Block selection 15 "Through 
output + Pulse train output". 

 
Input 2 
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110, 120, 130: Counter/Timer 

Block 

selection 
Item Details 

110 

Category Counter/Timer 

Function block Up counter 

Symbol 

 Parameter 1: Target value 

 Input 1 

 

Output   

 Input 2 

   

Description 

This is an up counter output with a reset input. 

Parameter 1 sets the target value. 

Input 2 is a reset signal. Turning ON Input 2 sets the counter value to 0. 

If the counter value is less than Parameter 1, +0.01 is added to the counter value 

at the rise of Input 1.  

When the counter value is equal to or more than Parameter 1, the output turns 

ON. When the output is ON, nothing is added to the counter value. 

Stopping the customizable logic sets the counter value to 0. 

Input 1 
Logical value: When the count signal changes from OFF to ON, +0.01 is added to 

the counter value. 

Input 2 Logical value: Turning ON the input signal sets the counter value to 0. 

Output 
Logical value: ON when the counter value is equal to or more than the target 

value 

Property settings Parameter 1: Target value: 0.00 to 9990 (significant digits: 3 digits) 

120 

Category Counter/Timer 

Function block Down counter 

Symbol 

 Parameter 1: Counter initial value 

 Input 1 

 

Output  

 Input 2 

   

Description 

This is an down counter output with a reset input. 

Parameter 1 sets the initial value. 

Input 2 is a reset signal. Turning ON Input 2 sets the counter value to Parameter 

1. 

If the counter value is more than 0, +0.01 is subtracted from the counter value at 

the rise of Input 1.  

When the counter value is equal to or less than 0, the output turns ON. When the 

output is ON, nothing is subtracted from the counter value. 

Stopping the customizable logic sets the counter value to Parameter 1. 

Input 1 
Logical value: When the count signal changes from OFF to ON, +0.01 is 

subtracted from the counter value. 

Input 2 Logical value: Turning ON the reset signal sets the counter value to Parameter 1. 

Output Logical value: ON when the counter value is equal to or less than the 0. 

Property settings Parameter 1: Target value: 0.00 to 9990 (significant digits: 3 digits) 
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Block 

selection 
Item Details 

130 

Category Counter/Timer 

Function block Timer with a reset input 

Symbol 

 Parameter 1: Target time 

 Input 1 

 

Output  

 Input 2 

   

Description 

This is an OFF-delay timer output with a reset function. 

Parameter 1 sets the target time. 

Input 2 is a reset signal. Turning ON Input 2 sets the timer current value to 0. 

Turning ON Input 1 turns ON the output and starts the timer. While the timer is 

operating, the output remains ON without regard of the status of Input 1. 

When the timer current value is equal to or more than the target time, the output 

turns OFF without regard of the status of Input 1. Also, the timer stops and the 

timer current value becomes 0. 

If both Input 1 and Input 2 are turned ON, Input 2 takes precedence. 

Stopping the customizable logic sets the timer current value to 0. 

Input 1 Logical value: When the signal changes from OFF to ON, the timer is started.  

Input 2 Logical value: Turning ON the reset signal sets the timer current value to 0. 

Output 
Logical value: ON during the period from when Input 2 turns OFF and Input 1 

turns ON to when the timer current value becomes less than the target time. 

Property settings Parameter 1: Target time: 0.00 to 9990 [s] (significant digits: 3 digits) 
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2.3.3.18.5. [Analog] - Basic Operator 

Calculator 

2001: Addition 

Block 

selection 
Item Details 

2001 

Category Calculator 

Function block Addition 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

This is a combination of an addition circuit with 2 inputs/1 output and an output 

limiter.  

This function block performs an addition between Input 1 and Input 2 and outputs 

the result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation 2 Input + 1 Input = Output  

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

2002: Subtraction 

Block 

selection 
Item Details 

2002 

Category Calculator 

Function block Subtraction 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

This is a combination of an subtraction circuit with 2 inputs/1 output and an output 

limiter.  

This function block performs a subtraction between Input 1 and Input 2 and 

outputs the result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation 2 Input - 1 Input = Output  

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

  



 

Chapter 2 Functional Description 

 2-127 

2003: Multiplication 

Block 

selection 
Item Details 

2003 

Category Calculator 

Function block Multiplication 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

This is a combination of a multiplication circuit with 2 inputs/1 output and an 

output limiter.  

This function block performs a multiplication between Input 1 and Input 2 and 

outputs the result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation 2 Input  1 Input = Output   

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

2004: Division 

Block 

selection 
Item Details 

2004 

Category Calculator 

Function block Division 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

This is a combination of a division circuit with 2 inputs/1 output and an output 

limiter.  

This function block performs a division between Input 1 and Input 2 and outputs 

the result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation 2 Input  1 Input = Output   

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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2006: Absolute value 

Block 

selection 
Item Details 

2006 

Category Calculator 

Function block Absolute value 

Symbol 

 Parameter 1: Upper limit value 

 Input 

 

Output  

 Parameter 2: Lower limit value 

Description 

This function block determines the absolute value of the input and outputs the 

result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

2007: Inverse addition 

Block 

selection 
Item Details 

2007 

Category Calculator 

Function block Inverse addition 

Symbol 

 Parameter 1: Offset  

 Input 

 

Output  

 Parameter 2: Bias  

Description 

This is an inverting circuit with 1 input/1 output. 

It corrects the sign inversion value of the input based on Parameter 1 (offset) and 

Parameter 2 (bias) and outputs it. 

The output is limited by ±9990. 

This is similar to the function block "inverse addition switchover (4002)". For 

information on the inverse addition switchover, refer to "4002: Inverse addition 

switchover" in "[Digital + Analog] - Basic operator". 

Calculation 2 Function + 1) Function - (Input - = Output  

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 
Parameter 1: Offset: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Bias: -9990 to +9990 (significant digits: 3 digits) 
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2010: Modulo 

Block 

selection 
Item Details 

2103 

Category Calculator 

Function block Modulo 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

Outputs the result of modulo operation of Input 1 and Input 2. Divides input 1 by 

input 2 and outputs the remainder. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation Output = Input 1 mod Input 2 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

2103: Average 

Block 

selection 
Item Details 

2103 

Category Calculator 

Function block Average calculation 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Lower limit value 

Description 

Outputs the addition average value of Input 1 and Input 2. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Calculation 
2

2 Input + 1 Input
=Output  

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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Limiter 

2005: Limiter 

Block 

selection 
Item Details 

2005 

Category Limiter 

Function block Limiter 

Symbol 

 Parameter 1: Upper limit value 

 Input 

 

Output  

 Parameter 2: Lower limit value 

Description 

This is an upper/lower limiter circuit with 1 input/1 output.   

This function block determines the limited value of Input 1 and outputs the result. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

If the upper limit value is equal to the lower limit value, the upper limit value is 

interpreted as +9990 and the lower limit value as -9990. In this case, "Through" 

appears under the symbol. 

If the upper limit value is less than the lower limit value, the upper limit value is 

output. 

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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2008: Variable limiter 

Block 

selection 
Item Details 

2008 

Category Limiter 

Function block Variable limiter 

Symbol 

 Parameter 1: Input 3 (step number) 

 Input 1 

 

Output   Input 2 

 Input 3: Function 

block output 

   

Description 

You can apply variable upper and lower limits to Input 3. 

The output is limited by the upper and lower limit values assigned to Input 1 and 

Input 2. 

If Input 1 (upper limit value) is less than Input 2 (lower limit value), Input 1 is 

output. 

Input 3 accepts the connection of the output of a function block (a symbol that 

allows step number assignment). You cannot connect an input terminal directly to 

it. 

If you do not connect Input 3, the variable upper and lower limit values are applied 

to the output (SOxx) with step number xx specified in Parameter 1. 

If you connect Input 3, performing the auto step number assignment overwrites 

Parameter 1 with the step number specified by Input 3. 

Calculation 
Output

Input 1

Input 2

Input 3

 

The lower limit is applied first and 

then the upper limit is applied. 

If you do not connect Input 3, replace 

Input 3 shown to the left with the 

output of the step number specified 

in Parameter 1. 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings Parameter 1: Step number: 1 to maximum step number 
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Selector 

2101: Maximum selection 

Block 

selection 
Item Details 

2101 

Category Selector 

Function block Maximum selection 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Lower limit value 

Description 

Compares Input 1 and Input 2 and outputs the larger of the two. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

2102: Minimum selection 

Block 

selection 
Item Details 

2102 

Category Selector 

Function block Minimum selection 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

Compares Input 1 and Input 2 and outputs the smaller of the two. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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Analog through 

2005: Analog through 

Block 

selection 
Item Details 

2005 

Category Analog through 

Function block Analog through 

Symbol 

  

 Input 

 

Output  

  

Description 

This is a through output of analog values without arithmetic processing. 

Use “10 to 15: Through” for the through output a digital signal. 

 

 
 Since this function is internally the same as "2005: Limiter", it has 

the same number. 

 

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

 

Constant value 

2009: Constant value 

Block 

selection 
Item Details 

2009 

Category Constant value 

Function block Constant value 

Symbol 

  

 

 

Output  

 Parameter 2: Constant value 

Description 

The value set for Parameter 2 is always output as a constant. 

 

 
 Since this function is internally the same as "2009: Linear 

function", it has the same number. 

 

Calculation Output = Parameter 2 

Output Numeric value: -9990 to +9990 

Property settings Parameter 2: Constant value: -9990 to +9990 (significant digits: 3 digits) 
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2.3.3.18.6. [Analog] - Comparator 

Analog comparator 

2051: Comparison 1 

Block 

selection 
Item Details 

2051 

Category Analog comparator 

Function block Comparison 1 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the two input deviations (including any 

equal sign). 

If both the output ON and OFF conditions are true, the ON condition takes 

precedence. 

Calculation 
Output ON condition: Input 1 - Input 2 ≥ Parameter 1 + |Parameter 2| 

Output OFF condition: Input 1 - Input 2 ≥ Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 

 

2052: Comparison 2 

Block 

selection 
Item Details 

2052 

Category Analog comparator 

Function block Comparison 2 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Hysteresis width 

Description 
Digitally outputs the comparison result of the two input deviations (not including 

equal signs). 

Calculation 
Output ON condition: Input 1 - Input 2 > Parameter 1 + |Parameter 2| 

Output OFF condition: Input 1 - Input 2 < Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 
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2053: Comparison 3 

Block 

selection 
Item Details 

2053 

Category Analog comparator 

Function block Comparison 3 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the two input deviations (absolute 

values) (including any equal sign). 

If both the output ON and OFF conditions are true, the ON condition takes 

precedence. 

Calculation 
Output ON condition: |Input 1 - Input 2| ≥ Parameter 1 + |Parameter 2| 

Output OFF condition: |Input 1 - Input 2| ≦ Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 

 

2054: Comparison 4 

Block 

selection 
Item Details 

2054 

Category Analog comparator 

Function block Comparison 4 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Hysteresis width 

Description 
Digitally outputs the comparison result of the two input deviations (absolute 

values) (not including equal signs). 

Calculation 
Output ON condition: |Input 1 - Input 2| > Parameter 1 + |Parameter 2| 

Output OFF condition: |Input 1 - Input 2| < Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 
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2055: Comparison 5 

Block 

selection 
Item Details 

2055 

Category Analog comparator 

Function block Comparison 5 

Symbol 

 Parameter 1: Judgment value 

 Input 

 

Output  

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the input and the judgment value. 

The hysteresis width is configurable but takes effect only if the OFF condition is 

true. 

Calculation 
Output ON condition: Input ≥ Parameter 1 

Output OFF condition: Input 1 < Parameter 1 - |Parameter 2| 

Input Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 
Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 

 

2056: Comparison 6 

Block 

selection 
Item Details 

2056 

Category Analog comparator 

Function block Comparison 6 

Symbol 

 Parameter 1: Judgment value 

 Input 

 

Output  

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the input and the judgment value. 

The hysteresis width is configurable but takes effect only if the OFF condition is 

true. 

Calculation 
Output ON condition: Input ≥ Parameter 1 

Output OFF condition: Input 1 < Parameter 1 + |Parameter 2| 

Input Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 
Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 
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2057: Comparison 7 

Block 

selection 
Item Details 

2057 

Category Analog comparator 

Function block Comparison 7 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the two input deviations. 

The ON condition does not include the equal sign, and the OFF condition 

includes the equal sign. 

Calculation 
Output ON condition: Input 1 - Input 2 > Parameter 1 + |Parameter 2| 

Output OFF condition: Input 1 - Input 2 ≦ Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 

 

2058: Comparison 8 

Block 

selection 
Item Details 

2058 

Category Analog comparator 

Function block Comparison 8 

Symbol 

 Parameter 1: Deviation judgment value 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Hysteresis width 

Description 

Digitally outputs the comparison result of the two input deviations (absolute 

values). 

The ON condition does not include the equal sign, and the OFF condition 

includes the equal sign. 

Calculation 
Output ON condition: |Input 1 - Input 2| > Parameter 1 + |Parameter 2| 

Output OFF condition: |Input 1 - Input 2| ≦ Parameter 1 - |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 

Parameter 1: Deviation judgment value: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 
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Equal 

2071: Equal comparison 1 

Block 

selection 
Item Details 

2071 

Category Equal 

Function block Equal comparison 1 

Symbol 

 Parameter 1: Judgment value 

 Input 

 

Output  

  

Description 

Digitally outputs the comparison result of Input 1 and the judgment value. 

If Input 1 and the judgment value are equal, ON (true) is output. 

 

 
 Since this function is internally the same as "2071: Window 

comparison 1", it has the same number. 

 

Calculation 
Output ON condition: Input = Parameter 1 

Output OFF condition: Input ≠ Parameter 1 

Input Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings Parameter 1: Judgment value: -9990 to +9990 (significant digits: 3 digits) 

 

2059: Equal Comparison 2 

Block 

selection 
Item Details 

2059 

Category Equal 

Function block Equal comparison 2 

Symbol 

  

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Hysteresis width 

Description 
Digitally outputs the comparison result of Input 1 and the judgment value. 

If Input 1 and Input 2 are equal, ON (true) is output. 

Calculation 
Output ON condition: |Input 1 - Input 2| ≧ |Parameter 2| 

Output OFF condition: |Input 1 - Input 2| < |Parameter 2| 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings Parameter 2: Hysteresis width: -9990 to +9990 (significant digits: 3 digits) 
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Window comparator 

2071: Window comparison 1 

Block 

selection 
Item Details 

2071 

Category Window comparator 

Function block Window comparison 1 

Symbol 

 Parameter 1: Upper threshold 

 Input 

 

Output  

 Parameter 2: Lower threshold 

Description 

Digitally outputs the comparison result of Input 1 and the upper/lower thresholds. 

If Input 1 is within the range between the upper threshold and the lower threshold 

(including equal signs), ON (true) is output. 

Calculation 
Output ON condition: Parameter 1 ≥ Input ≥ Parameter 2 

Output OFF condition: (Input > Parameter 1) or (Parameter 2 > Input) 

Input Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 
Parameter 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits) 

 

2072: Window comparison 2 

Block 

selection 
Item Details 

2072 

Category Window comparator 

Function block Window comparison 2 

Symbol 

 Parameter 1: Upper threshold 

 Input 

 

Output  

 Parameter 2: Lower threshold 

Description 

Digitally outputs the comparison result of Input 1 and the upper/lower thresholds. 

If Input 1 is within the range between the upper threshold and the lower threshold 

(not including equal signs), ON (true) is output. 

Calculation 
Output ON condition: Parameter 1 > Input > Parameter 2 

Output OFF condition: (Input ≥ Parameter 1) or (Parameter 2 ≥ Input) 

Input Numeric value: -9990 to +9990 

Output 
Logical value: ON when the output ON condition is true; OFF when the output 

OFF condition is true. 

Property settings 
Parameter 1: Upper threshold: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower threshold: -9990 to +9990 (significant digits: 3 digits) 
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2.3.3.18.7. [Analog] - Converter 

Converter 

2009: Linear function 

Block 

selection 
Item Details 

2009 

Category Converter 

Function block Linear function 

Symbol 

 Parameter 1: Coefficient AK   

 Input  Output  

 Parameter 2: Coefficient BK   

Description 

This function block calculates the linear function passed as input.  

It calculates the output value based on the predefined linear function (one 

indicated in the "Calculation" field below). The coefficients of the linear function 

are given by Parameter 1 and Parameter 2.  

The output is limited by the internal limiter.  

When Parameter 1 is set to 0.00, no error occurs even if the input is not 

connected. 

Calculation 
ΒΚΑΚ  InputOutput  

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 
Parameter 1: Coefficient AK : -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Coefficient BK : -9990 to +9990 (significant digits: 3 digits) 

 

2151: S13 function code input 

Block 

selection 
Item Details 

2151 

Category Converter 

Function block S13 function code input 

Symbol 

 Parameter 1: Value output when S13 is 20000 

 

 

Output  

 Parameter 2: Value output when S13 is 0 

Description 

Converts the settings "0 to 20000/0 to 
100%" of function code S13 (PID command 
value) so that the values specified in 
Parameter 2 and Parameter 1 are output 
when S13 is 0 and 20000, respectively. 

Output

S13

Function 1 

Function 2
0 20000

(0%) (100%)
 

Calculation 2 Function + S13
20000

2) Function - 1 (Function
= Output   

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property 

settings 

Parameter 1: Value output when S13 is 20000: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Value output when S13 is 0: -9990 to +9990 (significant digits: 3 digits) 
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2201: Inverse scale transformation 

Block 

selection 
Item Details 

2201 

Category Converter 

Function block Inverse scale transformation 

Symbol 

 Parameter 1: Value input when the output is 100 

 Input 

 

Output  

 Parameter 2: Value input when the output is 0 

Description 

Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%". 

Use this function block for the connection to an analog output terminal. 

The maximum number of steps that can be 

used is two. 

If you set both Parameter 1 and Parameter 

2 to the same value, the output is 0. 

Output

Input

Function 1Function 2

0

100

 

Calculation 
2 Function - 1 Function

2 Function - Input
100 = Output   

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 

Parameter 1: Value input when the output is 100: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Value input when the output is 0: -9990 to +9990 (significant digits: 3 digits) 

 

2202: Scale transformation 

Block 

selection 
Item Details 

2202 

Category Converter 

Function block Scale transformation 

Symbol 

 Parameter 1: Value output when the input is 100 

 Input 

 

Output  

 Parameter 2: Value output when the input is 0 

Description 

Inversely transform the scale of Input 1 from "minimum to maximum" to "0 to 100%". 

For input selection, you can only use a setting from 8000 to 8085 

The maximum number of steps that can be used is 

two. 
Output

Input 

Function 1

Function 2
0 100

 

Calculation 2 Function + Input
100

2) Function - 1 (Function
= Output   

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 

Parameter 1: Value output when the input is 100: -9990 to +9990 (significant digits: 3 

digits) 

Parameter 2: Value output when the input is 0: -9990 to +9990 (significant digits: 3 digits) 
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3001: Conversion 1 

Block 

selection 
Item Details 

3001 

Category Converter 

Function block Conversion 1 

Symbol 

 Parameter 1: Upper limit value 

 Input 

 

Output  

 Parameter 2: Lower limit value 

Description 

This function block calculates the quadratic function passed as input. 

It calculates the output value based on the predefined quadratic function (one 

indicated in the "Calculation" field below). 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

You can select whether to manually set or automatically calculate coefficients 

K A , K B , KC . 

To manually set the conversion coefficients 

You can set each coefficient using an exponent. For example, you can specify 

a mantissa and an exponent part to define K A as follows: 

part) (Exponent
10(Mantissa) K A

 

The same applies to K B  and KC . 

To automatically calculate the 

conversion coefficients 

Specify the input-output 

relationship using three points: 

(X1, Y1), (X2, Y2), and (X3, Y3). 

Then each coefficient is set to 

an automatically calculated 

value. 
 

The maximum number of steps 

that can be used is one for both 

Conversion 1 (3001) and 

Conversion 2 (3002). 

When you use both Conversion 1 

(3001) and Conversion 2 (3002), 

Conversion 1 (3001) takes 

precedence. 

X3X2X1

Y3

Y2

Y1

Operating 

point 3

(X3,Y3)

Operating 

point 2

(X2,Y2)Operating 

point 1

(X1,Y1)

0
Input

Output

 

If you use two or more instances of Conversion 1 (3001), the one with the 

smallest step number takes precedence. 

Do not select Auto Calculation when you want to write to the keypad. Refer to 

"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details. 

Calculation   KCK BK A  InputInputOutput
2  

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 

To manually set the conversion coefficients: 

Mantissas of K A , K B , and KC : -9.999 to 9.999 

Exponent parts of K A , K B , and KC : -5 to 5 

To automatically calculate the conversion coefficients: 

X1 , Y1 , X 2 , Y 2 , X 3 , Y 3 : -9990 to +9990 (significant digits: 3 digits) 

Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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3002: Conversion 2 

Block 

selection 
Item Details 

3002 

Category Converter 

Function block Conversion 2 

Symbol 

 Parameter 1: Upper limit value 

 Input 

 

Output  

 Parameter 2: Lower limit value 

Description 

This function block calculates the output value based on the predefined function 

(one indicated in the "Calculation" field below). 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

You can select whether to manually set or automatically calculate coefficients 

K A , K B , KC . 

To manually set the conversion coefficients 

You can set each coefficient using an exponent. For example, you can specify a 

mantissa and an exponent part to define K A as follows: 

part) (Exponent
10(Mantissa) K A

 

The same applies to K B  and KC . 

To automatically calculate the 
conversion coefficients 

Specify the input-output 

relationship using three points: 

(X1, Y1), (X2, Y2), and (X3, Y3). 

Then each coefficient is set to 

an automatically calculated 

value. 
 

The maximum number of steps 

that can be used is one for both 

Conversion 1 (3001) and 

Conversion 2 (3002). 

When you use both Conversion 1 

(3001) and Conversion 2 (3002), 

Conversion 1 (3001) takes 

precedence. 

Y Operating 

point 3

(X3,Y3)

Operating 

point 2

(X2,Y2)

Operating 

point 1

(X1,Y1)

X3X2X10 X
 

If you use two or more instances of Conversion 2 (3001), the one with the 

smallest step number takes precedence. 

If the calculation result inside is a negative value, '0' is output. 

Do not select Auto Calculation when you want to write to the keypad. Refer to 
"2.3.3.4. [4] Function Block 3001: conversion 1, 3002: conversion 2" for details. 

Calculation KC
K B

K A 
+ Input

= Output  

Input Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 

To manually set the conversion coefficients: 

Mantissas of K A , K B , and KC : -9.999 to 9.999 

Exponent parts of K A , K B , and KC : -5 to 5 

To automatically calculate the conversion coefficients: 
X1 , Y1 , X 2 , Y 2 , X 3 , Y 3 : -9990 to +9990 (significant digits: 3 digits) 

Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 
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2.3.3.18.8. [Digital + Analog] - Basic operator 

Basic operator 

4001: Hold 

Block 

selection 
Item Details 

4001 

Category Basic operator 

Function block Hold 

Symbol 

 Parameter 1: Upper limit value 

 Input 1 

 

Output  

 Input 2 

 Parameter 2: Lower limit value 

Description 

Turning OFF Input 2 (logical value) outputs Input 1 as-is. 

Turning ON Input 2 (logical value) holds the output value. 

The output is limited by the upper and lower limit values assigned to Parameter 1 

and Parameter 2. 

For more information on the limit operation, refer to "2005: Limiter". 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: The previous output value is output. 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Upper limit value: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Lower limit value: -9990 to +9990 (significant digits: 3 digits) 

 

4002: Inverse addition switchover 

Block 

selection 
Item Details 

4002 

Category Basic operator 

Function block Inverse addition switchover 

Symbol 

 Parameter 1: Offset  

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Bias  

Description 

Turning OFF Input 2 (logical value) outputs Input 1 as-is. 

Turning ON Input 2 (logical value) outputs the calculation result of the expression 

indicated in the "Calculation" field below. 

This is similar to the function block "inverse addition (2007)". For information on 

the inverse addition, refer to "2007: Inverse addition" in "[Analog] - Basic 

Operator". 

Calculation Output when Input 2 is ON = -(Input 1 - Parameter 1) + Parameter 2 

Input 1 Numeric value: -9990 to +9990 

Input 2 

Logical value: OFF: Input 1 is output. 

 ON: Outputs the calculation result of the expression indicated in 

the "Calculation" field above. 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 
Parameter 1: Offset: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Bias: -9990 to +9990 (significant digits: 3 digits) 
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4005: Low pass filter 

Block 

selection 
Item Details 

4005 

Category Basic operator 

Function block Low pass filter 

Symbol 

 Parameter 1: Time constant [s] 

 Input 1 

 

Output  
 Input 2 

  

Description 

Turning OFF Input 2 outputs Input 1 as-is. 

Turning ON Input 2 outputs Input 1 after applying a low pass filter to it. 

The low pass filter calculation uses the previous output value. When Input 2 

changes from OFF to ON, the previous output value is the output value before the 

low pass filter is applied. The previous output value is '0' when the customizable 

logic is started or the CLC terminal is turned ON. 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: Outputs Input 1 after applying a low pass filter to it. 

Output Numeric value: -9990 to +9990 

Property settings Parameter 1: Time constant: 0.01 to 5.00 [s] (A value of 0.00 disables the filter.) 
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4006: Change rate limit 

Block 

selection 
Item Details 

4006 

Category Basic operator 

Function block Change rate limit 

Symbol 

 Parameter 1: Rise time [s] 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Fall time [s] 

Explanation 

The change rate limit function block limits the change amount per unit time of 

Input 1. 

You can also set the limit value by specifying the time for Input 1 to change from 0 

to 100. You can specify the limit values separately for the rise amount and the fall 

amount. 

Turning OFF Input 2 outputs Input 1 as-is. 

Turning ON Input 2 outputs Input 1 after applying the change rate limit to it. 

The change rate limit calculation uses the previous output value. When Input 2 

changes from OFF to ON, the previous output value is the output value before the 

change rate limit is applied. The previous output value is '0' when the 

customizable logic is started or the CLC terminal is turned ON. 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: Outputs Input 1 after applying the change rate limit to it. 

Output Numeric value: -9990 to +9990 

Property settings 

Parameter 1: Rise time: Time for Input 1 to change from 0 to 100 

0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, no limit is 

applied.) 

Parameter 2: Fall time: Time for Input 1 to change from 0 to 100 

0.01 to 600 [s] (significant digits: 3 digits) (When set to 0, the same 

time as Parameter 1 is used.) 
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6101: PID dancer output gain frequency 

Block 

selection 
Item Details 

6101 

Category Basic operator 

Function block PID dancer output gain frequency 

Symbol 

 Parameter 1: Gain ratio [%] 

 Input 1 

 

Output  
 Input 2 

 Parameter 2: Frequency lower limit value [Hz] 

Description 

This function block is used in the dancer control PID. 

You can select whether to calculate the frequency correction amount by assuming 

that the 100% of the PID output is equivalent to the maximum output frequency or 

the commanded frequency (by the line speed command). 

Setting Input 1 to 0 outputs 0. 

Setting Input 1 to a non-zero value outputs the value calculated using the 

expression indicated in the "Calculation" field. 

The output is intended for use in monitoring. 

If the dancer control is enabled (i.e., function code J01 is set to 3), the function 

block calculates the frequency correction amount using the expression indicated 

in the "Calculation" field below and reflects it to the output frequency. 

The maximum number of steps that can be used is one. If you use two or more 

instances of PID dancer output gain frequency (6101), the one with the smallest 

step number takes precedence. 

Function 1

Input 2

×

Output

Set frequency 

[Hz]

ON

OFF

≠0

＝ 0

0

Input 1

＝ 0

≠0×

Function 2

Maximum output 

frequency

[Hz]

+

×

+

0.01

×
PID output

[%]

0.01

Output 
frequency

[Hz]

 

Turns ON when dancer 

control is enabled

 

Calculation 

Output 

Input 1 
Input 2 

Parameter 

1 
Output 

0 OFF/ON Not used 0 

Non-zero 

OFF Not used If set frequency is equal to or more than 

Parameter 2, the set frequency is 

output. 

If the set frequency is less than 

Parameter 2, Parameter 2 is output. ON 

0 

Non-zero frequency output Maximum
100

 1 Function
  

Output
100

[%] output PID
= amount correctionFrequency   

Output frequency  Set frequency   Frequency correction amount 
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Block 

selection 
Item Details 

6101 

Input 1 
Numeric value: If set to 0, 0 is output. 

 If set to a non-zero value, the calculation is performed. 

Input 2 

Logical value: OFF: Calculates the frequency correction amount from the set 

frequency. 

 ON: If Parameter 1 is 0, same as OFF. 

  If Parameter 1 is non-zero, the function block calculates the 

frequency correction amount from the maximum output 

frequency.  

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Gain ratio: 0 to 200 [%] 

Parameter 2: Frequency lower limit value: 0 to 500 [Hz] 
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2.3.3.18.9. [Digital + Analog] - Selector 

Selector 

4003: Selection 1 

Block 

selection 
Item Details 

4003 

Category Selector 

Function block Selection 1 

Symbol 

 Parameter 1: Value output when the Input 2 is ON 

 Input 1 

 

Output  

 Input 2 

   

Description 
Turning OFF Input 2 outputs Input 1 as-is. 

Turning ON Input 2 outputs Parameter 1. 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: Parameter 1 is output. 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3 

digits) 

 

4004: Selection 2 

Block 

selection 
Item Details 

4004 

Category Selector 

Function block Selection 2 

Symbol 

 Parameter 1: Value output when the Input 2 is OFF 

 Input 

 

Output  

 Parameter 2: Value output when the Input 2 is ON 

Explanation 
Turning OFF Input 2 (logical value) outputs Parameter 1. 

Turning ON Input 2 (logical value) outputs Parameter 2. 

Input 
Logical value: OFF: Parameter 1 is output. 

 ON: Parameter 2 is output. 

Output Numeric value: -9990 to +9990 

Property settings 
Parameter 1: Value output when Input 2 is OFF: -9990 to +9990 (significant digits: 3 digits) 

Parameter 2: Value output when Input 2 is ON: -9990 to +9990 (significant digits: 3 digits) 
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5001 to 5014: Selection 3-1 to 3-14 

Block 

selection 
Item Details 

5001 

to 

5014 

Category Selector 

Function block Selection 3-1 to 3-14 

Symbol 

[Example in 5001]   

 Input 1 

 

Output  

 Input 2 

   

Description 

Turning OFF the output (SOxx) with step number xx (where xx is 1, 2,..., 14) 

outputs Input 1. 

Turning ON the output (SOxx) outputs Input 2. 

The output (SOxx) must be a logical value. 

SO01 to SO14 Logical value: OFF: Input 1 is output. 

 ON: Input 2 is output. 
 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings Not used 

 

5101 to 5114: Selection 4-1 to 4-14 

Block 

selection 
Item Details 

5101 

to 

5114 

Category Selector 

Function block Selection 4-1 to 4-14 

Symbol 

[Example in 5001]   

 Input 1 

 

Output  

 Input 2 

   

Description 

Turning OFF Input 2 outputs Input 1. 

Turning ON Input 2 outputs the output (SOxx) with step number xx (where xx is 1, 

2,..., 14). 

The output (SOxx) must be a numeric value. 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: The output (SOxx) is output. 

Output Numeric value: -9990 to +9990 

Property settings Not used 
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5000: Selection 3 

Block 

selection 
Item Details 

5000 

Category Selector 

Function block Selection 3 

Symbol 

 Parameter 1: Step number 

 Input 1 

 

Output   Input 2 

 Input 3: Function 

block output 

   

Description 

Input 3 accepts the connection of the output of a function block (a symbol that 

allows step number assignment). You cannot connect an input terminal directly to 

it. 

Turning OFF Input 3 outputs Input 1. 

Turning ON Input 3 outputs Input 2. 

Input 3 must be a logical value. 

If Input 3 is not connected, the function block uses the output (SOxx) with step 

number xx specified in Parameter 1 instead of Input 3. 

If you connect Input 3, performing the auto step number assignment overwrites 

Parameter 1 with the step number specified by Input 3. 

Input 1 Numeric value: -9990 to +9990 

Input 2 Numeric value: -9990 to +9990 

Input 3 
Logical value: OFF: Input 1 is output. 

 ON: Input 2 is output. 

Output Numeric value: -9990 to +9990 

Property settings Parameter 1: Step number: 1 to maximum step number 
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5100: Selection 4 

Block 

selection 
Item Details 

5100 

Category Selector 

Function block Selection 4 

Symbol 

 Parameter 1: Step number 

 Input 1 

 

Output   Input 2 

 Input 3: Function 

block output 

   

Description 

Input 3 accepts the connection of the output of a function block (a symbol that 

allows step number assignment). You cannot connect an input terminal directly to 

it. 

Turning OFF Input 2 outputs Input 1. 

Turning ON Input 2 outputs Input 3. 

Input 3 must be a numeric value. 

If Input 3 is not connected, the function block uses the output (SOxx) with step 

number xx specified in Parameter 1 instead of Input 3. 

If you connect Input 3, performing the auto step number assignment overwrites 

Parameter 1 with the step number specified by Input 3. 

Input 1 Numeric value: -9990 to +9990 

Input 2 
Logical value: OFF: Input 1 is output. 

 ON: Input 3 is output. 

Input 3 Numeric value: -9990 to +9990 

Output Numeric value: -9990 to +9990 

Property settings Parameter 1: Step number: 1 to maximum step number 
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2.3.3.18.10. [Digital + Analog] - Function Code 

Function Code 

6001: Function code read 

Block 

selection 
Item Details 

6001 

Category Function Code 

Function block Function code read 

Symbol 

 Parameter 1: Function code group 

 

 

Output  

 Parameter 2: Function code number 

Description 

This function block outputs the function code data specified by Parameter 1 and 

Parameter 2. 

It can correctly read out the following data formats: 

[1], [2], [3], [4], [5], [6], [7], [8], [9], [10], 

[12], [22], [24], [29], [35], [37], [45], [61], 

[67], [68], [74], [92], [93] 

However, the value is limited within the range of -9990 to 9990. In addition, for 

[29], the function block displays 20000 as 100%. 

Do not use any other data format than above because the function block cannot 

correctly read other formats. 

If an attempt is made to read out a non-existent function code, the output will be 0. 

For more information on the data formats, refer to Chapter 5 of the Appendix " 

RS-485 Communication User's Manual". 

Alternatively, you can refer to the data format for each function code on the 

[Function code edit] window accessible from the [Function Code List] window. For 

more information on [Function code edit], refer to "2.3.1.1. Function Code Edit". 

Input None 

Output Numeric value: -9990 to +9990 (limit value: ±9990) 

Property settings 
Parameter 1: Function code group 

Parameter 2: Function code number: 00 to 99 
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6002: Function code write 

Block 

selection 
Item Details 

6002 

Category Function Code 

Function block Function code write 

Symbol 

 Parameter 1: Fixed to function code group U1 

 Input 1 

 

 
 Input 2 

 Parameter 2: Function code number 

Description 

Select the function code you want to write to, using Parameter 1 and Parameter 2. 

You can select function codes U171-. The written value is retained even if the 

power is turned off. 

Turning ON Input 2 writes Input 1 to the selected function code. 

If Input 2 is OFF, nothing is written. 

The values written to function codes U171- are stored in the volatile memory 

(RAM) and, once the inverter detects low voltage, stored in the non-volatile 

memory (EEPROM). 

The maximum number of steps that can be used is one per function code. 

If you use two or more instances of function code write (6002), the one with the 

smallest step number takes precedence. 

When you perform the auto step number assignment, a warning that states 

"Output 1 for function code write is not connected" appears but you can ignore it 

safely. 

Input 1 Numeric value: -9990 to +9990 

Input 2 

Logical value: OFF: Nothing is written. 

 ON: Input 1 is written to the function code selected by 

Parameter 1 and Parameter 2. 

Output None 

Property settings 
Parameter 1: Function code group: U1 

Parameter 2: Function code number: 71 to 75 
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6003: function code change 

Block 

selection 
Item Details 

6003 

Category Function Code 

Function block Function code change 

Symbol 

 Parameter 1: Function code group 

 Input 1 

 

 
 Input 2 

 Parameter 2: Function code number 

Description 

Select the function code whose setting you want to change, using Parameter 1 

and Parameter 2. 

Turning ON Input 2 changes the setting of the selected function code to Input 1. 

However, this does not change the setting stored in the non-volatile memory 

(EEPROM). 

Turning OFF Input 2 restores the original setting of the selected function code. 

The maximum number of steps that can be used is one per function code. 

If you use two or more instances of function code change (6003) for the same 

function code, the one with the smallest step number takes precedence. 

Before reading and writing function codes from the loader or copying them to the 

keypad, be sure to restore the original setting of the selected function code by 

turning OFF Input 2. 

If you use the function code change (6003) function block to change the setting of 

a function code and then load the setting into the loader or copy it to the keypad, 

the data that is being changed is read, rather than the data stored in the 

non-volatile memory. Moreover, if you select [Write 2 to y97] and write the data 

from the loader, the data that is being changed by the function code change 

(6003) function block is stored in the non-volatile memory. 

Before stopping the customizable logic, you are recommended to turn OFF Input 

2. 

Stopping the customizable logic with Input 2 still ON retains the data that is being 

changed by the function code change (6003) function block. To restore the 

original setting from this state, you must (1) start the customizable logic and turn 

OFF Input 2, (2) turn off the power to the inverter, or (3) restore the original setting 

using a keypad, etc. 

Input 1 Numeric value: -9990 to +9990 

Input 2 

Logical value: OFF: Nothing is written. 

 ON: Input 1 is written to the function code specified by 

Parameter 1 and Parameter 2. 

Output None 

Property settings 
Parameter 1: Function code group 

Parameter 2: Function code number 

 

  



 

 

 2-156 

Bit Extraction 

6011: Bit extraction [S] 

Block 

selection 
Item Details 

6011 

Category Bit Extraction 

Function block Bit extraction [S] 

Symbol 

 Parameter 1: Function code number  

 

 

Output  

 Parameter 2: Bit position 

Description 

This function block outputs the bit information of the communication function code 

(S code) specified by Parameter 1 and 2. 

It can correctly read out the following data formats: 

[14], [15], [16], [43], [44], [77], [78], [91] 

Do not use any other data format than above because the function block cannot 

correctly read other formats. 

If an attempt is made to read out a non-existent function code, the output will be 0. 

For more information on the data formats, refer to Chapter 5 of the Appendix " 

RS-485 Communication User's Manual". 

Alternatively, you can refer to the data format for each function code on the 

[Function code edit] window accessible from the [Function Code List] window. For 

more information on [Function code edit], refer to "2.3.1.1. Function Code Edit". 

Input None 

Output Logical value 

Property settings 
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point) 

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point) 

 

6012: Bit extraction [M] 

Block 

selection 
Item Details 

6012 

Category Bit Extraction 

Function block Bit extraction [M] 

Symbol 

 Parameter 1: Function code number  

 

 

Output  

 Parameter 2: Bit position 

Description 

This function block outputs the bit information of the communication function code 

(M code) specified by Parameter 1 and 2. 

See “6011: Bit extraction [S]” for other operations. 

Input None 

Output Logical value 

Property settings 
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point) 

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point) 
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6013: Bit extraction [W] 

Block 

selection 
Item Details 

6013 

Category Bit Extraction 

Function block Bit extraction [W] 

Symbol 

 Parameter 1: Function code number  

 

 

Output  

 Parameter 2: Bit position 

Description 

This function block outputs the bit information of the communication function code 

(W code) specified by Parameter 1 and 2. 

See “6011: Bit extraction [S]” for other operations. 

Input None 

Output Logical value 

Property settings 
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point) 

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point) 

 

6014: Bit extraction [X] 

Block 

selection 
Item Details 

6014 

Category Bit Extraction 

Function block Bit extraction [X] 

Symbol 

 Parameter 1: Function code number  

 

 

Output  

 Parameter 2: Bit position 

Description 

This function block outputs the bit information of the communication function code 

(X code) specified by Parameter 1 and 2. 

See “6011: Bit extraction [S]” for other operations. 

Input None 

Output Logical value 

Property settings 
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point) 

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point) 
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6015: Bit extraction [M] 

Block 

selection 
Item Details 

6015 

Category Bit Extraction 

Function block Bit extraction [Z] 

Symbol 

 Parameter 1: Function code number  

 

 

Output  

 Parameter 2: Bit position 

Description 

This function block outputs the bit information of the communication function code 

(Z code) specified by Parameter 1 and 2. 

See “6011: Bit extraction [S]” for other operations. 

Input None 

Output Logical value 

Property settings 
Parameter 1: Function code number: 0 to 99 (Truncate after the decimal point) 

Parameter 2: Bit position to be read: 0 to 15 (Truncate after the decimal point) 
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2.3.4. Trace 

Trace function 

You can observe the inverter operation status as continuous waveform information.  

The loader provides the following three types of the trace function: 

(1) Realtime trace: Reads the sequential waveform data from the inverter and displays it 

in a graph. This is suitable for long-time monitoring. 

(2) Historical trace: Reads the waveform data of the inverter operation status based on an 

arbitrary trigger saved in the inverter's memory and displays it in a 

graph. This is suitable for monitoring with small sampling times. 

 

 
 The Realtime trace and Historical trace can be used when communication with the 

inverter is possible. 

 

 

 

 

Offline setting function 

When the loader cannot communicate with the inverter to be traced, you cannot use the trace 

function but you can configure the advanced waveform settings. This is useful when you want to 

prepare the trace settings in advance. 
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2.3.4.1. Trace Function 

Select [Menu] > [Trace] from the main menu or click  on the main window toolbar and 

then click [Real-Time Trace], [Historical Trace], or [Trace back] to open the corresponding 

trace function window.  

  
  

 

[Select Online/Offline] window is displayed first. 

 

Select [Online], then select [Target Inverter] 

in the dropdown list. 

Click [OK]. 

 

Then the trace window (see “2.3.4.2.Realtime Trace”, “2.3.4.3.Historical Trace”) is displayed. 

 

 
 For the [Target Inverter], the model registered in [Connection Settings] (see 

“1.5.5.2.Connection Setting”) is displayed. 

 Select an inverter that can communicate with the loader in the [Target Inverter]. If 

communication is not established, an error is displayed and the trace window is not 

displayed. 
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2.3.4.2. Realtime Trace 

The following is the description of the [Realtime Trace] window. 
 
Subwindow 

- [Monitor], [Graph position adjustment], and 
[File information] tabs 
(Refer to "2.3.4.7. Subwindow") 

Click this button to save the trace data 

(Refer to "2.3.4.4. Saving the Trace Data") 

Click this button to copy the waveform monitor 

(Refer to "2.3.4.5. Copying the Trace Data Screen") 
The trace operation status is displayed  

Click this button to start/stop the trace operation  

Display time frame and sampling time 

Cursor position  Cursor setting and position display 

The position is displayed only when "vertical" 
is selected.  
(Refer to "2.3.4.7. [1] Cursor") 

Trace type is displayed 

Show/hide the 
subwindow 

 

Scrollbar for moving the vertical cursor 

 

[Setting] 

Click this button to 
import/export the 
settings.  
(Refer to "2.3.4.9. 
Setting Export/Setting 
Import") 

 Waveform screen Cursor A Cursor B Waveform  
screen vertical 
scrollbar 

Scrollbar for moving the horizontal cursor 

Advanced waveform settings 

Advanced settings for each channel.  
(Refer to "2.3.4.8. Advanced Waveform 
Settings") 

 Waveform screen 
horizontal scrollbar 

External signal import 

Click this button to import the customizable logic trace data. This button appears once you save the trace monitor 
information.  
(Refer to "2.3.4.10. Combination with the Customizable Logic Function") 

 

 
 The realtime trace works even if without a trigger setting. 
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2.3.4.3. Historical Trace 

The following is the description of the [Historical Trace] window. 

 
Subwindow 

- [Monitor], [Graph position adjustment], and 
[File information] tabs 
(Refer to "2.3.4.7. Subwindow") 

Click this button to save the trace data 

(Refer to "2.3.4.4. Saving the Trace Data") 

Click this button to copy the waveform monitor 

(Refer to "2.3.4.5. Copying the Trace Data Screen") 
The trace operation status is displayed 

 
Click this button to start/stop the trace operation 

 
Display time frame and sampling time 

Cursor position  Cursor setting and position display 

The position is displayed only when "vertical" 
is selected.  
(Refer to "2.3.4.7. [1] Cursor") 

Trace type is displayed 

Show/hide the 
subwindow 

 

Scrollbar for moving the vertical cursor 

 

[Setting] 

Click this button to 
import/export the 
settings.  
(Refer to "2.3.4.9. 
Setting Export/Setting 
Import") 

 Waveform screen Cursor A Cursor B Waveform  

screen vertical 

scrollbar Scrollbar for moving the horizontal cursor 

Advanced waveform settings 

Advanced settings for each channel.  
(Refer to "2.3.4.8. Advanced Waveform 
Settings") 

 Waveform screen horizontal 

scrollbar 

 

 
 To use the historical trace, you must configure the trigger settings. For 

information on trigger settings, refer to "2.3.4.8. [2] A-Ch1 to A-Ch4 (analog 

settings)" and "2.3.4.8. [3] D-Ch1 to D-Ch8 (digital settings)". 
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2.3.4.4. Saving the Trace Data 

To save the trace data, click the [Save] button around the top center of the trace or select [File] 

-> [Save As...]. 

 

When selecting [Save] for the data for the first time, the following dialog will open in the same 

manner as when selecting [Save As …]. Select [Save to ...] and [Save as type] and enter the file 

name under which the data is saved in [File Name]. Then click [Save] to save the file.  

 

- Realtime trace waveform information:  *.RT2, *.CSV (comma separated format) 

- Historical trace waveform information:  *.HT2, *.CSV (comma separated format) 

- Each trace graph image:  *.JPG, *.BMP 

 

 
 Once you save a *.CSV, *.JPG, or *.BMP file, you cannot reload it into The 

Loader. 

 

 
 Opening a saved *.RT2, *.HT2, trace data file in Doesa-Loader makes the 

[START/STOP] button unavailable.  

If you plan to run the trace with the same settings as the saved trace data, save 

the settings by selecting [Setting] -> [Setting Export]. For more information on 

[Setting Export], refer to "2.3.4.9. Setting Export/Setting Import". 
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2.3.4.5. Copying the Trace Data Screen 

To copy the content of the trace data screen, click the [Copy] button around the top center of the 

trace screen. The data is copied to the clipboard, from which you can paste the data to a 

document or elsewhere. 

 

 

 

 

2.3.4.6. Printing the Trace Data 

To print the trace data, select [File] -> [Print] with the trace screen active. The following is an 

example printout of trace data: 
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2.3.4.7. Subwindow 

[1] Cursor 

The boxes on the cursor subwindow display the measurement value or status of each channel at 

the respective cursor positions. 

 
Cursor value monitoring area 

Analog: 4 channels 

Digital: 8 channels 

Channels not visible in the monitoring area can be 

displayed using the vertical slides bar at the cursor 

value monitoring area. 

Cursor settings 

Vertical: 2 (either cursor A or cursor B or both) 

Horizontal: 2 (either cursor A or cursor B or both) 

Hide 

 Analog channel 

cursor value 

Show/hide the 
subwindow 

Slides bar for moving 
the vertical cursor 

 

Digital channel 

cursor value 

Cursor value 

monitoring area 

vertical slides bar 

Cursor A Cursor B Waveform screen 

horizontal scrollbar 

 

Use the scroll bar to move to the waveform screen to be analyzed and click the point to be 

observed in the graph. The cursor will move to that position. The cursor movement position is 

the sampling point (time point) closest to the clicked point. The trace data of all channels on the 

cursor appears on the [Monitor] tab at left. 

Alternatively, you can move the cursor using the cursor movement scrollbar or by dragging the 

mouse.  

The cursor keys on the keyboard are also available.  

However, while tracing, neither waveform screen nor cursor can be moved. 
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[2] Adjust Graph Position 

The graph position adjustment subwindow allows you to adjust the graph position for each 

channel. 

 

Select Channel 

Select the channel for which you want to adjust the 

graph position and color. 

Display 

Display only the channels you have marked with  . 

Y axis display position 

Set the Y axis display position of the selected channel.  

The upper edge is position 0. 

X axis display position 

Set the X axis display position of the selected channel.  

The left edge is position 0. 

Amplitude 

Set the amplitude of the selected channel by 

magnification.  

Change the magnification using point 0 for reference. 

As you change the amplitude, the [Scale] value 

changes accordingly and the graph display also 

changes according to the [Scale] value. 

Scale 

Set the scale of the selected channel.  

Enter the numeric value per DIV for the Y axis.  

This setting applies to the analog setting channels 

only. 

Graph position reset 

Reset the display position and amplitude setting of the selected channel to the initial values.  

- Y axis display position:  Ch1 = 50 and the value increments by +50 for the subsequent channels.  

- X axis display position:  Each Channel = 0   

- Amplitude: 1.00 

Optimize Y axis graph 

Arrange the Y axis display position and scale of the displayed channels without overlapping by channel.  

Reset the amplitude setting to the initial value. 

- Y axis display position:  Ch1 = 100 and the value increments by +100 (analog) or +50 (digital) for subsequent 

channels. 

- Scale:  Set the scale value based on the multiple of 50 so that the maximum value can be within 

two grids.  

For example, 50Hz/DIV if the maximum value is 1Hz or 100Hz/DIV if the maximum value 

is 53Hz. 

Detect waveform peak 

Move Cursor A to the maximum value of the selected channel automatically. If there are two or more peaks, the cursor 

moves to the earliest one.  

This setting applies to the analog setting channels only. 

Display range in one DIV 

Set the time to be displayed in one DIV for the X axis on the waveform screen. 

Historical trace and Trace back: 1 ms to 10 min 

Realtime trace: 20 ms to 60 min 

You cannot specify a time smaller than the sampling time. 

Number of grid auxiliary lines 

Set the number of grid auxiliary lines for the Y axis. 
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Color setting 

The color setting data is held. Once you obtain the waveform, you can change the color setting. 

 

Channel line 

Select the line color, type, thickness for the selected channel. 

Cursor line A 

Select the line color, type, thickness for Cursor A. 

Cursor line B 

Select the line color, type, thickness for Cursor B. 

Trigger line 

Select the line color, type, and thickness of the trigger line. 

Grid line 

Select the line color, type, and thickness of the grid line. 

Graph background color setting 

Select the waveform monitor background color. 

The line color, type, and thickness settings are as follows: 

- Color 

 

 

 

- Line type 

 

- Line thickness 

 

 

 

 

  



 

 

 2-168 

[3] File Information 

The file information subwindow displays the date/time information for the trace. Also, you can 

add a comment. 

The date/time information uses the clock managed by the operating system of the PC. Even if 

you trace an inverter model that has a realtime clock (RTC), the loader uses the clock managed 

by the operating system of the PC. 

The content of the file information subwindow is saved to trace data files (RT2 and HT2 files). 

When you open a saved file, the information contained in it is displayed. The content of this 

subwindow is not contained in a file saved by selecting [Setting] -> [Setting Export] (i.e., an 

EXRTM or EXHIM file). 

The content of the file information subwindow is included in the printout of a waveform. 

 

Refresh 

Click this button to update the time information (such 

as the trace start date) displayed in the file 

information subwindow.  

When you start the trace with the file information 

subwindow open, its display content will not be 

automatically updated. It will be updated when you 

click the [Refresh] button or open a different 

subwindow. 

Trace start date 

The date when the trace was started. 

Trace start time 

The time when the trace was started. 

Trigger detection date 

The date when a trigger was detected. 

Trigger detection time 

The time when a trigger was detected. 

Comment 

You can add a comment. 
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[4] Data selection 

The data selection subwindow allows you to select, read, and erase the trace back data. 

 

Select Trace-back Data 

Select the trace back data number to be checked. 

Reload 

Click this button to get the list of traceback data 

stored on the connected keypad. After received data 

list properly, the trace back data drop-down list will 

be updated. 

Trace back information 

Displays additional information such as inverter 

status and trace conditions related to the traceback 

data selected in the drop-down list. 

 

Read waveform 

Click this button to read the waveform of the 

traceback data selected in the drop-down list and 

display it on the waveform screen. 

Erase data 

Click this button to erase the trace back data 

selected in the drop-down list from the connected 

keypad. 
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2.3.4.8. Advanced Waveform Settings 

[1] Channel Configuration 

You can set the configuration of analog channels and digital channels to be traced. For more 

information on the settings for each channel, refer to [2] to [5]. 

The loader stores in memory the settings for each inverter model. One you open the [Realtime 

Trace] or [Historical Trace] window, the [Advanced settings] window displays the previous 

settings for the inverter model you want to trace this time. 

In the [Traceback] window, the [Advance settings] window displays the settings of the currently 

connected inverter. If the target inverter is not connected, the previous settings will be displayed. 

 

Ch configuration settings 

Select the number of channels you want to use.  

The number of analog channels can be up top 4, and the total number of analog and digital channels can be up to 8.  

However, if you select 4 analog channels, then you cannot select digital channels. 

 

 

[Select inverter] 

Displays the inverter selected in the [Select Online/Offline] window (see [2.3.4.1.Trace Function]).  

You can trace only the inverter displayed here. 
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[2] A-Ch1 to A-Ch4 (analog settings) 

You can configure analog channel settings. 

 

 

Signal 

From the list box, select the signal you want to trace. You can select, for example, the output 

frequency, the output current, or the output voltage. (Available signals differ depending on the 

inverter model.) 

 

Alternative name 

You can assign an alternative name to the signal.  

Once you assign an alternative name, that name appears in the waveform screen and 

subwindow.  

You cannot use single-byte @, #, and \ characters. 
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Filter 

The filter settings for each channel are as follows: 

 

OFF 

Select this if you do not want to use a filter. 

 

Manual filter 

Traces the data after a low pass filter is applied. 

Select the filter time constant from the list box below. 

 

Peak filter 

Traces the maximum value within the sampling time. 

 

Auto filter 

Traces the data after a low pass filter is applied.  

The filter time constant is given by the following expression: 

Filter time constant = Sampling time x 3.2 

 

Filter time constant 

Select the filter time constant when you use the manual filter.  

The valid range is 1 [ms] to 100 [ms]. 

 

 
 The filter time constant should be at least twice the sampling time. 

 

 
 To use a filter for the realtime trace, the dedicated communication command 

must be supported by the inverter model. For more information, refer to "Table 

1-1" in "1.1.2. Loader Functions by VF1A Series Inverter Model". 
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Trigger 

The trigger settings for each channel are as follows: 

 

Trigger setting 

Select the channel for which you want to configure a trigger.  

An analog channel accepts only one trigger. 

 

Trigger level 

Select the appropriate trigger level depending on the data quantity handled 

for the monitor item selected for each channel. 

 

Trigger edge 

Select the trigger rise or fall edge. 

 

 
 To use a trigger for the realtime trace, the dedicated communication command 

must be supported by the inverter model. For more information, refer to "Table 

1-1" in "1.1.2. Loader Functions by VF1A Series Inverter Model". 

 

  



 

 

 2-174 

[3] D-Ch1 to D-Ch8 (digital settings) 

You can configure digital channel settings. 

 

 

Select signal 

From the list box, select the signal you want to trace. You can select, for example, the X or Y 

terminal. (Available signals differ depending on the inverter model.) 

 

Alternative name 

You can assign an alternative name to the signal.  

Once you assign an alternative name, that name appears in the waveform screen and 

subwindow. 

You cannot use single-byte @, #, and \ characters. 

 

Trigger setting 

The trigger settings for each channel are as follows: 

 

Trigger setting 

Select one of the following: Low (L) level, Hi (H) level, Up edge, Down edge. 

 

A digital channel accepts one or more trigger settings. 

You can specify triggers with the "OR" or "AND" condition. 

 

* Refer to "Trigger detection conditions" in "[5] Other Settings". 
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 To use a trigger for the realtime trace, the dedicated communication command 

must be supported by the inverter model. For more information, refer to "Table 

1-1" in "1.1.2. Loader Functions by VF1A Series Inverter Model". 

 
 

[4] Ch Setting Check (analog/digital) 

The data configured for each channel is listed. To save the settings, click the [OK] button. To 

cancel the settings, click the [Cancel] button. 
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[5] Other Settings (including sampling time setting) 

Configure the advanced settings for the waveform monitor. 

 

 

Sampling time setting 

The following sampling time settings are 

available. 

 
 

Sampling 

time 

setting 

Realtime 

Historical 

/ 

Trace back 

When using the dedicated communication command (*) When not using the 

dedicated 

communication 

command 

If the port specified in 

[Communication Setting] is 

RS-485 connected 

If the port specified in 

[Communication Setting] is 

USB connected 

0.5 ms    △ 

1 ms     

2 ms △ (note) △ (note)   

5 ms △ (note) △ (note)   

10 ms  (note)  (note)   

20 ms  (note)  (note)   

50 ms  (note)  (note)   

100 ms     

200 ms     

: Selectable △: Selectable depending on the inverter model : Not selectable 
 
(*) You can only use the dedicated communication command with an inverter model that 

supports it. 
 

 
 When using the realtime trace with a small sampling time, the graph display may 

be incomplete if the communication speed is insufficient. 

Please increase the communication speed as much as possible. 
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Pre-trigger position 

Set the number of sampling points of data preceding the trigger position. 

 

The setting can be up to 999 counts for the realtime trace or up to 499 counts for the historical 

trace. 

 

Trigger detection conditions 

Configure two or more trigger detection conditions for digital channels with the "OR" or "AND" 

condition. 

Analog: 1 channel only  

Digital: 1 to 8 channels 

 
 

 
 To configure the sampling time setting, pre-trigger position, and trigger detection 

conditions for the realtime trace, you have to check the [Enable buffering trace 

command] check box on the [Advanced waveform settings] -> [Other settings] 

window. 
 

Enable buffering trace command 

Check this check box to have the realtime trace use the data buffered in the inverter's memory. 

 

 
 This setting is not available for the historical trace and the trace back. 

 The dedicated communication command must be supported by the inverter 

model. For more information, refer to "Table 1-1" in "1.1.2. Loader Functions by 

VF1A Series Inverter Model". 

 If the dedicated communication command is supported by the inverter model 

connected, this check box is enabled automatically, and cannot be unchecked. 
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Trace start time and date 

Set the date/time when to start the trace. 

 

 

Auto Save 

Use this setting if you want to have the trace data automatically saved. 

 

 

The data is automatically saved: 

 When you stop the realtime trace by clicking [START/STOP]. 

 When the accumulated trace data becomes more than can be written to the specified 

number of split files during the realtime trace. 

 When the size of all split files exceeds the total file size during the realtime trace. 

 After the historical trace waveform has been drawn. 

 

File size of saving (available for the realtime trace only) 

This setting is available if the trace auto save check box is checked. 

 

Divide saving file 

Currently this check box is 

always checked.  

Split files are always saved. 

 

Sampling count of one file 

This represents approximate data counts per channel saved in one file. This setting is fixed to 7500 counts.  

For example, if the sampling time is 20 ms, one file contains the data from 0 ms to approximately 150,000 ms 

(= 7500 x 20 ms). 

 

Total file size 

Specify the total file size in MB. If the size of all saved files exceeds this size, the realtime trace is stopped and 

no more files are saved 
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The file name of a split file is the file name specified under [Auto Save] suffixed by a serial 

number such as _1, _2, _3 before the file name extension. 

For example, if the file name specified under [Auto Save] is "Realtime_Trace.RT2", the names of 

the split files will be 

"Realtime_Trace-1.RT2", 

"Realtime_Trace-2.RT2", 

"Realtime_Trace-3.RT2", 

and so on. 

When the size of all split files exceeds the total file 

size, the dialog at right appears and the realtime 

trace is stopped. 
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2.3.4.9. Setting Export/Setting Import 

With VFD Doesa-Loader, you cannot open saved trace data files with an extension of *.RT2, 

*.HT2 and run the trace. 

To run the trace with the same settings as the saved trace data, you should follow these steps: 

Step 1: When you save the trace data, save the settings separately from the trace data by 

using the [Setting Export] function. 

Step 2: When you run the trace, first open the same trace screen as step 1 with the loader 

connected to the inverter you want to trace. 

Step 3: Load the settings by using the [Setting Import] function. 

To use [Setting Export] and [Setting Import], click the 

[Setting] button under the [Advanced Waveform Settings] 

button. 

 

The [Settings] window appears. 

 

 
 

Setting Export 

Saves the advanced waveform settings to a file.  

Click this button to open the [Save As...] dialog.  

Setting Import 

Loads the advanced waveform settings from a file.  

Click this button to open the [Open] dialog. 

Cancel 

Click this button to close the [Settings] dialog.  

 

File types 

*.EXRTM: Realtime trace format. You can import these files only when working with the 

[Realtime Trace] window. 

*.EXHIM: Historical trace format. You can import these files only when working with the 

[Historical Trace] window. 

*.EXTBM: Trace back format. You can import these files only when working with the [Trace 

back] window. 

The inverter model must match the currently selected one on the trace window. If it does not 

match, a warning dialog displays, then it blocks to import settings. 
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2.3.4.10. Combination with the Customizable Logic Function 

After writing your created settings for the customizable logic function to the inverter or if the 

comparison result shows no difference, you can monitor your selected symbol using the 

realtime trace. 

 
 A limited set of functions is available with some inverter models. Refer to "1.1.2. 

Loader Functions by VF1A Series Inverter Model" for details. 

 

[1] How to Monitor a Customizable Logic Signal Using the Realtime Trace 

The following is the basic procedure for monitoring a customizable logic signal using the 

realtime trace: 

 

 

 

  

 

 

 

 

 

START 

END 

Select the trace monitor 

Save trace monitor file 

 Write the circuits to the 

inverter 

 External signal import 

 Advanced waveform settings 

 Start the realtime trace 

 Start the customizable logic 

function 

 

Use the customizable logic 

editor screen 

 

Use the [Realtime Trace] 

window 

(Refer to Section 

2.3.3.9) 

(Described in 

this section) 

(Described in 

this section) 

(Described in 

this section) 

(Described in this 

section. Also refer to 

Section 2.3.4.8.) 

(Refer to Section 

2.3.4.2.) 
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- Selecting the Trace Monitor 

On the customizable logic editor screen, right-click the symbol whose waveform you want to 

monitor.  

Select [Trace monitor select] on the context menu.  

 

 

 
 [Trace monitor select] is applicable to a function block only. It is not applicable to 

an input or output terminal or function block (FB). 

 

- Save Trace Monitor File 

Click [Trace monitor file] on the toolbar to save the information of the symbol for which you 

selected the trace monitor. 

 

 

 

- External Signal Import 

Select  on the main window toolbar and click [Realtime Trace] to open the [Realtime Trace] 

window. 

 

 

Alternatively, you can open the [Realtime Trace] window without using the Quick Access 

menu by selecting [Menu] -> [Trace] -> [Realtime Trace] from the main menu. 
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Click the [External signal import] button at the 

lower left of the [Realtime Trace] window. 

(Using the customizable logic editor screen, 

load the information saved by clicking [Save 

trace monitor file].) 

 

 
 The [External signal import] button appears once you click [Save trace monitor 

file]. 

 

- Advanced Waveform Settings 

 

- Next, click the [Advanced...] button at the right 

of the [External signal import] button and 

configure the channel settings. 

 

To select a signal within the customizable logic 

function, use the [Analog Ch] tabs for both 

analog and digital signals. 

 

The customizable logic signals are added at 

the bottom of the [Select Signal] list. 

 

For information on other settings, refer to 

"2.3.4.8. Advanced Waveform Settings". 
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- Graph Position Adjustment 

 

 

 

 

 

 

 

To monitor a digital signal, set [Scale] to '2' on 

the [Graph position adjustment] tab. 

 

 

To start the trace, click the [START/STOP] button at the top of the trace screen.  

Refer to "2.3.4.1 Trace Function" for details. 

 

 

[2] Saving the Customizable Logic Signal Trace Data 

You can save the customizable logic signal trace data in the same way as other trace data. 

Refer to "2.3.4.4. Saving the Trace Data" for details. 

At this time, however, you should save the customizable logic project data as well. 

The same applies when you perform [Setting Export] from [Settings] under the [Advanced 

waveform settings] button. Be sure to save the customizable logic project data as well. 
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[3] Opening the Saved Customizable Logic Signal Trace Data 

Before you open a file that contains the customizable logic signal trace data (i.e., an RT2 or 

RT1 file), you should click [External signal import] to load the same signal information as when 

the trace data was collected. 

 

 
 If the signal information you load by clicking [External signal import] is not 

appropriate, the loader will not correctly display the signal names, units, and 

data step sizes. 

 

Therefore, you should follow these steps to open the trace data: 

First, open the customizable logic project data used when the trace data was collected. 

Next, select [Trace monitor select] -> [Save trace monitor file] -> [External signal import], 

similarly to when you collected the trace data. 

For more information on [Trace monitor select] and [Save trace monitor file], refer to 

"2.3.4.10. [1] How to Monitor a Customizable Logic Signal Using the Realtime Trace".  

Finally, open the trace data. 

 

 

 

The same applies when you perform [Setting Import] from [Settings] under the [Advanced 

waveform settings] button.  

Before you use [Setting Import] to load the customizable logic signal settings saved using 

[Setting Export], you should use [External signal import] to load the same signal information as 

when you performed [Setting Export].  

 

 

 

 

START 

END 

Trace monitor select 

Save trace monitor file 

 
Open the customizable logic 

project file 

 External signal import 

 Open the trace data 

 
Use the customizable logic 

editor screen 

Use the [Realtime Trace] 

window 
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2.3.4.11. Offline setting function 

You can make setting up the trace function without communication to any inverter. It is useful in 

case you want to prepare setting in offline situation in advance. 

Select [Menu] > [Trace] from the main menu or click  on the main window toolbar and then 

click [Real-Time Trace], [Historical Trace], or [Trace back] to open the corresponding trace 

function window. 

  
  

 

[Select Online/Offline] window is displayed first. 

 

Select [Offline]. 

Click [OK]. 

 

Then [Offline Settings] window is displayed. 

 

Select the inverter model to be configured. 

Click [OK]. 

 

The trace window (see “2.3.4.2. Realtime Trace” or “2.3.4.3.Historical Trace”.) is displayed. 

 
 The model list shows only the inverter models that support the tracing function (see 

“1.1.2.Loader Functions by VF1A Series Inverter Model”). 
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The Trace window displayed as offline cannot perform the trace function, as the START/STOP 

buttons disabled. 

In order to make setting up the Trace function, open [Detailed Waveform Settings] (see 

[2.3.4.8.Advanced Waveform Settings]). 

To save or restore your settings, use Export/Import function. (see [2.3.4.9.Setting Export/Setting 

Import]). 
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2.3.5. Test Run 

Select [Menu] -> [Test run] -> [Drive operation] from the main menu or select  on the main 

window toolbar and click [Test run] to open the [Drive operation] menu under the toolbar. 

 

 
 You cannot perform operations if you have selected [Data in Keypad] for [USB 

Connection] on the [Communication Setting] window. If you cannot perform 

operations for another reason, refer to "2.3.5.3. If You Cannot Use the [Drive 

operation] Menu". 

 

 
 You should use [Test run] only while connected to the inverter. 

 Depending on the communication link condition, it may take a long time to detect 

the communication target. The loader does not respond until the communication 

target is detected. To avoid the inability to operate the loader for a long time, you 

should use the loader in an environment with as good communication conditions 

as possible. 

 Do not attempt operations with an inverter that has password protection enabled. 

If the loader does not respond or is forcibly terminated, the means to stop the 

inverter may be limited, which can be very dangerous. 

 

Drive operation buttons 

FWD: Click this button to rotate the motor in 

the forward direction. (The button 

appears depressed during rotation.) 

REV : Click this button to rotate the motor in 

the reverse direction. (The button 

appears depressed during rotation.) 

STP : Click this button to stop the inverter. 

RST : Click this button to reset the alarm. 

Test Run 

Click this button to open the [Drive operation] menu under the 

toolbar. Click it again to close the [Drive operation] menu. 

 

Frequency command/operation command change (update) 

Sends the frequency/operation command source to the 

inverter. 

 

Frequency command (update) 

Sends the frequency command [Hz] to 

the inverter. 

 Target 

Select the device you want to test-run. 

 

 Update 

Click this button to synchronize the display of the drive operation buttons, 

the frequency command, and the frequency command/operation 

command change with the inverter. 

 

To close the [Drive operation] menu, click the [Test run] button on the toolbar (see above). 

Alternatively, you can close it by selecting [Menu] -> [Test run] -> [Drive operation] from the main 

menu. 
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In addition, you can display the terminal operation buttons under the [Drive operation] menu by 

selecting [Menu] -> [Test run] -> [Terminal operation] from the main menu. 

 

 

 

Terminal operation buttons 

X1, X2, ...,X9:  These buttons allow you to turn ON X1 to X9 terminals. The number of terminals you can operate 

varies depending on the inverter model. 

XF:  Click this button to turn ON the FWD terminal. 

XR:  Click this button to turn ON the REV terminal. 

 

To hide the terminal operation buttons, select [Menu] -> [Test run] -> [Terminal operation] from the 

main menu, similarly to when you display them. 
 

 
 When you use the terminal operation buttons to operate a terminal, the logical 

inversion settings of the terminal function are ignored.  

The following example shows what occurs when the free run command "BX" is 

selected with E01. 

Function 

code data 
Physical terminal 

Loader's terminal operation 

button 

7 
Free run when the X1 terminal is ON 

(normally open) Free run when the [X1] button is 

ON (normally open) 
1007 

Free run when the X1 terminal is OFF

 (normally closed) 

You should be careful, especially when you configure the forced stop ("STOP") 

using a logical inversion (E01=1030). If the physical terminal is enabled, you can 

run the inverter by turning OFF the X1 terminal. However, if the operation 

command from the loader is enabled, you cannot run the inverter unless you turn 

ON the [X1] button. 
 

Once you open the [Drive operation] menu, the [Frequency command/operation command 

change] field shows "0: Freq = Inverter, Ope = Inverter", which means that you cannot use the 

loader to change the frequency command or start/stop the inverter. Hence, you cannot click the 

operation buttons [STOP], [FWD], and [REV] on the loader screen. 

Similarly, once you display the terminal operation buttons, you cannot click the [X1], [X2], [X3], 

[X4], [X5], [X6], [X7], [X8], [X9], [XF], and [XR] buttons. 

The drive operation and terminal operation buttons are enabled only when "Ope = Loader" is 

shown in the [Frequency command/operation command change] field.  

Also, the frequency command is enabled only when "Freq = Loader" is shown.  

However, the [RST] button is always enabled. 
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2.3.5.1. Operating the Inverter from the Loader 

Click  next to the [Frequency command/operation command change] field and select 

"1: Freq = Loader, Ope = Inverter", "2: Freq = Inverter, Ope = Loader", or "3: Freq = Loader, 

Ope = Loader" from the pull-down list depending on the command you want issue from the 

loader. See the table below. 

 

 

Command you want 

issue from the loader 

[Frequency 

command/operation 

command change] 

Frequency 

command 

Drive operation 

buttons [FWD], 

[REV], [STOP] 

Terminal operation 

buttons [X1] to 

[X9], [FWD], [REV] 

None 

0: Freq = Inverter, 

Ope = Inverter  

(default) 

Disabled 

(Not operable) 

Disabled 

(Not operable) 

Disabled 

(Not operable) 

Frequency command 
1: Freq = Loader, 

Ope = Inverter 

Enabled 

(Operable) 

Disabled 

(Not operable) 

Disabled 

(Not operable) 

Operation command 
2: Freq = Inverter, 

Ope = Loader 

Disabled 

(Not operable) 

Enabled 

(Operable) 

Enabled 

(Operable) 

Frequency command 

Operation command 

3: Freq = Loader, 

Ope = Loader 

Enabled 

(Operable) 

Enabled 

(Operable) 

Enabled 

(Operable) 

 

To issue both the frequency command and the operation command from the loader, follow these 

steps: 

 

1) From the [Frequency command/operation command change] field, select "3: Freq = Loader, 

Ope = Loader" and click [Apply]. 

 

 

2) This enables the frequency command field as well as the drive operation buttons [STOP], 

[FWD], and [REV], the terminal operation buttons [X1], [X2], ... (number of terminals you can 

operate varies depending on the inverter model), and the [FWD] and [REV] buttons. 

 

3) Enter a frequency in the frequency command field and click [Apply]. To rotate the motor in the 

forward direction, click the [FWD] button. To rotate the motor in the reverse direction, click 

the [REV] button. To stop it, click the [STOP] button. 

 

 

 
 When you close the [Drive operation] menu, the loader automatically writes "0: 

Freq = Inverter, Ope = Inverter". 

 

 

2.3.5.2. Monitoring the Inverter Operation Status from the Loader 

You can monitor the inverter operation status using the operation monitor and the realtime trace. 

Refer to "2.3.2. Operation Monitor" and "2.3.4.2. Realtime Trace. 
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2.3.5.3. If You Cannot Use the [Drive operation] Menu 

You may be unable to use the [Drive operation] menu in the following cases: 

 

[1] A communication Error Has Occurred 

If a communication error has occurred between the loader and the inverter and you attempt to 

use the [Drive operation] menu or a terminal operation button, the following dialog appears: 

 

If you respond by clicking [Cancel], the drive operation buttons, the frequency command field, 

the [Frequency command/operation command change] field, and the terminal operation buttons 

will be disabled. Even if the communication is restored, the loader will not automatically resume 

the communication with the inverter with which a communication error occurred. 

If this is the case, check the communication status by clicking [Browse] on the [Connection 

Setting] window. 

If "Connected" is shown in the [Status] column, it means that the communication between the 

loader and the inverter has been resumed and you can enable the [Drive operation] menu and 

the terminal operation buttons by clicking  at the right of the [Drive operation] menu. 

 

 

 

 

 

 

 

 

 

 

 

Click [Browse]. 

 

 

 

Check if "Connected" is shown. 

 

If "Connected" is shown after you click [Browse] but the [Cannot communicate with inverter] 

dialog appears when you attempt to use the [Frequency command/operation command change] 

field, the inverter may have password protection enabled. If this is the case, you must disable 

the password protection of the inverter. For more information on password protection, refer to 

the instruction manual or user's manual of your inverter.  
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[2] "LE" Enable Communications Link Is Assigned 

If "LE" Enable communications link is assigned to the general-purpose input signal (X terminal) 

and "LE" is OFF, you cannot use the drive operation buttons and the frequency command field 

even after you change the [Frequency command/operation command change] field to a 

non-zero setting. 

 

The drive operation buttons and the frequency 

command field are disabled. 

 

 

In this case, you can enable the [Drive operation] menu and the terminal operation buttons by 

clicking  at the right of the [Drive operation] menu after enabling "LE" or unassigning "LE". 

You can check the assignment and ON/OFF status of "LE" Enable communications link, using 

the [Operation Monitor] > [I/O Monitor] window. The following example shows what is displayed 

when "LE" Enable communications link (E01=24) is assigned to the X1 terminal and "LE" is OFF 

(i.e., the X1 terminal is OFF). 

 

 

 

To assign "LE" Enable communications link, use function codes E01, E02, and so on. For more 

information, refer to the User's Manual of your inverter. 

 

 

[3] The Inverter Has a Realtime Clock (RTC) 

If the loader is connected to an inverter model that has a realtime clock (RTC) and the realtime 

clock (RTC) is not configured (or it is initialized), you cannot operate the inverter with the 

schedule operation function enabled. To operate the inverter, you should configure the inverter's 

date and time or disable the timer operation function. 
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 Carefully note that resetting the alarm with the operation command on causes the inverter 

to start unexpectedly as soon as the alarm is cleared. 

 Failure to observe this could result in an accident. 

 

 If the loader goes down or is forcibly terminated during the operation with the test run 

screen open, it will be impossible to stop the inverter operation with the loader. If this is the 

case, stop the inverter by doing one of the following: 

 Failure to observe this could result in an accident. 

<How to stop the inverter when the loader goes down or is forcibly terminated> 

1) If an emergency stop switch is available, use the switch to stop the inverter. 

2) Turn off the inverter power. 

3) Turn off the inverter operation command and switch the inverter from "remote command 

mode" to "local command mode".  

More specifically, do one of the following:  

- Turn off the terminal to which the "LE" command is assigned.  

- Zero the data for the link function for support (function code: y99).  

- Zero the data for the link function (function code H30). 

 

 Do not remove the RS-485 cable, USB cable, or keypad during the operation with the test 

run screen open. Doing so would be dangerous because it would be impossible to stop the 

inverter operation with the loader. 

 Failure to observe this could result in an accident. 

 

Even after you have stopped the inverter by doing one of the above, the settings of the inverter's 

frequency command via internal communication (communication dedicated function code S05), 

operation command (communication dedicated function code S06), and link function for support 

(function code y99) will be retained. If you attempt to operate the motor in this state, the motor 

may suddenly start. For safety, reset the data of the above function codes (S05, S06, and y99) 

to 0 by following these steps: 

1) Turn off the power to the inverter. Wait for the inverter to completely stop. Then turn back 

on the power. 

2) Zero the data of the link function for support (function code y99) using a keypad. Then start 

the loader and zero the data of the frequency command via communication (communication 

dedicated function code S05) and the operation command (communication dedicated 

function code S06) on the [Function code edit] window. 
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2.4. Setup 

The [Setup] menu provides the following submenus: 

 

 

This section describes the main functions available under the [Setup] menu. 

 

 

2.4.1. Communication Settings 

Refer to "1.5.5.1. Communication Settings". 

 
 

2.4.2. Browse 

Not available. 
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2.4.3. Language 

You can configure the language settings of the loader. From the main menu, click [Setup] -> 

[Language] to select the desired language and then exit from the loader.  

 

 

Restart the loader and the selected language will be displayed. 

* The selected language will not be displayed until you restart the loader. 

 

 

 
 Depending on the language supported by the operating system, you may not be 

able to select Japanese language. 
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2.4.4. Region Spec. 

You should configure [Region spec.] correctly according to your inverter. 

 
 You can identify the inverter region spec. from the inverter model number printed 

on the rating nameplate of the inverter. For more information, refer to "2.2.1. [1] 

Model, Regional Specification, Voltage, Capacity" or the instruction manual of 

your inverter. 

 

If the region spec. you specify in the loader does not match the region spec. of the inverter, the 

following problems may occur. 

 The inverter model you want to connect is missing from the list box on the [Default setting] 

window accessible by clicking [Function code edit...] -> [New...] -> [Default setting] from the 

Quick Access menu. 

 The communication wirings and the inverter and 

loader communication settings are correct but 

an attempt to communicate with the inverter fails 

with the message "Failed to get the inverter 

model information" displayed.  

 

You can change the loader's region spec. setting by clicking [Setup] -> [Region spec.] from the 

main menu. 

 

 

When you are finished changing the setting, exit from the loader. 

Restart the loader to apply the new region spec. 

* The new region spec. will not be applied until you restart the loader. 

 

 
 Normally, you set the region spec. once when you start the loader for the first time. 

Refer to "Setting the Operating Environment" in "1.5.3. Starting the Loader" for 

details. 
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2.5. Edit 

Once you open the [Function Code List] window, the [Edit] option is added to the main menu.  

 

 

[Undo]: Click this button to restore the second most recent setting of the 

function code you edited in the [Function code edit] window. 

[Factory shipping value]: Click this button to reset the function code setting selected in the 

[Function code edit] window to the factory-set value. 

[Search]: Refer to "2.3.1.1. [8] Search (Search function code terminologically)". 

 

 

 
 You can open the [Function Code List] window by selecting [Function Code] from 

the Quick Access menu. Refer to "2.3.1. Function Code " for details. 
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2.6. View 

You can specify which elements to display on the loader screen. 

 

 

2.6.1. Toolbar 

You can show or hide the toolbar.  

Showing the toolbar allows you to use your desired feature (such as the Quick Access menu) by 

just clicking its icon. 

Toolbar 
 

 
 
 

Status Bar 

 

2.6.2. Status Bar 

You can show or hide the status bar. 

For information on what is displayed on the status bar, refer to "2.1. Main Window". 
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2.6.3. Parameter Information and Character size 

These menu items are added once you open the [Function Code List] window. 

 

Parameter Information 

This menu item provides the same function as the [Function code 

information] button on the [Function code edit] window. 

Select it to display the information of your selected function code in 

the function code information window. 

 

Character size 

Select this menu item to open the [Font] window (as shown below). 

The [Font] window allows you to change the font for the function 

code names in the [Function code edit] window. 

 

 

Example: Default font 

 

After you change the font to Tahoma, Bold Oblique, 18 pt 

 
 

 
 Once you close the [Function Code List] window, the font settings will be reset to 

the defaults. You cannot save the font settings. 

 The font settings are ignored when you print the data. 

 You can open the [Function Code List] window by selecting [Function Code] from 

the Quick Access menu. Refer to "2.3.1. Function Code " for details. 

 The [Function code edit] window is actually a tab of the [Function Code List] 

window. 
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2.6.4. Toolbox, Project Management Window, Output Window 

These menu items are activated once you open the [Customizable logic] window. They allow 

you to show or hide the windows relating to the customizable logic function. For information on 

these windows, refer to "2.3.3.2. Editor Screen". 

 

 

 

Toolbox 

Show or hide the toolbox. 

 

Project management window 

Show or hide the project management window. 

 

Output window 

Show or hide the output window. 
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2.7. Function Code Edit 

Once you open the [Function Code List] window, the [FunctionCodeEdit] option is added to the 

main menu.  

 

 

2.7.1. Import and Export 

This function allows you to save the function code setting data to a file in CSV format and 

restore from the CSV file. 

This is useful when you want to edit function code settings in an external application such as 

Microsoft Excel and then load them into the loader. 

Import 

Allows you to import function code settings from a function code data file in the CSV format and display them 

in the [Function code edit] window. Before you import the settings, you should open the [Function Code List] 

window. 

After selecting a CSV file to be imported, [Import setting] dialog is displayed. 

 

Import target selection 

Select whether to import data that has different set values depending on the voltage series and 

capacity, and read-only data such as for monitoring. 

For more information for such data, refer to the “User's Manual” or "RS-485 Communication User's 

Manual" for your inverter. 

 

Continue 

Click this button to proceed the 

import operation. 

Cancel 

Click this button to cancel the 

import operation. 

Additional information 

Displays messages if the CSV file to be imported differs from the inverter model, voltage, capacity, 

version, or etc. in the current [Function Code List] window. If it is the intended import operation, 

press the [Continue] button to proceed the operation. In that case, some data may not be imported 

correctly, therefore make sure that the intended result is obtained after the operation.  

Nothing is displayed here if the settings of the CSV file to be imported matches to [Function Code 

List] window. 
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Export 

Allows you to export the function code settings in the [Function code edit] window to a CSV file.  

Before exporting the settings, you should select the function code you want to export from the tree view of 

the [Function code edit] window. 

 

For example, to export all the function code settings, select the [Function] node at the top 

of the tree. 

 

To export a particular function code group, select the function code group you 

want to export from within the tree. 

After selecting the function code(s), click [Export].  

You can edit the exported CSV file in an external application such as Microsoft Excel.  

 

 
 You can open the [Function Code List] window by selecting [Function code edit...] 

from the Quick Access menu. Refer to "2.3.1. Function Code " for details. 

 The [Function code edit] window is actually a tab of the [Function Code List] 

window. 

  If two or more instances of the [Function code edit] window are open, the imported 

settings are displayed in the active instance of the [Function code edit] window. 

  You cannot use [Import] or [Export] on the customizable logic function code list. 

 

  

 

[1] CSV File Format 

The following example shows the format of a CSV file that contains the exported function code 

data. For more information on the format, refer to "CSV File Format" in "3.2.2. Function Code 

Setting Specifications". 

 

 Column number 

1 2 3 4          5  6  7  8 

R
o

w
 n

u
m

b
e

r 

1 
Doesa 

Loader, 

DF1A 900, 900,       8,  U,  4,  2022/03/01 - 00:00:00 

2 Func, Function code name, Setting, Factory default 

3 F00, Data protection, 0, 0 

4 

… 

F01, 

… 

 

Frequency setting 1, 

… 

 

0, 

… 

 

0 

… 

 [comment]    

     

      

Figure 2-2  Format of a CSV file that contains function code settings 

 

Editable 
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[2] Editing a CSV File 

To avoid import failures, you are recommended to edit an exported CSV file to create a CSV file 

for import. In addition, you are recommended to save the function code settings to the FNL 

format as well as the CSV format and manage both the FNL and CSV files. You can avoid import 

failures by opening that FNL file while you are importing the data. 

Basically, you should only edit the settings of the exported CSV file (the portion enclosed in 

dotted lines in Figure 2-2 above). You should edit the settings correctly in accordance with the 

following input rules. 

 

Setting input rules 

(1) A function code setting should be configured using a decimal or hexadecimal value. You 

cannot use a string such as "OFF". 

When using a decimal value:  You can use single-byte numbers (0 to 9), minus 

sign (-), and decimal point (.). 

When using a hexadecimal value:  Prefix the value with 0x. You can use single-byte 

numbers (0 to 9), alphabets a to f and A to F.  

Example: A decimal value of 32767 is expressed in 

hexadecimal as 0x7FFF. 

(2) Enter a value within the valid range for the function code. A value outside the valid range will 

not be imported. You can check the valid range for a function code in the [Function code edit] 

window. 

(3) You can enclose the setting in double quotation marks. 

Example: You can enter "32767" to represent a decimal value of 32767. 

(4) The setting of 999 has a special meaning and is treated as a decimal value of 32767 

(0x7FFF in hexadecimal). 

Example:  The valid range of VF1A F40 torque limit value 1 (drive) is 0 to 300 %; 999,  

where '999' means "no operation" rather than representing a percentage and it 

is treated as 32767 in a CSV file. 

(5) Strings such as "OFF", "Auto", and "Inherit" are treated as a decimal value of either 0 or 

32767 (0x0 or 0x7FFF in hexadecimal) depending on the function code. For more 

information, refer to the description of the data format in the "RS-485 Communication 

User's Manual" for your inverter. Or export function code settings that include strings, open 

the exported CSV file, and check the numeric values. 

Example:  The valid range of VF1A F50 electronic thermal (for breaking resistor 

protection) (rated discharge withstand current) is 1 to 9000 kWs; OFF,  

where "OFF" is treated as a decimal value of 32767 (0x7FFF in hexadecimal). 

 
 If in Microsoft Excel you convert an exported CSV file to a different format such as 

XLS, edit it and re-export it to a CSV file, you may be unable to import the 

resulting file. If this is the case, open the CSV file in a text editor (such as 

Windows Notepad) and check if it complies with the rules described in "Figure 2-2  

Format of a CSV file that contains function code settings". 

 
 If a warning such as "Model mismatch", "Voltage mismatch", "Capacity 

mismatch", or "Some function codes cannot be loaded" appears when you 



 

 

 2-204 

attempt to import a CSV file, there may be a mismatch in model, voltage, 

capacity, or inverter ROM version between the CSV file and the [Function code 

edit] window.  

To check for any mismatch, abort the import and export the function codes from 

the [Function code edit] window. Then compare the CSV file you are going to 

import with the exported CSV file.  

For more information on the CSV file format, refer to "Figure 2-2  Format of a 

CSV file that contains function code settings".  

If a mismatch is found, correct the CSV file you are going to import so that it 

matches the exported CSV file. 

 

[3] Recommended Way of Use 

You are recommended to primarily use the [Function code edit] window when you configure 

function code settings and use the [Export] and [Import] functions as needed for assistance. 

An example of use is shown below: 

Edit the function code settings in the [Function code edit] window. 

 

  

Export some of the function 

code data and edit it using a 

spreadsheet application or a text 

editor. 

  

 

 

 

 

Import the function code settings from a 
CSV file to the settings you edited in the 
[Function code edit] window. 

 

 
 To avoid import errors, save the function code data to the FNL format as well as 

the CSV format. 

Before you import the function code settings, select [Function Code] -> [Read from 

the file] to open the FNL file you saved when you exported the data. 

 

2.7.2. Export to CSV (Last error Info.) 

This function is same as the [Save...] button in the error window as shown below. This is used to 

save the error information to the CSV file in case closed the error window without save the 

information.  
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An example of the error window with the [Save...] button 

 

 

The submenu shown in right hand is activated 

after the error window is displayed even once. 

 

 

2.7.2.1. Commuication (read or write) 

If the error window with the [Save...] button is displayed even once at reading/writing data 

from/to the inverter in the [FunctionCodeEdit] window, this menu becomes available. 

This is used to save the error information to the CSV file in case closed the error window 

without saving the information.  

2.7.2.2. Function code import 

If the error window with the [Save...] button is displayed even once at importing data from a file 

in the [FunctionCodeEdit] > [Import...] on the Main Menu, this menu becomes available. 

This is used to save the error information to the CSV file in case closed the error window 

without saving the information.  

2.7.2.3. Change the definition file 

If the error window with the [Save...] button is displayed even once at changing the definition file 

on the [File Information] window, this menu becomes available. 

This is used to save the error information to the CSV file in case closed the error window 

without saving the information.  
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2.8. Window 

You can arrange the windows on the loader screen.  

 

 
 

2.8.1. Cascade 

Click [Window] -> [Cascade] to cascade windows.  
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2.8.2. Tile 

Click [Window] -> [Tile] to tile windows.  

 

 

 

2.8.3. Arrange Icons 

Click [Window] -> [Arrange Icons] to minimize windows and arrange the icons at the bottom of 

the main window.  
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2.8.4. Tile Vertically 

Click [Window] -> [Tile vertically] to tile windows vertically.  
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2.9. Help 

2.9.1. Search the Topics 

Not available. 

2.9.2. About 

Displays the version and copyright information for this loader.  

 

Implemented the management function of the additional definition library files. 

 

 

Version 

The main version that integrates 

executable and definition files. 

File Version 

Version of the executable file itself. 

Definitions Library 

Installed definition file library type and 

version are listed here. 

Add-IN Setting 

Displays the Add-in setting window which manages additional definition library files. 

The files will be provided as needed by IDEC CORPORATION. 





 

 

 
 
 
 

Chapter 3 

Reference Information 
 

 

This chapter provides information on troubleshooting and standard specifications. 
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3.1. Frequently Asked Questions 

3.1.1. Loader Specifications 

 

Q1. What is the supported OS? 

A1. The supported OS is Microsoft 8.1, and 10. 
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3.1.2. Communication-Related Information 

3.1.2.1. Connection Methods and Connection Devices 

■ Recommended Cables 

Q1. Where can we get these cables? 

A1. Cables For Connecting RJ-45 Connectors 

Commercially available LAN cables can be used. 

 

Cables for Connecting Terminal Blocks 

Not available from IDEC CORPORATION. 

 

Recommended cable is as follows. 

Manufacturer:  Furukawa Electric Co., Ltd. AWM2789 Long distance connection 

cable and so on.  

For these products, please contact Furukawa Electric Co., Ltd. or their distributor. 

 

USB Cable 

Please use commercially available USB cables. 

   Refer to "1.2.2.2. [2] Cables (for RJ-45 connector connection)". 

  Refer to "1.2.2.2. [3] Cables (using terminal blocks)". 

 

■ Connection Methods 

Q2. Is it possible to connect the RJ-45 connector on the inverter to the LAN terminal of 

the PC directly using the LAN cable? 

A2. Both the inverter and the PC may be damaged. Never connect them directly. 

They must be connected via the RS-232C/RS-485 or USB/RS-485 converter or 

the remote keypad with USB. 

For information on the specific connection methods, refer to "1.2.2" and "1.2.3". 

   Refer to "1.2.2. RS-485 Communication Port Connection". 

  Refer to "1.2.3. USB Communication Port Connection". 
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■ RS-232C/RS-485 or USB/RS-485 converter 

Q3. Can we get these converters through IDEC CORPORATION? Where can we get 

these converters? 

A3. Not available from IDEC CORPORATION. 

The recommended converters are as follows: 

System Sacom Industry Corp. 

- KS-485PTI (RS-232C/RS-485 converter) 

- USB-485I RJ-45-T4P (USB/RS-485 converter) and so on.  

For these products, please contact System Sacom Industry Corp. or their distributor. 

 

Q4. The converter is not recognized by Windows 8 or later version. Any solution? 

A4. The converter may not be supported by Windows 8 or later version. 

Please contact the converter manufacturer because IDEC CORPORATION does not 

handle the converters. 

If the converter is supported by Windows 8 or later version, it is possible that you 

failed in installing the converter drive software. Please reinstall the software. 
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3.1.2.2. USB Communication 

■ USB Communication 

Communication target : Inverter via the remote keypad with USB  

: Remote keypad with USB  

Q1. USB communication does not work. 

Q1'. The following message is displayed: "Failed to obtain the inverter model 

information." 

A1-1. Power may not have been supplied to the inverter. 

A1-2. The USB driver may not have been installed. 

Confirm that [Driver for FRENIC USB interface] is displayed under [Loader USB 

device] on the Device Manager of the Windows PC. 

For information on the specific confirmation procedure, refer to "1.4.1.5". 

   Refer to "1.4.1.5. Checking the USB Driver". 

 If [Unknown device] is displayed instead of [Driver for FRENIC USB interface], set 

up the USB driver again. For information on the specific procedure, refer to 

"1.4.1.4". 

   Refer to "1.4.1.4. USB Driver Installation Procedure". 

 If neither [Driver for FRENIC USB interface] nor [Unknown device] is displayed, 

refer to "Q2". 

   Refer to "Q2.". 

A1-3. If you are using the USB hub, stop using the hub. 

A1-4. The Message Manager may not have been installed. 

Confirm that the Message Manager icon  is displayed on the task bar of the 

Windows PC while the Loader is running. 

For information on the specific confirmation procedure, refer to "1.5.4.1". 

   Refer to "1.5.4.1.Checking the Startup of the Message Manager". 

 If the Message Manager icon  is not displayed on the task bar of the Windows 

PC, uninstall the Message Manager and then reinstall it. 

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this 

instruction manual. 

   Refer to "1.4.2.2. Uninstallation of the Message Manager". 

  Refer to "1.4.1.6. Installation of the Message Manager". 

 If the Message Manager icon  is displayed on the task bar of the Windows PC, 

refer to "Q3". 

   Refer to "Q3". 
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A1-5. The timeout setting for the Loader may be too short. 

If the timeout is set to a value smaller than 1.5 s, a communication error may be 

detected before the Loader receives a response from the communicating device. 

Set to a value larger than the default value and try to see if communication is 

possible. 

Set the timeout setting on [Communication Conditions] on the [Communication 

setting] window. Refer to "1.5.5.1. [3]" of this instruction manual. 

   Refer to "1.5.5.1. [3] Communication Conditions". 

A1-6. When the communication target is the inverter via the remote keypad with USB 

The inverter may not be applicable to the communication via the keypad. 

For the correspondence table, refer to "1.1.1" of this instruction manual. 

   Refer to "1.1.1. Features". 

A1-7. When the communication target is the inverter via the remote keypad with USB 

The keypad may have been connected to the RS-485 communication port 2 of the 

inverter. 

Connect to the RS-485 communication port 1. 

A1-8. When the communication target is the inverter via the remote keypad with USB 

If a LAN cable is used for the connection between the keypad and the inverter, the 

LAN cable used may be a cross cable. If a cross cable is being used, replace it with 

a straight cable. 

A1-9. When the communication target is the inverter via the remote keypad with USB 

The port setting on the [Communication setting] of the Loader may not be correct. 

Make sure that the setting is as follows: [USB connection], [Data in Inverter (via 

VF1A-PH1)]. 

For information on the specific setting procedure, refer to "1.5.5.1". 

   Refer to "1.5.5.1. Communication Settings". 

A1-10. When the communication target is the inverter via the VF1A-PH1 remote keypad 

with USB  

The address set on [Address] (for the RS-485 station address) on the [Connection 

setting] window accessed from the [Communication setting] window of the Loader 

may not the same as the station address of the inverter. Make sure that the address 

is the same. 

For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2". 

   Refer to "1.5.1. Setting Function Codes Related to Communication on the 

Inverter Side". 

  Refer to "1.5.5.2. Connection Setting". 

A1-11. When the communication target is the remote keypad with USB 

The port setting on the [Communication setting] of the Loader may not be correct. 

Make sure that the setting is as follows: [USB connection], [Data in Keypad]. 

For information on the specific setting procedure, refer to "1.5.5.1". 

   Refer to "1.5.5.1. Communication Settings". 
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Q2. When it is checked whether the USB driver is recognized by the Device Manager, 

"Unknown device" is not displayed. How can I make the Device Manager properly 

recognize the driver? 

A2-1. The connection between the PC with the USB device may be incomplete. 

Check the connection by disconnecting and then reconnecting the USB cable, 

connecting to another USB port on the PC, or replacing the USB cable. 

A2-2. It is necessary to connect the PC to the USB device to display "Unknown device". 

After that, install the USB driver. 

   Refer to "1.4.1.4. USB Driver Installation Procedure". 

 

Q3. Although the Message Manager is running, communication does not work. 

A3-1. The USB driver may not have been properly recognized by the Message Manager. 

In such a case, the Message Manager must be restarted. Close the Message 

Manager, and restart the Loader. 

For information on procedures for closing the Message Manager, refer to "1.4.1.4". 

   Refer to "1.4.1.4. [1] Before Installing the USB Driver". 

A3-2. The Message Manager itself or its registry may have been damaged due to some 

reason. 

Uninstall the Message Manager and then reinstall it. 

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this 

instruction manual. 

   Refer to "1.4.2.2. Uninstallation of the Message Manager". 

  Refer to "1.4.1.6. Installation of the Message Manager". 
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Q4. After changing the function code from the Loader, I checked it using the keypad and 

found that the function code was not changed. 

A4. If you are using the remote keypad with USB, the port setting on [Communication 

setting] of the Loader may be set to [USB connection], [Data in Keypad]. If that's the 

case, change the setting to [Data in Inverter (via VF1A-PH1)]. 

For information on the specific setting procedure, refer to "1.5.5.1" of this instruction 

manual. 

   Refer to "1.5.5.1. Communication Settings". 

 

Q5. Set the Loader to work offline from the inverter (for example, bringing the Loader to 

your office), edit the function code on the Loader, and write the edited result in the 

remote keypad with USB. 

Is it possible to copy the edited data to the inverter just by using the keypad (at the 

work site) without using the Loader? 

A5. Yes. It must be noted, however, that it is possible only with the models that support 

the keypad as standard or as an option. For information on the keypad support 

details, refer to "1.1.2. Table 1-1" of this instruction manual. 

   Refer to "1.1.2. Table 1-1  Correspondence between VF1A Series Inverter 

Models and Loader Functions". 

 If customizable logic is used, care must be taken. 

If the customizable logic is used for the inverter that supports the setting specified in 

[Open customizable logic setting screen] under [Function code setting], both the 

basic function code settings (such as F, E, or C codes) and customizable logic 

setting (Uxx) must be written when writing the data from the Loader to the keypad. 

For reference information, refer to "2.3.3.9" of this instruction manual. 

   Refer to "2.3.3.9. [2] To write to the Keypad". 

 

 

Q6. USB communication is not possible after the PC enters the standby (sleep) state. 

A7. Disconnect and then reconnect the USB cable. If the communication cannot be 

recovered even after that, restart the PC. 
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Q7. The seven-segment LED display on the VF1A-PH1 shows "-Ld-". What does that 

mean? 

A8. It means that the connection between the VF1A-PH1 and the inverter is not 

established and only the PC side is connected. 

If this is displayed while using the Loader, communication with the inverter is not 

possible. Check the connection between the VF1A-PH1 and the inverter and take 

necessary actions. 
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3.1.2.3. RS-485 Communication 

■ RS-485 communication 

Communication target : Inverter via the USB/RS-485 converter 

: Inverter via the RS-232C/RS-485 converter 

Q1. RS-485 communication does not work. 

A1-1. Power may not have been supplied to the inverter. 

Check whether the power is properly supplied. 

A1-2. When using the USB/RS-485 converter 

The USB driver may not have been installed. 

Confirm that [USB Serial Port (COM)] is displayed under [Port (COM and LPT)] on 

the Device Manager of the Windows PC. 

For information on the specific confirmation procedure, refer to "1.5.2". 

   Refer to "1.5.2. Checking Communication Ports on the PC (when Using a 

Converter)". 

 If [Unknown device] is displayed, set up the USB driver again. For information on the 

specific procedure, refer to the instruction manual of the converter currently used. 

A1-3. When using the RS-232C/RS-485 converter 

The Loader does not allow switching with RS-232C flow control signals (RTS or 

DTR) from the PC. The transmission and reception switching must be done 

automatically through monitoring transmission data. 

If a converter other than the ones we recommend, confirm the transmission and 

reception switching method specified in the instruction manual of the converter 

currently used. 

There is no problem with the converters we recommend because the transmission 

and reception switching is done automatically through monitoring transmission data.  

   Refer to "1.2.2.2. [1] Converter". 

A1-4. The number of the COM port on the Windows may not match with the COM port 

setting on the Loader. Check the COM port. For information on the specific 

procedure, refer to "1.5.2" and "1.5.5.1" of this instruction manual. 

   Refer to "1.5.2. Checking Communication Ports on the PC (when Using a 

Converter)". 

  Refer to "1.5.5.1. Communication Settings". 
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A1-5. The Message Manager may not have been installed. 

Confirm that the Message Manager icon  is displayed on the task bar of the 

Windows PC while the Loader is running. 

For information on the specific confirmation procedure, refer to "1.5.4.1". 

   Refer to "1.5.4.1. Checking the Startup of the Message Manager". 

 If the Message Manager icon  is not displayed on the task bar of the Windows 

PC, uninstall the Message Manager and then reinstall it. 

For information on the specific procedure, refer to "1.4.2.2" and "1.4.1.6" of this 

instruction manual. 

   Refer to "1.4.2.2. Uninstallation of the Message Manager". 

Refer to "1.4.1.6. Installation of the Message Manager". 

 If the message Manager icon  is displayed on the task bar of the Windows PC, 

refer to "3.1.2.2. Q3". 

   Refer to "3.1.2.2. USB Communication Q3". 

A1-6. The timeout setting for the Loader may be too short. 

If the timeout is set to a value smaller than 1.5 s, a communication error may be 

detected before the Loader receives a response from the communicating device. Set 

to a value larger than the default value and try to see if communication is possible. 

Set the timeout setting on [Communication Conditions] on the [Communication 

setting] window. Refer to "1.5.5.1. [3]" of this instruction manual. 

   Refer to "1.5.5.1. [3] Communication Conditions". 

A1-7. The port setting on the [Communication setting] of the Loader may not be correct. 

Make sure that it is set to [RS-485 connection]. 

For information on the specific setting procedure, refer to "1.5.5.1". 

   Refer to "1.5.5.1. Communication Settings". 

A1-8. The [Baud rate] for the RS-485 connection set under the [Communication setting] of 

the Loader may not be the same as the [Baud rate] of the inverter. 

Make sure that the baud rate is the same. For information on the specific setting 

procedure, refer to "1.5.1" and "1.5.5.2". 

   Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter 

Side". 

  Refer to "1.5.5.2. Connection Setting". 

A1-9. The address set on [Address] (for the RS-485 station address) on the [Connection 

setting] window accessed from the [Communication setting] window of the Loader 

may not the same as the station address of the inverter. Make sure that the address 

is the same. 

For information on the specific setting procedure, refer to "1.5.1" and "1.5.5.2". 

   Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter 

Side". 

  Refer to "1.5.5.2. Connection Setting". 
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A1-10. Some models have a multiple number of RS-485 communication ports. (Example: 

VF1A series) 

If a communication port on the terminal block is used instead of the communication 

port for keypad connection, the default value of the function code for setting the 

communication protocol must be a value other than the Doesa (Loader) protocol. 

Make sure that it is set to "Doesa (Loader) protocol". 

For information on the specific setting procedure, refer to "1.5.1". 

   Refer to "1.5.1. Setting Function Codes Related to Communication on the Inverter 

Side".  

A1-11. When using the inverter with two RS-485 ports 

If both the RS-485 settings 1 and 2 of the inverter are set to "Doesa (Loader) 

protocol", communication is not possible when the Loader is connected to the 

RS-485 communication port 1. Connect the Loader to the RS-485 communication 

port 2 or change the protocol option for the RS-485 setting 1 to a value other than 

[Doesa protocol]. 

 

Q2. Is it possible to use the Loader while communicating with the inverter with two 

RS-485 ports? 

A2. It is possible to use the general-purpose communication together with the Loader. 

Likewise, with the communication using the field bus option, the Loader can be used 

at the same time. 

It must be noted that, if the function code is changed from both of them, the data 

changed later becomes valid. 

 

Q3. When using the Loader to control a multiple of inverters equipped with two 

RS-485 ports, is it possible to connect one port to the PC and to use the other 

port to make a multi-drop connection with other inverters? 

A3. No, it's not possible to use them that way. 

Use either one of the ports. 

A multiple of inverters can be controlled using the Loader only if they are directly 

connected. 

* Such connection is not allowed not only for the Loader, but also for ordinary 

RS-485 communication. It is because a unique station address must be assigned to 

each port. 

 

Q4. With using the inverter equipped with two RS-485 ports, what will happen if both of 

the two ports are set to the Loader (Doesa) protocol? 

A4. We do not recommend that kind of setting. 

If the ports are set that way, the one on the terminal block side has the higher priority. 
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3.1.2.4. Common to Communication 

 

Q1. We use the inverter in an application where its continuous operation cannot be 

stopped halfway. If the Loader is connected, will it cause the inverter to stop? 

A1. Even if you connect the Loader, it will not cause the inverter to stop working. 

However, care must be taken because if you switch to test run, the inverter may stop. 

If the operation is controlled using the keypad, care must be taken because the 

inverter will stop if you disconnect the keypad by mistake when connecting the 

Loader. 
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3.1.3. How to Use the Loader 

3.1.3.1. Function Code Settings 

 

Q1. When I tried to make new settings by editing the function codes for the inverter with 

400-V specification, it was set to 200-V specification. How can I change the setting to 

400-V specification? 

A1. From the Quick Access menu or main menu, select [Function code setting], select 

[New] on the [Select data to edit] window, and on the [Initial setting] window, set 

models, capacities, and voltage series for the inverter you will be using. 

   Refer to "2.2.1. Create a New File". 

 

Q2. Is it possible to compare function codes set values for two or more inverters? 

A2. The function codes for two inverters can be compared simultaneously on the Loader 

screen. 

When comparing the codes for a multiple inverters, read the function code set values 

for every converter, save them as a set data file using the file function, and then 

compare a data file with the next one opened one after another. 

For information on the comparison function, refer to "2.3.1.1. [6] Compare" of this 

instruction manual. 

The set data can also be saved in CSV format, so the data can be compared using a 

commercially available software. 

For information on saving in CSV format, refer to "2.7" of this instruction manual. 

   Refer to "2.3.1.1. Function Code Edit [6] Compare". 

  Refer to "2.7. Function Code Edit". 

 

Q3. I want to perform offline tuning using the Loader, but P04 is not present in the 

function code under [Function code edit]. How can I perform offline tuning? 

A3. From the Quick Access menu or main menu, select [Function code edit] and then 

select [Autotuning] tab on the [Function code list] window to perform the tuning. 

   Refer to "2.3.1.2. Auto Tuning". 
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Q4. I cannot read the file where Loader's function code settings are saved. 

A4. For some reasons, the definition files required for executing the Loader may have 

been lost. 

When the function code settings are saved, they are linked to the definition files in 

correspondence with the ROM number. Therefore, you cannot read the file if the 

definition file that the Loader refers to does not exist when the file is opened. 

The definition files are generated when the Loader is installed. To generate the 

definition files, uninstall the Loader once and then install it again. 

   Refer to "1.4.2.1. The Loader Uninstallation Procedure". 

  Refer to "1.4.1.3. The Loader Installation Procedure". 

 

Q5. I cannot select models on [New] under [Function code settings]. (Selection options 

are not displayed.) 

A5. For some reasons, the files (such as INI file, DLL file) required for executing the 

Loader may have been lost or the environment definitions (such as registry setting) 

may have been corrupted. Uninstall the Loader once and then install it again. 

   Refer to "1.4.2.1. The Loader Uninstallation Procedure". 

  Refer to "1.4.1.3. The Loader Installation Procedure". 

 

Q6. Model names that are not listed in the catalog are displayed as optional items. 

A6. The Loader is common to applications in Japan or abroad. Therefore, all the 

applicable models that we sell in Japan and abroad are displayed. 

If models not listed in the catalog are displayed, the [Regional spec.] may be set to 

an optional item other than [J: JAPAN]. On the main menu, select [Setup] and set [J: 

JAPAN] for [Regional spec.]. Then restart the Loader. 

   Refer to "2.4.4. Region Spec.". 

 

Q7. After writing function code data in the inverter using the Loader, I read the written 

data. The values read were different from what I just wrote in. 

A7. Some function codes (H42, H43, H44, H47, H48, etc.) including those related to 

the run time or service life are set as monitor only or updated according to 

operation. Therefore, the read value may be different from what was written in. 

Applicable function codes are different depending on the inverter models. Refer to 

the instruction manual or user's manual for the inverter model currently used. 
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Q8. With the inverter models provided with the password function, it is not possible to set 

or change the password from the Loader. 

A8. Password setting or changing via communication is disabled on the inverter side to 

prevent malicious password decoding. 

Unlock the password from the keypad. 

 

 

3.1.3.2. Alarm History 

 

Q1. When I checked the alarm history using the Loader, I only found numerical data in 

the function code settings. 

A1. The numerical data that can be confirmed on [Function code edit] window indicates 

alarm code numbers. 

Refer to the alarm code table provided separately in the RS-485 Communication 

User's Manual. 

If you access the [Alarm monitor] tab on the [Operation monitor] window selected 

from the [Operation monitor settings] on the Quick Access menu, the alarm codes 

can be checked in the same format as those displayed on the keypad. 

   Refer to "2.3.2.3. Alarm Monitor (for monitoring the inverter's alarm information)". 

 

  



 

 

 3-16 

3.1.3.3. Customizable Logic 

 

Q1. What should I enter in the [Version] displayed for [Inverter model selection] when I 

select [New] after selecting [Customizable logic] and [Select edit data] on the Quick 

Access menu? 

A1. Set the ROM version of the inverter. 

For information on checking the ROM version, refer to the instruction manual or 

user's manual for the inverter model currently used. 

If the Loader is connected to the inverter, you can confirm the ROM version on 

[Inverter ROM version] displayed on the [System monitor] tab on the [Operation 

monitor] window that can be accessed from the [Operation monitor settings] on the 

Quick Access menu. 

The set values entered in [Model] and [Version] affect the usable number of steps 

and usable circuit types. The entry in [Version] can be changed at a later stage. 

However, if any change is made to [Version], an error may occur when step numbers 

are assigned. You are recommended to select a version number that is as 

appropriate as possible when creating a new circuit. 

   Refer to "2.3.3.1. Select Customizable Logic Project to Edit". 

  Refer to "2.3.2.2. System Monitor 

(for monitoring the internal setup information and maintenance status of the 

inverter)". 

  Refer to "2.3.3.12. Project Properties". 

 

Q2. The newly created project does not work properly. 

A2-1. Check whether the customizable logic is started. 

If "U00", the inverter’s function code, is 1, it means that the customizable logic has 

been started. 

A2-2. Use the comparison function to check if the project is properly written in the inverter. 

   Refer to "2.3.3.10. Comparison". 

A2-3. Check if the user set values required for the customizable logic and the set values 

for the storage area are properly written. 

   Refer to "2.3.3.6. Settings for the User Setting Area and the Memory Area". 

  Refer to "2.3.3.9. Write". 

A2-4. Use the on-line monitoring function to check if symbols and FB inputs and outputs 

operate properly. 

   Refer to "2.3.3.11. Debug Function". 

A2-5. The process execution sequence may not be correct. Check the execution 

sequence. 

The execution sequence is represented by step numbers. 

   Refer to "2.3.3.7. Step Number Assignment". 
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Q3. How can I debug a newly created project? 

A3. After you finish assigning the step numbers, use the following functions to debug the 

project. 

- On-line monitoring function that displays status in the vicinity of symbols 

- Trace monitoring function that displays I/O of symbols in waveforms as a realtime 

trace 

   Refer to "2.3.3.11. Debug Function". 

  Refer to "2.3.4.10. Combination with the Customizable Logic Function". 

 

Q4. Can I print the newly created project? 

A4. Either the project layout area or the selected portion of the area can be printed. 

   Refer to "2.3.3.15. Printing the Customizable Logic". 

 

Q5. The newly created project may contain unique know-how. Is it possible to hide 

symbols or their connections or to disable any changes to them? 

A5. You can hide or display with a password by using the lock function. 

However, it must be noted that the lock function is enabled on the PC, but disabled 

on the inverter. If you write the circuit that is protected with the lock function into the 

inverter, the circuit can be freely displayed and edited on the inverter. To apply 

restrictions to display or edit of the circuit on the inverter, you need to use the 

inverter's password function (H197, H198, and H99) 

   Refer to "2.3.3.13. Lock Function". 
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Q6. Is it possible to operate processes with different cycles within a project? 

A6. It is possible depending on the inverter model. 

For the customizable logic specifications for each inverter model, refer to 

“3.2.4.Customizable Logic Specifications” 

However, even for inverter models that do not support such operation, it is possible 

to make it appear to process with multiple cycles by adjusting the process I/O refresh 

timing. 

For example, for a project whose number of steps for the VF1A model is 75, the 

execution cycle is 10 ms.  

It is not possible to allow processes with cycles such as 2 ms or 5 ms that is shorter 

than 10 ms. Accordingly, the latch function or hold function will be added so that the 

I/O signals of the target processes are updated at the integer multiple of 10 ms. 

 

Q7. Is it possible to share the newly created function blocks (FBs) with other people or 

with other PCs? 

A7. The import/export function allows you to use your created FB in the VFD 

Doesa-Loader software installed on another PC. 

   Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]". 
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Q8. Can I use the newly created project on different models? 

A8. If a project is created using only the symbols that are common to different models, 

the whole project can be set as an FB so that it can be used among different models 

using the import/export function. 

By clicking the [Change] button on the [Properties] screen of the project, you can 

also change the model on the [Inverter model selection]. 

If symbols that are not common among different models are used, the newly created 

project cannot be used when the number of steps of the created circuit exceeds the 

maximum number of steps of another model. 

   Refer to "2.3.3.3. [4] Creating a Function Block (FB)". 

  Refer to "2.3.3.14. Importing/exporting an FB under [FB (Common)]". 

  Refer to "2.3.3.12. Project Properties". 

 

 

3.1.3.4. Trace 

 

Q1. Is it possible to use the waveform data obtained through the realtime trace or  

historical trace on a commercially available software? 

A1. The waveform data can be saved in CSV format and thus the data can be used with 

commercially available software applications. 

Besides, if the waveform data has already been saved in the file formats (extensions: 

RT2, HT2, RTM, HIM, or RT1) dedicated to the Loader, read the data on the Loader 

by clicking [File] -> [Open], and then save the data in CSV format by clicking [Save 

as]. 

Note that the data saved in CSV format cannot be opened with the Loader. 

   Refer to "2.3.4.4. Saving the Trace Data". 
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3.1.3.5. Test Run 

 

Q1. When I try to change [Switching frequency/operation command], the following 

message appears and I cannot make any changes: [Cannot communicate with the 

inverter. Retry communication?]  

A1-1. An error may have occurred in the communication between the Loader and the 

inverter. 

Access the [Connection setting] window from the [Communication setting] window of 

the Loader and then click the [Browse] button on the [Connection setting] window to 

check the state of communication. For information on checking methods, refer to 

"2.3.5.3" and "1.5.5.2" of this instruction manual. 

   Refer to "2.3.5.3. If You Cannot Use the [Drive operation] Menu". 

  Refer to "1.5.5.2. Connection Setting". 

 If "Not connected" is displayed, check communication cable connections or 

communication settings. For information on checking methods, refer to "3.1.2.2. Q1." 

and "3.1.2.3. Q1." of this instruction manual. 

   Refer to "3.1.2.2. USB Communication Q1". 

  Refer to "3.1.2.3. RS-485 Communication Q1". 

 If "Connected" is displayed, refer to "A1-2" on the following section. 

A1-2. If you cannot change [Switching frequency/operation command] even if "Connected" 

is displayed when the the [Browse] button is clicked, the inverter may be rejecting the 

[Switching frequency/operation command] request. With the inverter provided with 

the password function, the cause could be that the password protection has been 

enabled. 

If the [Password protected] dialog is displayed when [Read from Inverter] is selected 

on [Function code setting], it means that the password protection is enabled. 

If that dialog is not displayed, select [Read from Inverter] on [Function code setting], 

and then try writing in the function code y99 on the [Function code edit] window. If the 

[Password protected] dialog is displayed, it means that the password protection is 

enabled. 

If the password protection is enabled, it needs to be removed. 

For information on password protection, refer to the instruction manuals or user's 

manuals of relevant inverters. 
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3.1.4. Terminology 

 

Q1. What does the "Message Manager" (hereinafter referred as "the MM")? 

A1. It is a software that controls communication between our Loader and the inverter. If 

the Message Manager is not installed, if it was deleted, or if the existing one was 

overwritten by reinstalling the Message Manager, communication may be disabled. 

   Refer to "1.5.4. Overview of the Message Manager". 

 

Q2. What does the "definition file" mean? 

A2. It is a file that contains information required to identify various models and their 

functions. 

If new function codes are added as functional improvement to a certain model, a new 

definition version (file name) is given to the new one of the same model. 

Our naming rule specifies that a file name must include the ROM number. When 

function codes with attributes are read from the inverter, optimum definition files are 

automatically detected. If you attempt to write function code set values in the inverter 

with different ROM number, a warning will be displayed. 

In such a case, select definition files again and perform writing. Writing should be 

normal now. 

   Refer to "2.3.1.3. [3] Changing a Definition File". 
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3.2. The Loader Standard Specifications 

 

Item Specification Remarks 

Name VFD Doesa-Loader  

Supported inverters Doesa VF1A series 

 

 With special inverters other than 

standard series models, function 

codes may not be properly 

displayed. 

Number of connected 

inverters 

For USB connection: Only one inverter 

For RS-485 connection: 31 inverters max. 

 

Supported keypads Remote keypad with USB: VF1A-PH1 

 

 The VF1A-PH1 is an optional 

product. 

 For information on the kepyad 

support detail, refer to "1.1.2. Table 

1-1  Correspondence between 

VF1A Series Inverter Models and 

Loader Functions" or catalogs of 

relevant inverters. 

Recommended cable RS-485: Shielded twisted-pair cable for long 

distance transmission 

USB: USB cable (mini B connector) 

RS-485 connection: Refer to "1.2.2. 

RS-485 Communication Port 

Connection". 

USB connection: Refer to "1.2.3. 

USB Communication Port 

Connection". 

O
p

e
ra

ti
n
g

 e
n
v
ir

o
n

m
e

n
t 

Supported OS Microsoft Windows 8.1 

Microsoft Windows 10 

32bit/64bit 

Japanese/English 

Memory 2 GB or more 4GB or more is recommended 

Storage Approx. 800 MB or more of free space  

Serial port RS-232C, USB In case of RS-232C, conversion to 

RS-485 is required to connect to the 

inverter. 

In case of USB, remote keypad with 

USB or conversion to RS-485 is 

required to connect to the inverter 

not equipped with USB. 

Monitor Monitor with 1024 x 768 or higher resolution FHD (1920 x 1080) or higher is 

recommended. 

T
ra

n
s
fe

r 
s
p
e

c
if
ic

a
ti
o

n
 

Communication 

port 

COM1 to COM255 PC port used for loader 

Baud rate USB connection: 

12 Mbps between the Loader and the 

Remote Keypad with USB port 

Between the Remote Keypad with USB 

port and the inverter 

VF1A-PH1: 19200 bps 

For RS-485 connection: 

115200, 76800, 57600, 38400, 19200, 

9600, 4800, 2400 bps 

 19200 bps or faster is 

recommended 

 The available communication 

speed varies depending on the 

inverter model and communication 

protocol. 

 

Communication 

protocol 

Doesa protocol (Loader protocol) 

Modbus RTU protocol 

 The available communication 

protocol varies depending on the 

inverter model. 

Character length 8 bits Common between protocols. 
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Item Specification Remarks 

Stop bit length Doesa protocol: 1 bit (fixed) 

Modbus RTU protocol:  

1 bit or 2 bits without parity 

1 bit with parity 

 

Parity Doesa protocol: Even (fixed) 

Modbus RTU protocol: None / Even / Odd 

 

Retry count None, 1 to 10 times Retry count to communication 

timeout error detection 

Timeout setting 100 ms, 300 ms, 500 ms, 1.0 s to 1.9 s, 2.0 to 

9.0 s, 10.0 to 60.0 s 

Set a time longer than the y09 or y19 

response interval time. 
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3.2.1. Type of Files Used by VFD Doesa Loader 

 

Table 3-1  List of Files Used by the Loader 

File types 
File 

extension 

File operation 
Related section 

Save Open 

Function 

code setting 

Standard 

function 

codes 

Function 

code data 

FNL   

2.2.2 

2.2.4 

2.2.5 

2.3.1.1. [4] 

CSV   2.7 

Customizable 

logic function 

codes 

Function 

code data 
FBL   

2.2.2 

2.2.4 

2.2.5 

2.3.1.1. [4] 

Error information 

- File read error 

- Inverter access error 

CSV   － 

Operation 

monitor 

I/O 

monitoring 

Monitor data CSV   

2.3.2.1 Display item 

selection 
TXT   

Monitor data of the system 

monitor 
CSV   2.3.2.2 

Monitor data of the alarm 

monitor 
CSV   2.3.2.3 

Operating 

state 

monitoring 

Monitor data CSV   

2.3.2.4 Display item 

selection 
TXT   

Customizable 

logic 

Project data CML   

2.2.2 

2.2.4 

2.2.5 

2.3.3.1 

User setting area and 

customizable logic memory 

area 

CSV   2.3.3.6 

Input/output check CSV   2.3.3.8. [1] 

Logic check CSV   2.3.3.8. [2] 

Comparison results CSV   2.3.3.10 

Common function blocks 

(FBs) 
EXFBL   2.3.3.14 

: Possible  : Not possible 
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File types 
File 

extension 

File operation 
Related section 

Save Open 

Realtime 

trace 

Waveform data 
RT2   

2.2.2 

2.2.4 

2.2.5 

2.3.4.4 

CSV   
2.2.5 

2.3.4.4 Waveform images 
JPG   

BMP   

Advanced EXRTM   2.3.4.9 

Historical 

trace 

Waveform data 
HT2   

2.2.2 

2.2.4 

2.2.5 

2.3.4.4 

CSV   
2.2.5 

2.3.4.4 Waveform images 
JPG   

BMP   

Advanced EXHIM   2.3.4.9 

: Possible  : Not possible 
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3.2.2. Function Code Setting Specifications 

 CSV File Format 

The following section shows an example of CSV file format when the function code data is 

exported by selecting [Export] on the [FunctionCodeEdit] window accessed from the main 

menu. 

 

 Column number 

1 2 3 4          5  6  7  8 

R
o

w
 n

u
m

b
e

r 

1 Doesa Loader, VF1A, 900, 900,       8,  U,  4,  2022/03/01 - 00:00:00 

2 Func, Function code name, Setting, Factory default 

3 F00, Data protection, 0, 0 

4 

… 

F01, 

… 

 

Frequency setting 1, 

… 

 

0, 

… 

 

0 

… 

 [comment]    

     

 

1st row 

Column 

number 
Item name Description 

Import 

target 

1 Loader name Fixed at "Doesa Loader".  

2 Inverter model Indicates the model number of the inverter  

3 
Inverter ROM 

version 

Indicates the ROM version of the inverter 
 

4 
Function code set 

version 

Indicates the function code version. 
 

5 Capacity code Refer to "Table 3-2" shown below.  

6 
Regional 

specification 

J: Japan, A: Asia, C: China, E: Europe, U: USA, T: Taiwan, 

K: South Korea 
- 

7 Voltage code 
1: Single-phase 100 V, 2: Single-phase 200 V, 3: 

three-phase 200 V, 4: three-phase 400 V 
 

8 Date and time Indicates the date and time when the data is exported. - 

: Used for importing.  -: Not used for importing. 

 

Table 3-2  List of Capacity Codes 

Code 
Capacity 

[kW] 
Code 

Capacity 

[kW] 
Code 

Capacity 

[kW] 
Code 

Capacity 

[kW] 
Code 

Capacity 

[kW] 

1 0.1 8 5.5 15 37 22 160 29 400 

2 0.2 9 7.5 16 45 23 200 30 450 

3 0.4 10 11 17 55 24 220 31 500 

4 0.75 11 15 18 75 25 250 32 560 

5 1.5 12 18.5 19 90 26 280 33 630 

6 2.2 13 22 20 110 27 315 - - 

7 3.7 14 30 21 132 28 355 - - 
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2nd row 

Indicates the item name for the 3rd row and onwards. Not used for importing. 

 

From the 3rd row down to the row above the [comment] 

Column 

number 
Item Description 

Import 

target 

1 Function code 
Same as the No. column on the [Function code edit] 

window. 
 

2 
Function code 

name 

Same as the function code name on the [Function code 

edit] window. 
- 

3 Set value 
Numerical values that correspond to the set values on the 

[Function code edit] window. 
 

4 Factory default 
Numerical values that correspond to the factory default 

values on the [Function code edit] window. 
- 

: Used for importing.  -: Not used for importing. 

 

Row below [comment] and onward 

Same as the comment on the [File information]. Not used for importing. 
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3.2.3. Tracing Specifications 

 

Table 3-3  Tracing Specifications 

Item Realtime Historical  

Sampling 

time 

When using the special communication 

commands (*1) 

2 ms to 200 ms (*2) 
0.5 ms to 200 ms (*2) 

When not using the special communication 

commands 

200 ms 

Number of 

samplings 

15000 points/channel 

(Number that can be continuously displayed) 

500 

points/channel 
 

Number of 

displayed data 

items 

Analog: 4 channels 

Digital: 8 channels (*3) 

 

(*1) The special communication commands, the historical trace can be used by the inverters 

that support those functions. 

(*2) The sampling time setting range differs depending on the inverter model. Also, if the 

sampling time is extremely short in real-time tracing, the graph display may be interrupted 

depending on the communication speed and communication status. 

(*3) If four analog channels are selected, digital selection is not possible. 
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3.2.4. Customizable Logic Specifications 

 Number of steps 

Depends on the inverter models. 

 
Doesa VF1A Series Inverters 

Number of steps 

Version 300 or earlier 

100 

Version 400 or later 

200 

 

 Execution cycle 

Depends on the inverter models. 

 
Doesa VF1A Series Inverters 

Execution cycle Depends on the maximum step No. (following table) 

Maximum step 

No. 

(*1) 

1 – 10 2 ms 

11 – 20 
5 ms 

21 – 50 

51 – 100 10 ms 

101 – max 20 ms 

Multitask function Not available 

 

(*1) If 75 is manually assigned to the step number even if only one step is used, the maximum 

step No. becomes 75 and the execution cycle becomes 10 ms. 

 

 Multitask function 

Processes with multiple different execution cycles can be mixed and executed at the same 

time in one project. The multitask function can be enabled by setting U100 = 127 on the 

inverter model which supports it. 

For details, refer to the user's manual for each inverter model. 
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3.2.5. Replacement of Inverter ROM Versions 

When selecting definition files for the function code settings, when newly creating a 

customizable logic, or when setting the version using the customizable logic project 

properties, for the following inverter models, replace the ROM version and select it according 

to the table. 

 

 Doesa VF1A series 

ROM version Replaced version Remarks 

1000 900 VF1A-G21A5S4 or more 

6200 900 VF1A-G12A0S4 or less 
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